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C H A P T E R  1  

Introduction 

In This Chapter 
Virtual Machine Technology Overview................................................................................ 6 
About Parallels Workstation ................................................................................................. 7 
What's New in Parallels Workstation 2.2.............................................................................. 8 
Intel Virtualization Technology (VT-x) and AMD SVM Support........................................ 10 
Virtual Machine Equipment.................................................................................................. 11 
Supported Guest Operating Systems..................................................................................... 12 
 
 

Virtual Machine Technology 
Overview 

Virtual machine (VM) technology provides the following main features: 

 Enables multiple guest operating systems (OSes) and their applications to simultaneously 
run on a single computer. 

 Creates a number of virtual machines, each with a full set of standard virtual hardware. 
Operating systems and applications are isolated inside these virtual machines and share 
physical hardware resources. 

 Offers an opportunity to switch between operating systems without rebooting and to 
consolidate and virtualize a computing environment, resulting in reduced hardware costs, 
lower operating expenses, and increased productivity. 

Notes: 1. "Primary operating system" (primary OS) denotes the operating system that controls 
the I/O devices of the computer and that loads when the real computer is turned on. 

2. "Guest operating system" (guest OS) is an operating system that runs under virtual machine 
control. One primary OS and multiple guest OSes can be run at the same time on a single real 
computer. 
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About Parallels Workstation 
Parallels® Workstation is the most powerful, easy-to-use, cost-effective desktop virtualization 
solution available today. It empowers any user, from experienced professional developers to 
sales executives and home users, with the ability to create completely networked, totally secure 
independent virtual machines on a single physical machine. 

Parallels Workstation 2.2 is powered by a lightweight hypervisor, a thin layer of software that is 
between part of the host computer’s hardware and the primary operating system. The 
lightweight hypervisor controls some of the host computer's hardware resources, resulting in 
dramatically more stable, more secure, and higher-performing virtual machines.  

Parallels Workstation sophisticated virtualization engine enables each virtual machine to operate 
identically to a stand-alone computer. Each virtual machine works with its own processor, 
RAM, floppy, CD and DVD drives, I/O devices, and hard disk – everything a physical computer 
contains. See the Virtual Machine Equipment (page 11) topic for the full list of Parallels Virtual 
Machine devices.

Intel virtualization technology (VT-x) is fully supported by Parallels Workstation. See Intel 
Virtualization Technology (VT-x) and AMD SVM Support (page 10). 

Parallels Workstation has a set of special tools (utilities and drivers) that enhances the 
performance and functionality of your guest operating system (mouse synchronization tool, 
clipboard synchronization tool, etc.). See Parallels Tools Overview (page 77) for the full list of 
tools and their descriptions. 
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What's New in Parallels Workstation 
2.2 

New Graphics 

Parallels Workstation 2.2 has a new improved GUI. Most of the graphic elements, including 
device icons, buttons, wizard illustrations, are new. 

Startup Options Dialog Changed 

Interface of the Startup Options dialog has been changed in order to make it more intuitive. 
Please refer to Startup Options Dialog (page 104). 

New Guest OSes Supported 

Now Parallels Workstation officially supports the following guest operating systems: 

 Solaris version 10 and 9 
 Fedora Core Linux 5 
 Ubuntu Linux 5.0.4 

AMD SVM support 

In addition to Intel's virtualization technology VT-x Parallels Workstation now supports similar 
technology implemented into AMD processors, Security and Virtual Machine (SVM). Please 
refer to Intel Virtualization Technology (VT-x) and AMD SVM Support (page 10). 

Shared Folders 

Shared folders function assists in easily communicating between a virtual machine and your 
host computer. These folders are used for exchanging files between the primary OS and a virtual 
machine. Please refer to Using Shared Folders (page 133). 

Shared Folders Tab in Parallels Tools Center 

Shared Folders tab has been added to Parallels Tools Center in order to provide support for 
newly introduced Shared Folders function inside a guest operating system. Please refer to 
Shared Folders Options (page 168). 

Custom Screen Resolutions 

If you want the virtual machine window to occupy some specific place of your screen, you can 
set an arbitrary non-standard resolution for its monitor. For more on this please refer to Custom 
Screen Resolutions (page 135). 

Suspending, Stopping and Pausing of a Virtual Machine Changed 
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Suspending of a virtual machine is now started using single mouse click on a toolbar button. 
The same is stopping virtual machine. Please refer to Suspending/Resuming Virtual Machine 
(page 154) and Shutting Down and Resetting Virtual Machine (on page 153). 

Pausing virtual machine is also activated in a different way. Please refer to Pausing Virtual 
Machine (page 154). 

New Options of Fullscreen Mode  

Resolution of your monitor in fullscreen mode of a virtual machine can now be selected. It can 
be either your primary OS screen resolution or guest OS screen resolution. Please refer to User 
Interface Preferences (page 95). 

Network Protocol Used by Update Wizard Changed 

FTP protocol used by Update Wizard for downloading an update earlier may be inaccessible 
because of security issues. In the current version of Parallels Workstation FTP protocol has been 
replaced with commonly used HTTP protocol. Please refer to Updating Parallels Workstation 
(page 35).  

WiFi Support in Linux 

Linux version of Parallels Workstation from now supports bridging to wireless network 
adapters. Please refer to Virtual Machine Equipment (page 11). 

Hot Switching Between Bridged Adapters 

Parallels Workstation 2.2 lets you change network adapter and type of networking when running 
a virtual machine. Please refer to Working with a Network Adapter (page 158). 

Improved USB Support 

Parallels Workstation now supports more USB devices. Interrupt and isochronous devices 
support has been implemented. Please refer to Using USB devices in Virtual Machine (page 
135). 

Improved Sound Support 

Current version of Parallels Workstation provides more options of emulating sound device in a 
virtual machine. Please refer to Sound Options (on page 125). 
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Intel Virtualization Technology (VT-
x) and AMD SVM Support 

Intel VT-x Support 

Intel Virtualization Technology (VT-x), which is incorporated in the newest Intel processors, 
provides enhancements implemented into processor architecture that are specially designed for 
platforms running multiple operating systems. VT-enabled processors facilitate more efficient 
virtual machine partitioning and more precise virtual processor simulation. An extended set of 
processor instructions performs on a hardware level tasks previously realized programmatically, 
thus reducing virtualization overhead and improving virtual machine performance, security and 
stability. To learn more about Virtualization Technology see the Intel site 
http://www.intel.com/technology/computing/vptech/.  

Intel Virtualization Technology is fully supported by Parallels Workstation. If Parallels 
Workstation detects a VT-enabled CPU, support is automatically turned on. VT-x support can 
be manually enabled or disabled through a virtual machine configuration setting available in the 
VM Flags (page 108) section of General Options. If you run a guest OS with VT-x enabled, the 
Virtualization mode flag in the About Parallels Workstation screen shows Intel VT-x. See the 
More Information (page 143) section of the About Parallels Workstation screen. 

AMD SVM Support 

Security and Virtual Machine (SVM) architecture, which is incorporated in the newest AMD 
processors, provides enhancements implemented into processor architecture that are specially 
designed for platforms running multiple operating systems. SVM processors facilitate more 
efficient virtual machine partitioning and more precise virtual processor simulation. An 
extended set of processor instructions performs on a hardware level tasks previously realized 
programmatically, thus reducing virtualization overhead and improving virtual machine 
performance, security and stability. To learn more about SVM see the AMD site 
http://enterprise.amd.com/us-en/Solutions/Consolidation/virtualization.aspx.  

Security and Virtual Machine (SVM) architecture is fully supported by Parallels Workstation. If 
Parallels Workstation detects a SVM-enabled CPU, support is automatically turned on. SVM 
support can be manually enabled or disabled through a virtual machine configuration setting 
available in the VM Flags (page 108) section of General Options. If you run a guest OS with 
SVM enabled, the Virtualization mode flag in the About Parallels Workstation screen shows AMD 
SVM. See the More Information (page 143) section of the About Parallels Workstation screen. 
 

 

http://www.intel.com/technology/computing/vptech/
http://enterprise.amd.com/us-en/Solutions/Consolidation/virtualization.aspx
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Virtual Machine Equipment 
As we mentioned earlier, virtual machines work just like a stand-alone computer. Each VM 
contains the following virtual hardware: 

 CPU: Intel Pentium or AMD; 
 Generic motherboard compatible with Intel i815 chipset; 
 RAM up to 1500 MB; 
 VGA and SVGA with VESA 3.0 support; 
 1.44 MB floppy drive (mapped to a physical drive or to an image file); 
 Up to four IDE devices, each of them may be either a virtual hard drive (from 20 MB up to 

128 GB each, mapped to image file), or CD/DVD-ROM drive (mapped to physical drive or 
to image file); 

 Ethernet virtual network card compatible with RTL8029. Parallels Workstation supports 
bridging to wireless network adapters; 

 Up to four serial (COM) ports (mapped to real port, to pipe or to output file); 
 Up to three bi-directional parallel (LPT) ports (mapped to real port, to printer or to output 

file); 
 2-port USB 1.1 controller; 
 AC'97-compatible sound card. Sound recording is supported; 
 104-key Windows enhanced keyboard; 
 A PS/2 wheel mouse. 

 

 



 Introduction 12 
 

Supported Guest Operating 
Systems 

The current version of Parallels Workstation officially supports the following guest operating 
systems: 

Microsoft Windows Guest Operating Systems: 
 Windows Vista 
 Windows Server 2003 Standard Edition SP0 
 Windows Server 2003 Standard Edition SP1 
 Windows Server 2003 Enterprise Edition SP0 
 Windows Server 2003 Enterprise Edition SP1 
 Windows Server 2003 Web Edition SP0 
 Windows Server 2003 Web Edition SP1 
 Windows XP SP2 Professional 
 Windows XP SP2 Home 
 Windows XP SP1 Professional 
 Windows XP SP1 Home 
 Windows XP SP0 Professional 
 Windows XP SP0 Home 
 Windows 2000 Professional Edition SP4 
 Windows 2000 Server SP4 
 Windows 2000 Advanced Server SP4 
 Windows NT Workstation 4.0 SP6 
 Windows NT Server 4.0 SP6 
 Windows ME 
 Windows 98 
 Windows 95 
 Windows 3.11 
 Windows 3.1 

Linux Guest Operating Systems: 
 Red Hat Enterprise Linux WS4 
 Red Hat Enterprise Linux AS4 
 Red Hat Enterprise Linux WS3 
 Red Hat Enterprise Linux ES4 
 Red Hat Enterprise Linux ES3 
 Red Hat Linux 9 
 Red Hat Linux 8 
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 Red Hat Linux 7.3 
 Debian Linux 3.1 
 Fedora Core Linux 5 
 Fedora Core Linux 4 
 Fedora Core Linux 3 
 SUSE Linux 10 
 SUSE Linux 9.3 
 SUSE Linux 9.2 
 SUSE Linux 9.1 
 SUSE Linux 9.0 
 Mandriva Linux 10.1 
 Mandriva Linux 10 
 Mandriva Linux 9.2 
 Ubuntu Linux 5.0.4 
 Xandros Linux 4.0 

FreeBSD Guest Operating Systems: 
 FreeBSD 5.4 
 FreeBSD 5.3 
 FreeBSD 4.5 
 FreeBSD 4.1 

OS/2 and eComStation Guest Operating Systems: 
 OS/2 Warp 4.5  
 OS/2 Warp 4 
 OS/2 Warp 3 
 eComStation 1.2 
 eComStation 1.1 

Sun Solaris Guest Operating Systems: 
 Solaris 10 
 Solaris 9 

MS-DOS Guest Operating Systems: 
 MS-DOS 6.22 
 

 



 14 
 

C H A P T E R  2  

Installing Parallels Workstation 

This chapter provides the information on the process of installing Parallels Workstation onto 
computers running a Linux or Windows operating systems. 

In This Chapter 
System Requirements............................................................................................................ 14 
Installing Parallels Workstation in Windows........................................................................ 16 
Installing Parallels Workstation in Linux ............................................................................. 29 
 
 

System Requirements 
Note. Before installing the product, please make sure that all computers where you wish to 
install and run Parallels Workstation meet the hardware and software requirements described in 
this section. 
 

Hardware Requirements 
The physical computer running Parallels Workstation should meet the following hardware 
requirements: 

 700 MHz processor which supports the Pentium III instructions set. 1.5 GHz or faster is 
recommended. 

 32-bit or 64-bit platform. Note that to run Parallels Workstation 2.2 on 64-bit platform you 
should have a 32-bit primary OS installed on it. 

 Memory to run the primary OS plus memory required for each guest operating system and 
its applications. Please see your primary and guest operating systems documentation for 
their memory requirements. 1 GB or more is recommended. 

 Disk space required for virtual machines should be estimated according to volume of data 
you intend to store on virtual hard disks. A typical Windows XP virtual machine after the 
system installation occupies about 2 GB on the hard disk. Parallels Workstation itself takes 
about 23 MB. 

 Any SVGA video card with an 8-bit display adapter supported by your primary OS. 16-bit 
color depth or higher is recommended. 

 Optional: a 3.5" floppy drive, a CD/DVD-ROM drive. 
 If you intend to access the Internet in virtual machines, you should have an Ethernet adapter 

installed on your computer that is supported by your primary OS. 
 Optional: serial port, parallel port, USB controller. 
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Software Requirements 
If one of the following primary operating systems is running on your computer, Parallels 
Workstation can be successfully installed on it. 

Microsoft Windows Primary Operating Systems: 
 Windows Vista 
 Windows 2003 Standard Edition SP0 
 Windows 2003 Standard Edition SP1 
 Windows 2003 Enterprise Edition SP0 
 Windows 2003 Enterprise Edition SP1 
 Windows 2003 Web Edition SP0 
 Windows 2003 Web Edition SP1 
 Windows XP SP2 Professional 
 Windows XP SP2 Home 
 Windows 2000 Professional Edition SP4 
 Windows 2000 Server SP4 

You should have Internet Explorer version 5.0 or higher installed on your computer. 

Linux Primary Operating Systems: 
 Fedora Core Linux 4 stock 2.6.11-1.1369_FC4  
 Red Hat Enterprise Linux WS4 stock 2.6.9-5  
 Red Hat Enterprise Linux AS4 stock 2.6.9-5  
 Red Hat Enterprise Linux ES4 stock 2.6.9-5  
 Red Hat Linux 9 stock 2.4.20-8  
 Debian Linux 3.1 stock 2.6.8-2-386  
 SUSE Linux 10.0 stock 2.6.13-15 
 SUSE Linux 9.3 2.6.11.4-20a  
 SUSE Linux 9.2 stock 2.6.8-24.11  
 SUSE Linux 9.1 stock 2.6.4-52  
 SUSE Linux 9.0 stock 2.4.21-69  
 Mandriva Linux 10 stock 2.6.3-7 

The following software packages should be installed: 

 Sources of currently installed kernel (if you didn't install the kernel manually, then you 
should install kernel-sources package from your distribution);  

 glibc [glibc]  
 gcc [gcc], ld [binutils] (included in any development package)  
 X Window System including  

 xf86vidmode extension (for fullscreen only)  

 XKB extension (for keyboard national layouts and leds support) 
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 Qt 3.0.5 library multithreaded [qt3] 

PAE Support 

Current version of the Parallels Workstation supports up to 4 GB PAE (Physical Address 
Extension). If your processor supports more than 4 GB PAE: 

 In Windows primary OS on the first starting a virtual machine you will be prompted to 
create a new configuration with 4 GB PAE in boot.ini.  

 In Linux primary OS kernel PAE setting should be changed manually. 

See Troubleshooting section in Starting a Virtual Machine (on page 149) topic. 
 

Installing Parallels Workstation in 
Windows 

This section contains the complete information on installing Parallels Workstation onto 
computer running any of supported Windows OS. 
 

Parallels Workstation for Windows: Step-by-Step Installation 
Note: You must have Power User or Administrator rights to be able to install the Parallels 
Workstation on a computer running Windows. 

To install Parallels Workstation: 

1 Download Parallels Workstation installation file from Parallels site.  

 To download a trial version access the Parallels Download Center 
http://www.parallels.com/en/download. 

 To buy a full-scale version visit the Parallels Buy Online page 
http://www.parallels.com/en/buyonline. 

Select the Windows EXE file for downloading.  

 

http://www.parallels.com/en/download
http://www.parallels.com/en/buyonline
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2 Locate the downloaded self-extracting Parallels-Wst-2.2.xxxx-Win.exe file and 
double-click it. The Parallels Setup Wizard greets you with the following screen. 

 
Click Next button to display user license agreement which you must accept to continue 
installing Parallels Workstation. 

3 On the License Agreement screen use either the PgDn key or the down arrow ↓ key on your 
keyboard to read the entire agreement. Select the I accept the terms of the license agreement 
option. The Next button becomes enabled; click it to proceed with the installation.  
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You may print the license agreement for your records using the Print button. 

 
4 In the User Registration screen you can enter your contact information that will be used for 

sending you a trial activation key. Please enter your E-mail and User name. Specifying 
Company name is optional. Check I want to receive news from Parallels to my E-mail if you 
want to be informed about new Parallels products. You will be sent a free trial activation 
key soon after this. 

If you prefer to register on Parallels site, click the Register on site button. 

To buy Parallels Workstation and receive a permanent activation key, use the Buy button. 

If you want to put off the registration, click Skip registration to proceed to next step.  
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Note. The User registration screen does not appear if you reinstall Parallels Workstation. 

 
5 In the Customer Information screen, you can activate your copy of the Parallels Workstation. 

To do this, enter your Activation key. Entering User Name and Company Name is optional. 
Register on site and Buy buttons are provided for obtaining a trial activation key and a 
permanent activation key respectively. The Register on site button opens the Parallels site 
where you can register and get a trial activation key; the Buy button opens the Parallels 
online store where you can purchase a permanent activation key.  

When finished, click the Next button to move to the Choose Destination Location screen. 

Notes. 1. You are not obligated to specify activation information right now. It is possible to 
do it later in the installed application in the Activate Product (page 26) window. To skip this 
step, click the Activate later button. 
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2. The Customer Information screen may not appear if you reinstall Parallels Workstation 
after removing it. If you chose to save license information when removing, this step will be 
omitted. 
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6 On the Choose Destination Location screen you should specify a folder where Parallels 
Workstation will be installed. If you are not satisfied with the default folder, click the 
Change button to find another one. Note that Parallels Workstation should be installed only 
on the bootable system disk. 

 
Press the Next button to display the Select Program Folder window. 
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7 In this window you have to define the name of the Parallels Workstation folder in the 
Programs list of the Windows Start menu. 

 
By default, setup wizard offers to create a new folder called Parallels. However, you may 
choose one of the folders currently existing in the Programs list and presented in the Existing 
Folders list on this screen.  

Click Next to proceed.  
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8 On the Select shortcuts screen, specify where Parallels Workstation shortcuts should be 
added. The first option, Create the application shortcut on the Desktop adds Parallels 
Workstation icon on the Windows desktop. The second option, Create the application 
shortcut in the Start menu adds an additional link into program folders list above the folders. 
The third option, Put the application shortcut on the Quick Launch panel adds Parallels 
Workstation icon to the Windows Quick Launch panel located in the Taskbar. 

 
Click Next to move to the next screen.  

9 On the Ready to Install the Program screen, if you are satisfied with the information entered, 
click Install to start the Parallels Workstation installation. 
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You can return to the previous steps by clicking the Back button. 

 
10 If your Windows primary system is configured to warn you every time an unsigned driver is 

installed, you will receive the following message box: 

 
Click OK to disable the unsigned driver warnings during Parallels Workstation installation. 
They will re-enabled later when the installation will be complete. 

If your system is configured to block the unsigned drivers installation, you will receive the 
similar message prompting you to allow installation of these drivers. Click OK, otherwise 
Parallels Workstation can not be installed at all. 
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11 Installation progress is shown in the Setup Status window. 

 
12 When Parallels Workstation is installed, the wizard displays its final screen. 

 
To complete the installation, click Finish. If you check I want to view Readme file option, the 
Readme file will be opened in Notepad.  

 

 



 Installing Parallels Workstation 26 
 

Starting Parallels Workstation 
To start Parallels Workstation in Windows: 

 Select Programs --> <Parallels Folder Name> --> Parallels Workstation in the Windows Start 
menu, where <Parallels Folder Name> denotes the name of the Parallels Workstation folder 
in Windows Start menu that you have specified while installing.  

You may also start Parallels Workstation by double-clicking its icon on the desktop, by single-
clicking its shortcut in Start menu, or by single-clicking its icon in the Quick Launch panel, if 
you have added the corresponding shortcuts during installation.When you start Parallels 
Workstation for the first time, the auto-update feature asks you if you want to perform regular 
automatic check for updates. See Auto-Updating Parallels Workstation in Windows (page 36) 
for more information about the auto-update feature. 
 

Activating Parallels Workstation in Windows 

Getting an Activation Key 

If you already have an activation key, skip this section and proceed to Activating Your Copy of 
Parallels Workstation below in this topic. 

To get an evaluation key: 

1 Click Help in the menu and select Activate Product. This opens the Activate Product screen. 

2 In the Activate Product screen, click the Evaluate button to open the User Registration 
window.  
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3 In the User Registration window, specify your e-mail and your name. Entering the name of 
your company and optional information in the respective tab is not necessary. Specify if you 
want to receive news from Parallels to your e-mail. 

 
4 Click the Register button to send this information to Parallels. You will be sent a free trial 

activation key to your e-mail in a short time. 

Alternatively, you may register on Parallels site. Use the Register on site button to proceed 
to creation of the account on site. You will receive a free trial activation key on your e-mail 
soon after this.  

To get a permanent activation key: 

1 Click Help in the menu and select Activate Product. This opens the Activate Product screen. 

In the Activate Product screen, click the Buy button to open the Parallels Online Store where you 
can purchase a permanent activation key. 

Activating Your Copy of Parallels Workstation 

Perform the following steps: 

1 Click Help in the Parallels Workstation main menu and select Activate Product.  
2 In the Activate Product window fill in the following fields:  

 In the Activation key field, type the key provided to you. When you fill in this field, the 
Activate button becomes active.  
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 Specify your name and name of your company in the User Name and Company Name 
fields. Information taken from Windows system settings is automatically prompted here. 
These fields are optional. 

 
3 Click the Activate button. If you have entered a valid activation key, the following 

confirmation message will be displayed: "Parallels Workstation has been 
activated successfully. Thank you!" From this point on your copy of the 
Parallels Workstation is active and you may use all of its features and capabilities. 

 The same information is contained in the Licensing Information group in About Parallels 
Workstation (page 142) window and is described in the appropriate topic. 

If You Activated with a Permanent Key 

After you have activated your copy of Parallels Workstation with a permanent activation key, 
you will be asked to register the next time you start Parallels Workstation. When you see the 
dialog shown below and click the Register button, the user registration online form will be 
opened in your Web browser. Please provide us with you contact information to receive 
notifications about our new updates and products. 

 
 

 



 Installing Parallels Workstation 29 
 

Uninstalling Parallels Workstation in Windows 
Uninstalling Parallels Workstation does not delete any files that have been created using 
Parallels Workstation, such as configuration files, virtual hard disks, CD disc .iso images, 
floppy .fdd images, and serial/parallel port output files. 

Note: You must have Power User or Administrator rights to be able to uninstall the Parallels 
Workstation on a computer running Windows. 

1 Open the Windows Start menu, select Control Panel, select Add/Remove Programs, and then 
select Parallels Workstation. 

2 Click the Remove button (it may be combined with other buttons in different Windows 
versions) to begin uninstalling. 

3 When you are asked "Do you want to completely remove the selected 
application and all of its features?", click Yes.  

4 The Wizard asks whether you want to retain activation information: "You have 
license information of the Parallels Workstation stored in 
the Windows registry. Setup can save it for the future use, 
or remove it completely. It is recommended to keep the 
license if you plan to install the product again. Do you want 
to keep license?" 

If you choose to save it, you will not be asked to enter an activation key next time you 
install Parallels Workstation. 

 

Installing Parallels Workstation in 
Linux 

This section describes installing Parallels Workstation onto computer running Linux and all the 
related processes. 
 

Parallels Workstation for Linux: Step-by-Step Installation 
Notes: 1. Make sure that the required packages and libraries enlisted in the software 
requirements (page 15) for the Linux primary OS are installed on your system. 

2. To install Parallels Workstation on a Linux computer, you need root privileges. 

To install Parallels Workstation: 

1 Download the Parallels Workstation installation file from Parallels site.  

 To download a trial version access the Parallels Download Center 
http://www.parallels.com/en/download. 

 To buy a full-scale version visit the Parallels Buy Online page 
http://www.parallels.com/en/buyonline. 

 

http://www.parallels.com/en/download
http://www.parallels.com/en/buyonline
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Depending on what file types your system supports, download the RPM package, or DEB 
package, or TZG archive respectively. 

2 Launch the Terminal program. 

3 Run the 
su 

command to gain root privileges. Enter the password to the root account when you are 
asked for it. 

4 If .rpm is supported in your system: 

 Locate the .rpm package file Parallels-2.2.xxxx-lin.i386.rpm. 

 To start installing Parallels Workstation, issue the following command: 
rpm -i Parallels-2.2.xxxx-lin.i386.rpm 

Proceed to step 7. 

5 If .deb is supported in you system: 

 Locate the .deb package file Parallels-2.2.xxxx-lin.deb. 

 To start installing Parallels Workstation, issue the following command: 
dpkg -i Parallels-2.2.xxxx-Lin.deb 

Proceed to step 7. 

6 If both .rpm and .deb are not supported in your system: 

 Locate the .tgz package file Parallels-2.2.xxxx-lin.tgz and extract it into 
any existing directory: 

tar -xzpf Parallels-2.2.xxxx-lin.tgz -C <directory name> 

 Go to the directory where you unpacked the .tgz file and issue the next command 
cd parallels-2.2.xxxx-lin 

 Run the following command 
./install.sh 

7 After the installation completes, you should run the post-installation script. Issue the 
following command: 

parallels-config 

8 When prompted, press Enter on the keyboard.  

9 Read the license agreement up to the end by pressing Spacebar on your keyboard. To 
accept the agreement, type "y" or "yes" (in either upper or lowercase) and press Enter. 

10 The Parallels Workstation configuration procedure configures, compiles and installs drivers. 
After the process is finished you will be informed about the successful completion.  

11 In the Terminal, issue the  
exit 

command to leave the root account. You can now run Parallels Workstation! 
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Troubleshooting 

If you receive a "Can not configure!" or "Can not compile!" message (note that 
you should have kernel sources installed), you can view log file and try to fix problem yourself. 
The log file is named /usr/lib/parallels/comp.log.<log number>.error 

If you can not fix the problem yourself, please send the log file and problem description to 
reports@parallels.com. We will assist you as soon as possible. 
 

Starting Parallels Workstation 
To start Parallels Workstation in Linux: 

 Log in, launch the Terminal program and run  
parallels 

in the command line. 

When you start Parallels Workstation for the first time, the auto-update feature asks you if you 
want to perform regular automatic check for updates. See Auto-Updating Parallels Workstation 
in Linux (page 42) for more information about the auto-update feature. 
 

Activating Parallels Workstation in Linux 

Getting an Activation Key 

If you already have an activation key, skip this section and proceed to Activating Your Copy of 
Parallels Workstation below in this topic.  

To get an evaluation key: 

1 Click Help in the menu and select Activate Product. This opens the Activate Product screen. 

2 In the Activate Product screen, click the “obtain a free trial activation key” link to open the 
User Registration window.  
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3 In the User Registration window, specify your e-mail and your name. Entering name of your 
company and optional information in the respective tab is not necessary. Specify if you want 
to receive news from Parallels to your e-mail. 

 
4 Click the Register button to send this information to Parallels. You will be sent a free trial 

activation key to your e-mail in a short time. 

Alternatively, you may register on Parallels site. Click the Register on site button to proceed 
to creation of the account on site. You will receive a free trial activation key on your e-mail 
soon after this. 

To get a permanent activation key: 

1 Click Help in the menu and select Activate Product. This opens the Activate Product screen. 

2 In the Activate Product screen, click the “purchase a permanent activation key” hyperlink to 
open the Parallels Online Store. 

Activating Your Copy of Parallels Workstation 

To activate Parallels Workstation in Linux do the following: 

1 Click Help in the Parallels Workstation main menu and select Activate Product.  
2 In the Activate Product window, fill in the following fields:  

 In the Activation key field type the key provided for you. When you fill in this field, the 
Activate button becomes active.  
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 Specify your name and name of your company in the User Name and Company Name 
fields. These fields are optional. 

 
3 Click the Activate button. If you have entered a valid activation key, the following 

confirmation message will be displayed: "Parallels Workstation has been 
activated successfully. Thank you!" From this point on, your copy of the 
Parallels Workstation is active and you may use all of its features and capabilities. 

 The same information is contained in the Licensing Information group in About Parallels 
Workstation (page 142) window and is described in the appropriate topic. 

If You Activated with a Permanent Key 

After you have activated your copy of Parallels Workstation with a permanent activation key, 
you will be asked to register the next time you start Parallels Workstation. When you see the 
dialog shown below and click the Register button, the user registration online form will be 
opened in your Web browser. Please provide us with you contact information to receive 
notifications about our new updates and products. 
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Uninstalling Parallels Workstation in Linux 
Uninstalling Parallels Workstation does not delete any files that have been created using 
Parallels Workstation, such as configuration files, virtual hard disks, CD disc .iso images, 
floppy .fdd images, and serial/parallel port output files.

Note: To uninstall Parallels Workstation on a computer running Linux you need root 
privileges. 

To uninstall Parallels Workstation in Linux: 

1 If .rpm is supported in your system, run the command  
su -c "rpm -e Parallels" 

Enter the root password.  

2 If .deb is supported in your system, run the command 
su -c "dpkg -r Parallels" 

Enter the root password.  

3 If both .rpm and .deb are not supported in your system: 

 In the Terminal, run the command 
su 

to gain root privileges. Enter the password to the root account when you are asked 
for it. 

 Go to installation directory and run  
./uninstall.sh 

script. 

 Leave the root account by running the following command 
exit 
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C H A P T E R  3  

Updating Parallels Workstation 

This chapter discusses how to update previous version of Parallels Workstation for both 
Windows and Linux installations. 

In This Chapter 
Updating Parallels Workstation in Windows........................................................................ 35 
Updating Parallels Workstation in Linux.............................................................................. 41 
 
 

Updating Parallels Workstation in 
Windows 

Update procedure in Windows primary OS consists of the following steps: 

1 Getting known about a new update. 

We recommend that you use the auto-update feature incorporated into Parallels Workstation 
to be informed when new update is available. Auto-update feature regularly checks the 
Parallels server and informs when the update is found. See Auto-Updating Parallels 
Workstation in Windows (page 36).  

Instead you may check for new updates using Update Wizard or manually on Parallels site. 

2 Downloading and installing Parallels Workstation update. 

There are two ways to download an update: 

 Using the Update Wizard.  

If you use the auto-update feature, it informs you when the update is available and 
launches the Parallels Update Wizard for downloading. If you do not use the auto-
update feature, you are able to start Parallels Update Wizard manually. See Update 
Wizard in Windows (page 37).  

After you download the update using Update Wizard, the latter automatically launches 
the Setup Wizard for installation. 

 Manually from Parallels site. 

If you have downloaded the update manually, perform an ordinary Parallels Workstation 
installation. See Parallels Workstation for Windows: Step-by-Step Installation (page 
16). 
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Auto-Updating Parallels Workstation in Windows 
Parallels Workstation includes an auto-update feature. When starting Parallels Workstation for 
the first time, you will receive a notification which asks if you agree for Parallels Workstation to 
perform regular checks for updates: "Parallels Workstation is configured to 
automatically check for updates every week. To do this your host 
computer should be connected to the Internet. You may choose 
another checking period or disable this feature in the 
Preferences/Common screen." We recommend you to turn this feature on so you will 
be automatically informed when Parallels Workstation updates are released.  

Parallels Workstation will regularly access the Parallels update server and will check if a newer 
version than the one currently installed is available. By default, update checking is performed 
once a week. Checks are performed in background mode, meaning that you will not be notified 
until an update is found. If Parallels Workstation detects that update is available, auto-update 
asks for installation confirmation with the following message: "A newer version of the 
Parallels Workstation is available. Do you want to start 
Parallels Update Wizard?" If you want to update, click Yes to launch the Parallels 
Update Wizard that will download the update.  

Requirements to Your Computer 

To be able to use auto-update feature: 

 your computer must be connected to Internet. 

Note. If you have firewall and/or antivirus software installed in your primary operating system, 
they may display warnings when Parallels Workstation tries to access Internet for update. Please 
configure them properly to allow Parallels Workstation to perform checks. 

Configuring Auto-Update 

You can specify the frequency of update checks, i.e. daily, weekly, or monthly, in the 
Automatically checks for update option in the Common (page 90) tab of the Preferences window. 
Auto-update checking can be disabled by selecting Never in the same setting. You can enable 
the auto-update feature at a later time by revisiting this menu. 
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Update Wizard in Windows 
Updates for Parallels Workstation for Windows can be downloaded using the Parallels Update 
Wizard. For information on auto-updating Parallels Workstation, see Auto-updating Parallels 
Workstation in Windows (page 36).  

The Wizard accesses the Parallels update server, checks if a newer version than the one 
currently installed is available, downloads the newest version (if any), and starts installation, if 
the user decides to do it immediately. To use this feature, your primary operating system must 
be connected to the Internet. 

To update Parallels Workstation: 

1 Start the Parallels Update Wizard either by selecting Check for Updates in the Help menu, or 
by selecting All Programs -- > <Parallels Folder> -- > Check for Updates in the Windows Start 
menu. 

The Wizard will welcome you. Click Next to proceed. 
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2 The Wizard checks when your copy of the Parallels Workstation was last updated and 
displays the exact date and time of the update. If you have not previously updated your 
installation, the Wizard will inform you that "Update wizard has detected that 
your Parallels Workstation software has never been updated 
before". Click Next to check for available updates. 

 
3 While accessing the Parallels update server, the Wizard displays the following screen. 
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4 When the wizard gets the version numbers of available updates, it compares them with the 
installed version. If it can not find a more recent version than the one that is currently 
installed, the wizard displays the following screen. Click Finish to exit the wizard. 

 
5 If the wizard finds a more recent version of Parallels Workstation than the one currently 

installed, the number of the newest version is displayed in the following screen.   

 
Make sure that the newest version is checked and click Download. 
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6 While downloading, the Wizard displays the following screen. 

 
7 When the Wizard finishes downloading you may open the folder where the new update was 

placed using the Open updates folder button. 
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Before installing, close all Parallels Workstation instances. (If you haven't closed all 
Parallels Workstation windows, you will be notified later that you have to do it with the 
following message: "Please close all running instances of the 
Parallels Workstation before start installing the downloaded 
update. Do you want to begin installing?") After you have closed all 
Parallels Workstation instances, return to the Download is completed wizard screen, make 
sure that Install updates option is checked, and click Finish button.  

8 The Update Wizard closes itself and starts the Installation Wizard. The Installation Wizard 
asks for confirmation for replacing the current version with the newer one. 

 
Click Yes. The Installation Wizard performs the installation of the update. When it is 
finished, the Wizard may ask you to restart the computer. If this is the case, agree to restart. 

 

Updating Parallels Workstation in 
Linux 

Update procedure in Linux primary OS consists of the following steps: 

1 Getting known about a new update. 

We recommend that you use the Auto-update feature incorporated in Parallels Workstation 
to be informed when new update is available. Auto-update feature regularly checks the 
Parallels server and informs when the update is found. See Auto-Updating Parallels 
Workstation in Linux (page 42).  

Instead you may check for new updates using Update Wizard or manually on Parallels site. 

2 Downloading Parallels Workstation update. 

There are two ways to download an update: 

 Using the Update Wizard.  

If you use the Auto-update feature, it informs you when the update is available and 
launches the Parallels Update Wizard for downloading. If you do not use the Auto-
update feature, you are able to start Parallels Update Wizard manually. See Update 
Wizard in Linux (page 43).  

 Manually from Parallels site. 

3 Installing the update. 

After you have the update downloaded to your computer, you need to install it. See 
Installing an Update (page 46) topic for guidelines. 
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If you need to install an older version of Parallels Workstation than the one currently 
installed, in some operating systems it requires to perform a different command than an 
newer version installation.  

 

Auto-Updating Parallels Workstation in Linux 
Parallels Workstation includes an auto-update feature. When starting Parallels Workstation for 
the first time, you will be asked if you agree for Parallels Workstation to perform regular checks 
for updates: "Parallels Workstation is configured to automatically 
check for updates every week. To do this your host computer 
should be connected to the Internet. You may choose another 
checking period or disable this feature in the 
Preferences/Common screen." We recommend you to turn this feature on so you will 
be automatically informed when Parallels Workstation updates are released.  

Parallels Workstation will regularly access the Parallels update server and will check if a newer 
version than the one currently installed is available. By default, update checking is performed 
once a week. Checks are performed in background mode, meaning that you will not be notified 
until an update is found. If Parallels Workstation detects that update is available, auto-update 
asks for installation confirmation with the following message: "A newer version of the 
Parallels Workstation is available. Do you want to start 
Parallels Update Wizard?" If you want to update, click Yes to launch the Parallels 
Update Wizard that will download the update.  

Requirements to Your Computer 

To be able to use auto-update feature: 

 your computer must be connected to Internet. 

Note. If you have firewall and/or antivirus software installed in your primary operating system, 
they may display warnings when Parallels Workstation tries to access Internet for update. Please 
configure them properly to allow Parallels Workstation to perform checks. 

Configuring Auto-Update 

You can specify the frequency of update checks, i.e. daily, weekly, or monthly, in the 
Automatically checks for update option in the Common (page 90) tab of the Preferences window. 
Auto-update checking can be disabled by selecting Don't check in the same setting. You 
can enable the auto-update feature at a later time by revisiting this menu. 
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Update Wizard in Linux 
Parallels Workstation includes a Parallels Update Wizard which assists in downloading updates. 
The wizard accesses the Parallels update server, checks if a newer version than the one currently 
installed is available and downloads it (if one is found). The Update Wizard automatically 
selects the package suitable for your Linux primary OS. 

To be able to use the Parallels Update Wizard: 

 Your Linux primary operating system must be connected to the Internet. 

To download the update: 

1 Start the Parallels Update Wizard. 

The Parallels Update Wizard can be started automatically, by auto-update feature (see Auto-
Updating Parallels Workstation in  (page 42)Linux), or manually by one of the following 
methods: 

 select  Help/Check for Updates in the Parallels Workstation menu, 

 in the Terminal, issue the command: 
updatewizard 

2 The wizard welcomes you. Click Next to proceed. 
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3 The wizard checks when your copy of the Parallels Workstation was last updated and 
displays the exact date and time of the update.  

 
If you have not previously updated your installation, the Wizard will inform you that 
"Update wizard has detected that your Parallels Workstation 
software has never been updated before". Click Next to check for available 
updates. 

4 When the wizard gets versions numbers of available updates, it compares them with the 
installed version. If it can not find a more recent version than the one that is currently 
installed, the wizard informs you that "Wizard has detected that you have 
the most recent Parallels Workstation software". 
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If the wizard finds a more recent version of Parallels Workstation than the one currently 
installed, the number of the newest version is displayed in the following screen.  

 
Make sure that the newest version is checked and click Download. 

 



 Updating Parallels Workstation 46 
 

5 Wizard downloads the update. When finished, wizard displays the command(s) you should 
execute to install the update. Proceed to Installing an Update (page 46) to complete the 
installation. 

 
 

Installing an Update 
Note: To update Parallels Workstation on a Linux computer, you need root privileges. 

Updating From an RPM Package 

The update feature removes the Parallels Workstation version currently installed on your 
computer and installs a new one.  

To update the Parallels Workstation, you should perform the following operations: 

1 Launch the Terminal program. 

2 Run the 
su 

command to gain root privileges for installation. Enter password to the root account when 
you are asked for it. 

3 Issue the following command to start installing the update: 
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rpm -U ˜/parallelsupdate/parallels-2.2.xxxx-lin.i386.rpm 

If you are trying to update to a version that is the same or older than the currently installed 
one, you will be warned that the package is already installed, or that a newer package is 
already installed, respectively. Look below this procedure for the guidelines on installing 
older version of the Parallels Workstation. 

4 After the installation completes, you should run the post-installation script. Issue the 
following command: 

parallels-config 

5 When prompted, press Enter on the keyboard.  

6 Read the license agreement up to the end by pressing Spacebar on your keyboard. To accept 
the agreement, type Y and press Enter. 

7 The Parallels Workstation configuration procedure configures, compiles and installs drivers. 
After the process is finished you will be informed about the successful completion. You can 
now run the new version of the Parallels Workstation. 

8 In the Terminal, issue the  
exit 

command to leave the root account. 

To update to a previous version of the Parallels Workstation on a computer supporting .rpm:

 perform steps 1-2 from the procedure described above; 
 move to the directory where the installation package is located: 
cd <installation directory> 

 issue the following command to start installing: 
rpm -U --oldpackage Parallels-2.2.xxxx-lin.i386.rpm 

 perform steps 4-8 of the updating procedure. 

Updating From DEB and TGZ Packages 

To update Parallels Workstation on a computer supporting .deb or .tgz, perform the steps related 
to your Linux primary system from the Parallels Workstation installation procedure. See the 
Parallels Workstation for Linux: Step-by-Step Installation (page 29) topic.  

Troubleshooting 

If you receive "Can not configure!" message or "Can not compile!" message (note that you 
should have kernel sources installed), you can view log file and try to fix problem yourself. Log 
file is named /usr/lib/parallels/comp.log.<log number>.error

If you can not fix the problem yourself, please send the log file and problem description to 
reports@parallels.com. We will assist you as soon as possible. 
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C H A P T E R  4  

Interface Basics 

This chapter provides information about Parallels Workstation window and its controls.  

In This Chapter 
Main Window ....................................................................................................................... 48 
Property Page ........................................................................................................................ 51 
Console View........................................................................................................................ 53 
Status Bar .............................................................................................................................. 54 
Text Size ............................................................................................................................... 55 
Making Screenshots .............................................................................................................. 56 
 
 

Main Window 
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The Parallels Workstation window displays an opened virtual machine and a set of visual tools 
for managing its behavior.  If a virtual machine is not started, only its configuration and 
resources, i.e. connected devices, are seen. This is called property page view.  See 
Property Page (page 51) to learn more about this. When you start the virtual machine, its 
console (on page 53) is opened and acts as the display of a real computer.  

Controls available in both property page and console view are the following: 

 Parallels Workstation menu; 

 Toolbar; 

  Status bar. 
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The status bar is described in a separate topic; see Status Bar (on page 54). 

Toolbar 

Toolbar buttons are used to: 

 Start a virtual machine. See Starting Virtual Machine (on page 149); 
 Shut down virtual machines. See Shutting Down and Resetting Virtual Machine (on page 

153); 
 Reset a virtual machine. See Shutting Down and Resetting Virtual Machine (on page 153); 
 Suspend/resume a virtual machine. See Suspending/Resuming Virtual Machine (page 154); 
 Expand a virtual machine screen to the full screen of your display. See Switching Virtual 

Machine to Fullscreen Mode (on page 152); 
 Switch between property page view and console view. See Console View (on page 53) and 

Property Page (page 51); 

Most of the toolbar buttons become active when you start the virtual machine. When the virtual 

machine is stopped, only the Power On button is active letting you start the machine. 

If you click a toolbar button it becomes visibly pressed reflecting the current virtual machine 

state. On the picture above, the Power On  and the Property Page View   buttons are 
pressed, that means firstly, the guest OS is running and, secondly, you are looking at the virtual 
machine's property page. 

By default the toolbar is located to the right of the Parallels Workstation window. You may 
place it at the top, at the bottom, or to the left of the window if you'd like. Parallels Workstation 
will keep this toolbar position next time you launch the system. 

To change a toolbar position: 

 Click the toolbar handle and drag it to the desired place.  

Simplifying Parallels Workstation Window 

You can simplify the Parallels Workstation window by hiding some of its components such as 
the toolbar and status bar.  

To hide the toolbar/status bar: 

 Click Toolbar/Status Bar in the View menu.  

You can make them visible at any time with the same action. Visible window elements are 
marked with check marks.  
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Property Page 
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When you open an existing virtual machine or create a new one its property page is displayed. 
The upper part of the page, Configuration, displays the virtual machine name, name of the 
configuration file with the path, and general VM settings: guest operating system type and 
version (regardless whether or not it is installed), acceleration level, last modification date, etc. 
These settings may be changed; and if you click on any of them, the Configuration Editor (on 
page 105) will be opened on the appropriate page. 

Note. The name of the virtual machine is not linked to the Configuration Editor, however it can 
be changed on the General Options (on page 106) tab. 

The Resources list shows all devices connected to the virtual machine and their current options. 
To  edit any device simply click device name. The Configuration Editor will open the tab 
corresponding to that device. 

The command button panel in the bottom of the property page contains buttons for: 

 creating a new virtual machine (page 57), 
 browsing hard disk for a virtual machine to open (page 104), 
 editing virtual machine configuration (on page 105),  
 and also saving an opened virtual machine configuration (page 106). 

Parallels Workstation allows you to pick for the property page the text size that fits you the best. 
See Text Size (page 55) for details.  

When Running Guest OS 

The property page remains available when a guest OS is running. You may open it to check the 
VM configuration. However, editing of the configuration is prohibited and the command button 
panel is disabled. 
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Console View 
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You interact with a running virtual machine via its console which is opened when you start the 
virtual machine (on page 149). If you have a guest operating system installed it will be 
displayed on the console exactly as the primary OS is displayed on a real monitor.  

During guest OS execution all toolbar buttons and many of the menu commands become active. 

When a guest operating system is running, you can switch between the console and the property 
page. To switch to the property page while in the console view, do one of the following: 

 click Property Page View  on the toolbar, 
 select Console View in the View menu.  

To return to console view while in the property page, do one of the following: 

 click Console View  button, 
 select Console View in the View menu.  

Fullscreen Mode 

Guest operating systems can be executed in fullscreen mode, making the Parallels Workstation 
menu, toolbar, and status bar become hidden. For detailed information see Switching Virtual 
Machine to Fullscreen Mode (on page 152). 

Console Screenshots 

You can make screenshots of the console while the virtual machine is active. See Making 
Screenshots (on page 56) for details. 
 

Status Bar 
The status bar displays information when virtual machine is running. Left part of the status bar 
displays prompt on the menu entry currently pointed by cursor. 

Each device (except memory) connected to the virtual machine is presented as an icon on the 
right of the status bar. 

 

 



 Interface Basics 55 
 

The following devices put their icons onto the status bar: 

 hard disk  , 

 CD/DVD-ROM ,  

 floppy disk drive , 

 network adapter , 

 serial port , 

 parallel port , 

 sound device , 

 USB controller . 

When a device is involved in the current process, 

 green circle   when reading is being performed, 

 orange circle   when writing is being performed.  

If a device can be connected/disconnected when running guest OS (CD/DVD-ROM, floppy 
drive, network adapter, serial and parallel ports, a sound device, and USB), these operations can 
be executed using the device context menu. Right-click on the device icon to display its context 
menu and select the command you need. The picture below shows the context menu of the 
CD/DVD-ROM drive. 

 

For more on this please refer to the Connecting Devices When Running Virtual Machine (on 
page 155) section. 
 

Text Size 
Parallels Workstation allows to adjust text size of the property page. Use View->Text Size-> 
Increase Text Size and Decrease Text Size commands. To return to initial text size click Reset 
Text Size command. 
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Making Screenshots 
Parallels Workstation allows you to make screenshots of the guest operating system window 
when guest OS is running. Click Console Screenshot in the VM menu. Type or select a name and 
a directory to store the screenshot file. Parallels Workstation saves screenshots as .bmp files in 
Windows primary OS and as .png files in Linux primary OS. 
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C H A P T E R  5  

Creating Virtual Machine 

This chapter discusses the tasks you should perform when creating a new virtual machine. They 
are: 

 creating a virtual machine configuration, 
 guest operating system installation, 
 installing the Parallels Tools. 

The procedure of creating virtual machines is similar both for Windows and Linux-based 
Parallels Workstation installations. 

In This Chapter 
Creating Virtual Machine Configuration .............................................................................. 57 
Installing Guest OS ............................................................................................................... 73 
Installing Parallels Tools....................................................................................................... 76 
 
 

Creating Virtual Machine 
Configuration 

This section discusses what is virtual machine configuration and the process of creating a new 
virtual machine. 
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Understanding Virtual Machine Configuration 
Each virtual machine hardware configuration is defined by a special Parallels Workstation 
configuration file having the .pvs extension. It contains all of the information about virtual 
devices attached to the virtual machine and files connected to it. In genera,l two files make up a 
virtual machine, a configuration file and a hard disk image file (several virtual hard disks can be 
attached). Other files may not be attached. 

The following table explains all file types that may be related to a virtual machine: 

.pvs This is a virtual machine configuration file. One configuration file defines one 
virtual machine.  

One instance of Parallels Workstation can run only one opened configuration file, 
i.e. only one virtual machine. To run several virtual machines, you should launch 
several instances of Parallels Workstation. Typical configuration file can be easily 
generated using the New Virtual Machine Wizard (page 59). 

.sav This is a virtual machine saved state file. This file is created when you suspend a 
virtual machine and contains the state of the guest OS and its applications in the 
moment when suspend was invoked.  

See the Suspending/Resuming Virtual Machine (page 154) for more information. 

.hdd This is a virtual hard disk of a Parallels Workstation virtual machine.  

When you create a new virtual machine, the New VM wizard prompts you to 
place a new virtual hard disk and .pvs configuration file into the same directory, 
however you may store these files in different folders. You may also attach an 
existing virtual hard disks to different virtual machines.  

More information about virtual hard disks can be found in the Hard Disk Images
(page 100) topic. 

.iso This is a CD or DVD-ROM image file. .iso image files are treated by an 
operating system as real CD/DVD discs. 

More information about .iso images is given in the CD/DVD Real Discs and 
Images (page 102) topic. 

.fdd This is floppy disk image file created by Parallels Workstation. .fdd image files 
are treated by an operating system as a real floppy disks. 

More information about .fdd images is given in the Floppy Disks and Disk 
Images (page 102) topic.   

.txt Serial and parallel ports can be emulated via output .txt files. See Serial Port 
Options (on page 122) and Parallel Port Options (on page 124). 
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New Virtual Machine Wizard 
There is a special New Virtual Machine Wizard in Parallels Workstation that provides a means for 
creating new virtual machines for both new and experienced users.  

The wizard offers three methods of creating a virtual machine: Typical, Custom, and Blank. 
They differ in time and the ability to specify various settings, and the appropriate method should 
be chosen based on a user's experience with Parallels Workstation. Regardless of what method 
is selected, you will be able to configure ready virtual machine using Configuration Editor (on 
page 105).  

Typical Virtual Machine 

Typical method is designed for new users and for fast virtual machine creation. When choosing 
this method you only need to specify: 

 the type and version of the guest operating system that will be installed; 
 the name of the virtual machine; 
 a directory for storing the virtual machine configuration file and a name of the configuration 

file. 

A virtual machine is created with the most common parameters for the selected guest operating 
system. A new hard disk image is created with predefined size and format, standard amount of 
memory is allocated, and so on. User can later change the settings and add new devices using 
the Configuration Editor. 

Custom Virtual Machine 

When creating a custom virtual machine configuration, the wizard allows you to set virtual 
machine parameters directly in the process of creation. This is intended for experienced users. 
When creating a custom virtual machine configuration, the user is asked to define: 

 the type and version of the guest operating system that will be installed; 
 the amount of RAM the virtual machine will use; 
 whether you want to create a new virtual hard disk, attach an existing one, or not to add one 

at all. In the first case you should specify the parameters of the new disk: it's size and type 
and where to store the disk file. When attaching an existing disk you have to locate the disk 
image file. If you select not to add a hard disk at all you are able to do it later in the 
Configuration Editor; 

 the type of networking in the virtual machine. If you select Bridged Ethernet, the wizard 
will ask to choose the network adapter that should be connected to the virtual device; 

 a name of the virtual machine; 
 a directory for storing the virtual machine configuration file and a name of the configuration 

file. 

The CD/DVD-ROM drive, floppy drive, and sound device (if it is supposed for the selected 
guest OS) are added automatically. Serial ports are included in some guest OS. Other additional 
devices can be added in the Configuration Editor. 

Blank Virtual Machine 
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Blank virtual machine has only memory in its configuration after creation. When you select this 
method, the wizard's Next button changes to Finish, and after you click it wizard creates the 
machine immediately. Nothing else need to be defined. Devices can be added to blank 
configuration manually in the Configuration Editor. 
 

Creating Typical Virtual Machine 
A typical virtual machine includes the following devices: 

 memory 
 hard disk drive 
 floppy drive 
 CD/DVD-ROM 
 network adapter 
 sound device (except for FreeBSD and MS-DOS configurations) 
 USB controller (in Windows 98/ME/2000/XP/2003 and all of the Linux typical 

configurations) 

OS/2 typical configuration includes a serial port.  

Amount of memory and hard disk size vary for different guest OSes. Look in the following 
table for memory amount and hard disk size provided for different guest operating systems.  
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The virtual hard disk for typical virtual machines is always created in expanding format (page 
101).  

 
RAM, MB HDD size, 

MB

Windows Vista 512 16000 

Windows 2003 384 8000 

Windows XP 256 8000 

Windows NT/2000 128 6000 

Windows 95 128 2000 

Windows 3.11 64 2000 

Linux 256 8000 

FreeBSD 256 8000 

OS/2 Warp 3;4 128 2000 

OS/2 Warp 4,5 
eComStation 256 6000 

OS/2 other 128 6000 

Solaris 256 12000 

MS-DOS 32 2000 

Other guest OSes 256 8000 

To create a typical virtual machine: 

1 Open Parallels Workstation. Click the  button or select New VM in File 
menu. The New Virtual Machine Wizard welcomes you. Click the Next button.  
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2 In this step the first option, Create a typical VM, is selected. If you are going to create a 

typical virtual machine, nothing needs to be changed on this screen. Click the Next button to 
continue to the next step.  
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3 Here you should specify the type and the version of the guest operating system you want to 
install on the new virtual machine. When the guest operating system is specified, click Next 
button. 

 
4 In this last step you should define a name for the virtual machine and indicate in which 

folder on the hard disk the virtual machine configuration file should be stored. By default 
the wizard will put it into standard place with a standard name. (The default folder for 
Parallels virtual machines is specified in the Preferences->Common (page 90) window.) 

Enter a descriptive name for the virtual machine in the Virtual machine name field. The name 
should be no longer than 50 characters. 

In the Configuration file field the default path and name for the configuration file is shown. If 
you do not like the default name or path you may browse your file system to locate an 
appropriate folder and name. You may also make changes directly in the field. 

Click Finish to begin the process of creating your new virtual machine, or click Back to 
examine settings on the previous steps.  
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After you click Finish, the new configuration is generated and opened in the Parallels 
Workstation window. The property page (page 51) is displayed. You may continue with 
installing the guest operating system (page 73) on the new virtual machine. 
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C H A P T E R  6  

Creating a Custom Virtual Machine 

1 Open Parallels Workstation. Click the button on the Command Button 
panel or select New VM in File menu. The New Virtual Machine Wizard welcome screen will 
appear. Click Next button.  
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2 The Select virtual machine configuration screen is opened. Select the second option, Create a 
custom VM configuration. Click Next to proceed. 

 
3 On the Select guest OS screen you should specify the type and version of the guest operating 

system you want to install on the new virtual machine. When done, click the Next button to 
move to the next step. 
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4 On the Specify memory size screen you should set the amount of RAM for the new machine. 
You can choose any value from 4 to 1500 MB. We strongly recommend that you allocate no 
more than the half of the physical RAM installed on your computer.  

Memory size should be in multiples of 4 MB. You will receive error notification and will 
not be able to go further until specify a value that meets this condition. 

To set memory value use slider, spin buttons, or type a value directly into the field.  

Click Next to move to the next step. 

 
5 On the Select action type screen you have to decide whether you want to create a new virtual 

hard disk, attach to the machine an existing one, or not to add disk at all. After specifying 
what wizard should do, click Next. 
If you have selected to use an existing hard disk image, go to the step 8 of the current 
instructions. 
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If you have decided not to add disk at all, proceed to step 9. 

 
6 If you selected to create a new virtual disk on the previous step, you should specify its size 

and format. Disk formats are shortly explained on this wizard screen, but a more detailed 
description is given in the Hard Disk Images (page 100) topic.   

After specifying the data required, click Next.   
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7 On the Select an image file screen you should determine the path where the virtual disk 
image should be stored, and the name of the disk. 

The wizard prompts you to store the new hard disk image under the default path that is 
specified on the Common tab (page 90) in the Preferences window, in a separate folder. 
Files of each virtual machine are automatically stored in separate folders, that are named in 
the following format <guest OS>.<number of the machine of the same 
version - 1>. 

For instance, the first Windows 2000 virtual machine is proposed to store in the 
\win2000\ folder. For the second Windows 2000 VM \win2000.1\ folder is offered, 
and so on. 

If you don't like the default name or path you may browse for the right folder and name, as 
well as make corrections directly in the field. 

 
After you click Next the wizard checks if the specified folder exists, if not, a permission for 
creation is asked: "Directory <name> does not exists. Do you want it 
to be created automatically?" Click Yes.  

Continue to the step 9 of the current instructions. 
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8 Since you decided to attach to the new VM an existing hard disk image (in step 5) you have 
to specify where this disk image is stored. Use the Browse button to locate it or type the file 
name with its path directly in the field. 

 
After you click Next the wizard searches the disk for the specified file, and if it does not find 
the file, you are notified that "The specified file <file name> does not 
exist. Please select a different file." 

9 Here you will specify the type of networking for the new virtual machine.  

Select Bridged Ethernet if you want to access the Internet inside the virtual machine.  

Select Host-only Networking if you want to create a virtual network or you don't want to 
access the network outside your local computer. See Networking in Virtual Machine (page 
131) for detailed information about Bridged Ethernet and Host-only types of networking.  
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If you do not have physical network interface card or do not need a network adapter in this 
virtual machine, select the Networking is not required option. 

 
Click Next. If you have selected Host-only Networking or Networking is not required proceed 
to the step 11 of the current instructions. 
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10 If you have selected Bridged Ethernet networking for the new machine, on this screen you 
should specify which real adapter should be connected to the virtual drive. Select one in the 
list and click Next. 

 
11 On the Select virtual machine configuration file screen you should determine the name of the 

virtual machine and the folder where the virtual machine configuration file should be stored 
and with what file name. 

Specify a descriptive name for the machine in the Virtual machine name field. The name 
should be no longer than 50 symbols. 

In the Configuration file field the default path and name for the configuration file is shown. 
The wizard offers to store the configuration file in the same folder with the new hard disk 
image (if you have created a new virtual hard disk for the machine). The name of the folder 
is described in the step 7 of the current instructions.  
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If you don't like the default name or path you may browse for the right folder and name, as 
well as make corrections directly in the field.  

 
Click Finish after you specify the path and the name for the configuration file. If the folder 
does not exist the wizard displays notification: "Directory <name> does not 
exists. Do you want it to be created automatically?" Click Yes. 

New configuration will be created and opened in the Parallels Workstation window. 
 

Installing Guest OS 
This section discusses how to install an operating system in a virtual machine.  
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Installing a Guest Operating System on a Virtual Machine 
Before starting guest operating system installation, the virtual machine should be configured 
and the guest OS distributive should be connected to it. In addition to installation from a CD, 
DVD, or floppy, the guest OS distributive may reside in an image file(s) (an .iso image of 
CD/DVD or an .fdd image of a floppy disk).  

CD/DVD .iso images and floppy .fdd images can be made using the Parallels Image Tool 
included in Parallels Workstation distribution. For more information on Image Tool see the 
Using the Parallels Image Tool (page 174) chapter.  

Note: To install a guest OS from any physical disk when running Linux primary OS, you should 
have system privileges to access the corresponding device of your host computer. Otherwise 
you will not be able to connect CD/DVD-ROM or floppy drive of your virtual machine to 
proper physical device. 

General Steps: 

1 Start Parallels Workstation.  

2 Open or create a virtual machine configuration intended for installing guest OS. 

To install from a physical CD/DVD or CD/DVD .iso image: 

1 Select CD/DVD-ROM drive and open its options tab. 

On the virtual machine property page (page 51) click on the desired CD/DVD-ROM drive to 
open its CD/DVD-ROM Options (on page 117) in Configuration Editor. Make sure that the 
Enabled and the Connect at startup options are selected. 

2 Connect the CD/DVD-ROM drive to the guest OS distribution. 

If you install from a real CD/DVD:  

Select the Use real CD/DVD-ROM and specify which real drive to connect to the virtual device 
in the CD/DVD-ROM Drives list. 

Insert the CD/DVD disk with the operating system distribution into the appropriate drive of 
your computer. 

If you install from an .iso image file: 

Check the Use image file option and specify the path to the .iso distribution file in the 
Image File field. 

3 Specify the IDE channel for the virtual CD/DVD-ROM. In the Connect to list select 0:1. 

4 Save the virtual machine configuration. See the Saving Virtual Machine Configuration 
(page 106) subtopic in the Editing Virtual Machine Configuration topic.  

5 Start your virtual machine by clicking Power On  on the toolbar. Follow the installation 
instructions for the operating system. 

To install from a physical floppy disk or an .fdd floppy image: 

1 Select the floppy drive and open its options tab. 
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On the virtual machine property page (page 51) click on the Floppy resource to open Floppy 
Options (on page 113) in Configuration Editor. In the Floppy Options tab, make sure that the 
Enabled and the Connect at startup options are selected. 

2 Connect the floppy drive to the guest OS distribution. 

If you install from a real floppy disk: 

Select the Use real floppy option and specify which real drive to connect to the virtual device 
in the Floppy Drives list. 

Insert the floppy disk with the operating system distribution into the appropriate drive of 
your computer. 

If you install from an image file: 

Check the Use image file option and specify the path to the .fdd (or another) distribution 
file in the Image File field. 

3 Save the virtual machine configuration. See the Saving Virtual Machine Configuration 
(page 106) subtopic in the Editing Virtual Machine Configuration section. 

4 Start the virtual machine by clicking Power On  on the toolbar. Follow the installation 
instructions for the operating system. 

When Installing on Non-empty Hard Disk 

If you install a guest operating system onto a hard disk where the guest OS was previously 
installed, you have to change the boot sequence:  

 after you perform the general steps listed above, open the Booting Options tab of the 
General Opt (on page 106)ions, 

 set the boot sequence to [CD-ROM, Hard Disk, Floppy] or [Floppy, Hard Disk, CD-ROM], if you 
installed from a CD/DVD or a floppy disc respectively 

During installation, when the guest OS reboots for the first time, return the boot sequence to 
booting from hard disk: 

 When the virtual machine is off, set [Hard Disk, Floppy, CD-ROM] sequence, save the 
settings, and start the guest OS.  

 
 

Configuring X Window System in FreeBSD Guest OS 
If you want to use the X Window System graphic shell in a FreeBSD guest OS, you should 
configure it manually. Running automatic configuration command X -probeonly or X -
configure may not work. The X Window System can be configured using xorgconfig 
text utility or xorgcfg graphical utility. You need root privileges to run them. 

To start manual configuration: 

1 Issue one of the following commands in the command line: 
su -l root -c xorgconfig  

or 
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su -l root -c xorgcfg 

2 Enter the root password when you are asked for it. 

When configuring set the following: 

1 Select Generic VESA compatible video card. 

2 Select 4096K of video memory. 

3 Select screen resolution for a color depth. You may specify single resolution for any color 
depth. For instance, specify 640x480 resolution for 8-bit color, 800x600 resolution for 16-
bit color, and so on. Do not specify several resolutions for a color depth, because upon 
startup, X window will select the greatest one. 

You may set a single resolution for a particular color depth (for instance, if you are going to 
work with 16-bit color only, select any single resolution for it), and later select only this 
color depth for your configuration . 

4 Select preferred color depth for your configuration. 
 

Installing Parallels Tools 
Parallels Workstation includes specially developed tools that help you use your virtual machines 
in the most comfortable and efficient way. The current version of Parallels Workstation is 
supplied with tools for the following guest operating systems: 

 Windows versions 95, 98, ME, NT, 2000, XP, 2003, Vista; 
 OS/2 and eComStation; 
 Solaris.  

We provide PRL8029 driver for Solaris guest OS that should be installed if you want the 
Solaris virtual machine to support networking.   

 For other guest operating systems we provide PRL8029 network adapter driver. 

Most of the tools are located on the CD image VMTOOLS.ISO, however OS/2 network drivers 
that are conveniently installed during guest OS installation are also located on the floppy disk 
image VMTOOLS.FDD. Both CD and floppy images can be found in the directory where 
Parallels Workstation is installed: /Library/Parallels/Tools. 
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Parallels Tools Overview 
 

Tool Description
Clipboard Synchronization Tool The Clipboard Synchronization Tool syncs the guest OS 

clipboard and the primary OS clipboard, allowing you to 
easily exchange texts and pictures between the primary OS 
and the guest OS. Currently you can only exchange .bmp
pictures having up to a 128KB size. 

In you enable the Clipboard Synchronization Tool in all of 
your guest OSes, all of them will share the same clipboard 
with primary OS. 

In all the Windows guest OSes, this tool is installed 
automatically when you perform Parallels Tools installation. 
In OS/2 and eComStation you must install it manually. 

Time Synchronization Tool The Time Synchronization Tool allows the guest OS to keep 
the same system time as the primary OS. Without this tool 
the guest OS system time may differ from that of the primary 
OS.  

This tool also allows you to maintain a constant difference 
between the guest OS system time and the primary OS 
system time. You may configure this tool while the guest OS 
is running. See Time Synchronization Tool Options (page 
163) to learn how perform this task. 

Note. Before starting the Parallels Time Synchronization 
Tool, all other time synchronization services must be stopped 
in order to avoid potential conflicts. 

Video Driver The best graphical mode available in Windows NT and 2000 
guest operating systems without this driver is 16-color VGA 
with 640x480 resolution. The video driver allows Parallels 
Workstation to use SVGA graphical modes in guest OS 
monitors.  

In Windows XP/2003 the video driver is required for the 
mouse tool and is chosen automatically when you select the 
mouse tool installation. 

Note. If you install the video driver you will not be able to 
use VGA modes. To return to VGA, you must uninstall the 
Parallels Tools. 
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Mouse Synchronization Tool The Mouse Synchronization Tool enables the mouse to be 
captured and released without a special hot key combination 
defined in the Hot Key Combinations (page 98) tab of the 
Preferences window. Using this tool makes mouse 
movements smoother and improves system reaction on 
mouse. This tool is especially effective when running 
Parallels Workstation on a remote terminal.  

Sound Driver Parallels Tools pack includes an AC'97 sound driver for those 
guest operating systems that do not contain standard AC'97 
driver.  

Sound drivers for Windows XP/2003 are not included in the 
Parallels Tools pack since these operating systems contain 
sound drivers in their installations. 

Shared Folders Tool This tool is needed for a guest OS to view shared folders. 
Without it, the guest OS can not use the shared folders 
although they may be set up in your virtual machine 
configuration. To learn more about shared folders see Using 
Shared Folders (page 133). 

Disk Compacting Tool Parallels Workstation uses virtual hard disks of two types: 
plain and expanding. Expanding virtual disks grow in size as 
you work with them. The Disk Compacting Tool reduces the 
size of expanding virtual hard disks by cleaning up unused 
disk space. See Compacting Virtual Disk (page 169) for 
guidelines on using this tool. 

This tool does not reduces the size of plain virtual disks.   

Network Adapters and Drivers:  
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 Parallels Network Adapter 
Driver This Ethernet driver for the RTL8029 adapter is specially 

developed for Parallels Workstation to improve network 
performance. We recommend that you install this driver 
whenever possible.  

 RTL8029 CD with Parallels Tools includes native Realtek (all except 
for Solaris driver) drivers for RTL8029 network adapter for 
many different operating systems. They are located in the 
Drivers\Network\RTL8029 directory of the 
vmtools.iso CD image. 

Some guest operating systems, such as Windows 2000, 
contain an RTL8029 driver in their distributions, whereas 
others like Windows 2003 and OS/2 do not include this 
driver at all.  

Note. Unlike other guest OSes, a Solaris guest OS requires an 
RTL8029-compatible driver to be installed to support 
networking. Otherwise networking will not be possible. 

An RTL8029-compatible driver for Solaris has been created 
by an independent developer and is distributed under the 
terms of BSD license. Slightly modified version of this driver 
is included into Parallels Workstation 2.2 distribution. 

The table below shows which tools have been developed for which operating systems. 
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Windows 

 
95, 98, NT, 
ME 2000 XP, 2003 

OS/2, eCS 

 

Solaris 

 

other 

 

Clipboard 
Synchronization Tool + + + +   

Time Synchronization 
Tool + + +    

Video Driver + + +    

Mouse Driver  + + +   

Sound Driver + +  +   

Shared Folders Tool  + +    

Disk Compacting Tool + + +    

Network Drivers:       

 Parallels Network 
Adapter Driver  + +    

 RTL8029 + + + + + + 

In Windows guest OSes you can control the tools during guest OS execution. See the Parallels 
Tools Center (page 161) section to learn how to do this. 
 

Windows Tools Installation 
To install Parallels Tools in Windows guest OS do the following: 

1 Make sure that the virtual machine configuration includes a CD/DVD-ROM drive and it is 
enabled (the Enabled check box is selected). See CD/DVD-ROM Options (on page 117). 

2 Start your guest operating system and log in. In order to install tools properly do not begin 
the installation until OS completes its startup and you log in. 

3 Select Install Parallel Tools in the Parallels Workstation VM menu.  

4 You are warned about the necessity of having the guest OS fully started and being logged 
in: "You can install the Parallels Tools only if the guest 
operating system is running and you are logged in. If you are 
not logged in now, select Cancel and run Parallels Tools 
installation later." If you are logged in, click OK to start installing.  

5 Parallels Tools Setup wizard starts and greets you. Click Next to move to Choose Destination 
Location screen. If you do not like the default directory, select another one using the Change 
button. Then click Next. 
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6 On the Setup Type screen you should choose between the complete setup and a custom 
one. The complete setup installs all of the tools available for your guest OS. If you select 
custom setup, the Select Components screen asks you to select the desired tools from the 
tools available for your guest OS. 

7 Choose the program folder on the Select Program Folder screen, then the Check Setup 
Information screen displays the options selected. If they are correct, click Next to begin the 
installation. 

8 By default a Windows operating system is configured to warn you every time an unsigned 
driver is installed. Parallels Tools installation wizard supposes to temporarily disable these 
warnings.  

When you receive the following message: "Parallels Tools installation 
contains a number of unsigned drivers. These drivers are 
required for proper functioning of Parallels Tools. Currently 
your system is configured to warn you every time an unsigned 
driver is installed. Do you want to receive these warnings 
during Parallels Tools installation?" click OK to disable the unsigned 
driver warnings during Parallels Tools installation. They will re-enabled later when the 
installation will be complete. 

9 After the wizard copies tools, the Installation Completed screen asks if you want to restart 
the computer now. In all of the Windows guest OSes, except 98 and NT, you must restart 
the virtual machine after this setup procedure. Accept the selected option and click Finish. 
The virtual machine will be restarted and ready for work with the tools installed.  

Notes: 1. In a Windows 98 guest OS, the Sound Driver requires you to perform additional steps 
after this setup. Proceed to Windows 98 Sound Driver Installation (page 82). 

2. In Windows NT guest OS, proceed to Windows NT Tools Installation (page 82) to complete 
setup in this guest OS. 

Troubleshooting When Installing Tools 

Parallels Tools installation is invoked by Windows AUTORUN feature for CD/DVD-ROM 
drive. It is enabled by default, however if you have disabled it manually, nothing happens after 
you select the Install Parallels Tools command. (In any way, the vmtools.iso CD image will 
be connected to the virtual machine CD-ROM drive, however it is not visible to the user.) To 
solve this problem do one of the following: 

 Enable AUTORUN function for CD-ROM drive in guest Windows. 
 Start tools installation manually. 

Open the contents of the vmtools.iso in Windows Explorer, find PrlTools.exe file, 
and start it. 
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Windows 98 Sound Driver Installation 
The Sound Driver for a Windows 98 guest OS requires additional steps after the general 
Parallels Tools installation described in Windows Tools Installation (on page 80). 

To install AC'97 Sound Driver in Windows 98: 

1 Open the Control Panel. To do this, click the Start system menu, select the Settings item, 
and then Control Panel. 

2 Double click the System icon to open the System Properties window. In the System 
Properties window select the Device Manager tab. 

3 Locate the PCI Multimedia Audio Device in the hardware list. Select it and click the 
Properties button. 

4 In the PCI Multimedia Audio Device Properties window click the Reinstall Driver button. 

5 In the Update Device Driver Wizard select the Sound, video and game controllers item and 
click the Next button. 

6 In the second wizard screen select the second option: Display a list of all the drivers in a 
specific location, so you can select the driver you want, and click Next. 

7 On the screen asking you to select type of device click the Next button. 

8 In the next wizard screen click the Have Disk button. The Install From Disk window is 
opened, in the Copy manufacturer's file from: field type the following path "C:\Program 
Files\Parallels\Parallels Tools\Sound" and click OK. 

9 In the Select Device window select the AC'97 Audio and click OK. 

10 In the Update Device Driver Wizard click the Next button. When wizard asks, insert disc (or 
connect CD-ROM image file) with your Win98 distribution and type path to it in the field 
Copy files from. Click OK button. After wizard finishes copying files, click Finish button in 
its window. 

11 Close the windows with AC'97 audio properties and system properties. 

12 Restart the virtual machine if wizard asks you to do so for the new settings to take effect.  
 

Windows NT Tools Installation 
To install Parallels Tools in Windows NT: 

 Perform the installation procedure described in the Windows Tools Installation (on page 80) 
topic. It is enough to install such tools as Clipboard Synchronization and Mouse 
Synchronization Tools. 

 Perform these specific steps for installing the Video Driver and Sound Drive: 

Video Driver Installation 

To install the Video Driver do the following: 

1 Open the Control Panel. For this click the Start system menu, select the Settings item, and 
then Control Panel.  

2 Double click the Display icon to open the Display Properties window. 
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3 In the Display Properties window select the Settings tab. Then click the Display Type button. 

4 In the Display Type window select the Change button. 

5 In the Change Display window select the Manufacturers --> Parallels and Display --> Parallels 
Video Driver. Click OK. 

6 In the Third-party Drivers window click Yes. 

7 Installing Driver window informs you about successfully completed installation. Click OK. 

8 Click the Close button in the Display Type window. 

9 Click the Close button in the Display Properties window. 

10 Click the Yes button in the System Settings Change window to restart the guest OS. 

Note: You must restart virtual machine after this setup procedure. 

AC'97 Sound Driver Installation 

To install AC'97 Sound Driver do the following: 

1 Open the Control Panel. For this click the Start button in the system menu. Then select the 
Settings item, and then Control Panel. 

2 Double click the Multimedia icon to open the Multimedia Properties window. 

3 In the Multimedia Properties window select the Devices tab. Then select the Audio Devices 
from Multimedia devices: tree. Click the Add button. 

4 In the Add window, select the Unlisted or Updated Driver from List of Drivers. Click OK. 

5 In the Install Driver window click the Browse button and select the sound driver path. 

If you have installed Parallels Tools to the default location, select C:\Program 
Files\Parallels\Parallels Tools\Sound. 

If you have installed Parallels Tools to another directory, you should locate this directory. 

Click OK. Then click OK in the Install Driver window. 

6 In the Third-party Drivers window click Yes. 

7 The Add Unlisted or Updated Driver window informs you that you are about to install the 
AC'97 Audio Driver. Click OK.  

8 Click OK in the About AC97 Audio Driver window. 

9 Click OK in the System Settings Change window. 

10 Click Close button in the Display Type window. 

Note: You must restart virtual machine after this setup procedure. 
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Solaris Network Driver Installation 
Unlike other guest OSes Solaris does not support the RTL8029 network driver emulated in 
virtual machines. To add RTL8029 support to a Solaris virtual machine you need to install the 
RTL8029 network adapter driver. We have created the special network.sh script that helps 
you to do this, or you may install and configure the driver manually. Both ways are described 
below.  

Before Installing the Driver 

Before installing the driver perform the following steps: 

1 Make sure that the virtual machine configuration includes a CD/DVD-ROM drive and it is 
enabled. See CD/DVD-ROM Options (on page 117). 

2 Start your guest operating system. 

3 Connect the CD image with tools, vmtools.iso, to the CD/DVD-ROM drive of the 
virtual machine: 

 right-click the CD/DVD-ROM icon on the status bar and select the Connect image menu 
item (instead you may select Devices/CD/DVD-ROM <number> --> Connect Image in the 
Parallels Workstation menu); 

 browse for vmtools.iso in the folder where you installed Parallels Workstation. 

Proceed to installing the RTL8029 network driver using the network.sh script or manually. 

To install RTL8029 network driver using network.sh script: 
1 In the shell, run the 
cd /cdrom/PRLTOOLS/Drivers/Network/RTL8029/SOLARIS/ 

command to move to the respective directory. 

2 Issue the following command to begin installing the driver 
./network.sh 

3 You are sequentially informed that the driver is being extracted, compiled and installed. 
When it is finished, you are asked "Will you receive IP addresses from 
DHCP server?"  If IP addresses on your network are managed by DHCP server proceed 
to step 4, otherwise proceed to step 5. 

4 If IP addresses on your network are managed by DHCP server, type "Y" and the script will 
configure the DHCP client. Proceed to step 6.  

5 If IP addresses on your network are NOT managed by DHCP server, type "N" and then 
specify an IP address for your virtual machine, network address, network mask, and default 
gateway IP address when you are asked for them.  

6 Restart the guest operating system by issuing the command 
init 6 

To install RTL8029 network driver manually: 
1 In the shell, issue the following command to get root privileges: 
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su 

Enter the password to the root account when you are asked for it. 

2 As a root run the following commands:  
cd /tmp 
gzcat /cdrom/PRLTOOLS/Drivers/Network/RTL8029/SOLARIS/ni0.8.11.tgz|tar 
xf - 
cd ni-0.8.11 
/usr/ccs/bin/make install 
./addni.sh 

3 If IP addresses on your network are managed by DHCP server issue the following 
commands: 

touch /etc/hostname.ni0 
touch /etc/dhcp.ni0 

If IP addresses on your network are NOT managed by DHCP server, see the Solaris System 
Administration Guide. 

4 Leave the root account by running the command 
exit 

5 Restart the guest operating system by issuing the command 
init 6 
 

OS/2 and eComStation Tools Installation 
All of the OS/2 and eComStation tools can be installed from the vmtools.iso CD image. 
Network drivers can also be installed from the floppy disk image file vmtools.fdd during 
operating system installation. The latter is easier in most cases. 

Before starting the installation you should connect the CD-ROM image with Parallels Tools to 
your virtual machine CD-ROM drive. Do the following: 

 Select Install Parallels Tools in the Parallels Workstation VM menu. 

Mouse Synchronization Tool Installation 

The Mouse Synchronization Tool consists of the mouse driver and the video filter.  

Note: To install the Mouse Synchronization Tool you should have a VESA video driver 
installed, such as SDD or GENGRADD. For instructions on how to do this refer to OS/2 
documentation. 

To install the mouse tool: 

1 Click the Drives icon on the system panel. Select the CD-ROM drive and Drivers\Mouse\OS2 
directory on it. 

2 Launch the INSTALL.CMD batch file. The INSTALL.CMD copies files and makes 
necessary modifications to the CONFIG.SYS file. 

3 Restart the guest OS/2 operating system. 
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Note: The Mouse Synchronization Tool increases performance of the guest OS/2 operating 
system under Citrix. 

Clipboard Synchronization Tool Installation 

In OS/2 and eComStation you must launch the Clipboard Synchronization Tool manually. This 
tool is not a tool itself but an ordinary application, and should be treated as such. If you want the 
Clipboard Synchronization tool to start automatically when your guest operating system is 
started: 

 include the tool file PrlClip.exe into autostart group (startup.cmd file or another 
file as it is done in your operating system). 

The Clipboard Synchronization Tool is located in the ClipBrd\OS2 directory on the CD-ROM 
containing Parallels Tools. 

Sound Driver Installation 

Note: Before installing the Sound Driver you should have multimedia support installed in OS/2 
guest OS.  

To install the Sound Driver: 

1 Click the System Setup icon on the system panel.  

2 Select Install/Remove line, and then select Multimedia Application Install. 
3 In the IBM Multimedia Presentation Manager/2 - Installation window choose CD-ROM drive, 

then Drivers\Sound\OS2 directory. Select the ALC Codec feature and click the Install button. 

4 Restart the OS/2 guest operating system. 

Network Driver Installation 

Below we consider the installation of the Realtek RTL8029 driver inside the OS/2 Warp version 
4.0.  

1 Click the System Setup icon on the system panel. 

2 Click the MPTS Network Adapters and Protocol Services icon to open the Multi-Protocol 
Transport Services window. 

3 Click Configure. 

4 In the Configure window that opens, click Configure again to open the Adapter and Protocol 
Configuration window. 

5 Click the Other adapters button below the Network Adapters section of the window to open 
the Copy Additional Network Adapter Drivers window. 

6 Specify the path to the Parallels driver on CD-ROM disc image. The path should be: 
<CD-ROM drive>\Drivers\Network\RTL8029\NDIS2OS2 

7 Click OK. The Parallels network adapter driver will be copied. After this you can see the 
name RTL8029 PCI Ethernet Adapter included in the Network Adapters list. Select this name. 

8 Click Change in the Network Adapters section of the window to change the current network 
adapter into the selected one. 
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9 Click OK when the message "Are you sure you want to change this 
network adapter?" is displayed. After you click OK, the RTL8029 PCI Ethernet 
Adapter appears in the appropriate field of the Current Configuration section of the window. 
Now if you click Edit in the Current Configuration section of the window, you will see that 
you do not need to configure any this driver properties, because it is self-configurable. 

10 Click OK when finished. 

11 Close both the Configure and Multi-Protocol Transport Services windows.  

12 Click Exit in the Update CONFIG.SYS window. 

13 Exit the configuration program and restart the guest OS. 
 

Upgrading Parallels Tools 
If you have a virtual machine created by a previous version of Parallels Workstation (2.0 or 2.1) 
with Parallels Tools installed, please upgrade Parallels Tools to use all capabilities of Parallels 
Tools Center including Shared Folder Options. 

To upgrade Parallels Tools: 

1 Make sure that the virtual machine configuration includes a CD/DVD-ROM drive and it is 
enabled (the Enabled check box is selected). See the CD/DVD-ROM Options (on page 117). 

2 Start your guest operating system and log in. In order to install tools properly do not begin 
the installation until OS completes its startup and you log in. 

3 Select the Install Parallel Tools in the Parallels Workstation VM menu.  

4 You are warned about necessity of having guest OS fully started and being logged in: "You 
can install the Parallels Tools only if the guest operating 
system is running and you are logged in. If you are not 
logged in now, select Cancel and run Parallels Tools 
installation later." If you are logged in, click OK to start installing.  

5 Parallels Tools Setup wizard starts and informs you that you have the Parallels Tools 
already installed in your virtual machine and they will be updated. Click Next to move to the 
Setup Type screen. 

6 In the Setup Type screen you should choose between the complete setup and a custom 
one. The complete setup installs all of the tools available for your guest OS. If you select 
custom setup, Select Components screen asks you to select desired tools from all the tools 
available for your guest OS. 

7 In the Ready to Install the Program screen you are able to return back to review installation 
settings. When you are ready, start installation by clicking the Install button.  

8 If your Windows guest system is configured to warn you every time an unsigned driver is 
installed, you will receive the following message: "Parallels Tools 
installation contains a number of unsigned drivers. These 
drivers are required for proper functioning of Parallels 
Tools. Currently your system is configured to warn you every 
time an unsigned driver is installed. Do you want to receive 
these warnings during Parallels Tools installation?" Click OK to 
disable warnings during Parallels Tools installation. They will re-enabled later when the 
installation will be complete. 
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If your system is configured to block the unsigned drivers installation, you will receive the 
similar message prompting you to allow installation of these drivers. Click OK, otherwise 
Parallels Tools can not be installed at all. 

9 The wizard copies tools. When finished, Update Completed screen asks if you want to restart 
the virtual machine right now. Accept the selected option and click Finish.  

Note that the virtual machine should be restarted in order that Parallels Tools function 
properly. 

Windows NT  

In Windows NT guest OS, readmes for continuing installation of the video and audio drivers 
will be opened. Close them since re-installation of the drivers is not needed. 

 
 

Uninstalling Parallels Tools in Windows Guest OSes 
To uninstall Parallels Tools in all Windows guest operating systems except Windows NT, you 
should activate the same wizard as when installing. Do the following: 

1 Select Install Parallel Tools in the VM menu.  

2 Parallels Tools Setup wizard performs the diagnostics of the operating system and asks "Do 
you want to completely remove the selected application and 
all of its components?" Click Yes to begin the process.  

3 After the wizard removes the tools, the Uninstallation Completed window asks if you want to 
restart the computer now. Accept the selected option and click Finish. The virtual machine 
will be restarted.  

4 After the OS is started up, the System Settings Change screen asks "Do you want to 
restart your computer now?". Click Yes. When the virtual machine is restarted 
once more, the tools are completely uninstalled.  

Note: After uninstalling Parallels Tools and restarting the virtual machine, the guest operating 
system may display a warning that it should be restarted once more. In this case restart the guest 
operating system one more time to ensure its correct functioning. 

Uninstalling Tools in Windows NT 

In Windows NT Parallels Tools can be uninstalled using standard operating system techniques. 
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C H A P T E R  7  

Managing Virtual Machines 

This chapter discusses multiple ways to change a virtual machine configuration and provides 
information on setting user preferences and using virtual disks.  

In This Chapter 
Setting Parallels Workstation Preferences ............................................................................ 89 
Using Virtual and Real Disks................................................................................................ 99 
Selecting and Opening Virtual Machine ............................................................................... 103 
Editing Virtual Machine Configuration ................................................................................ 105 
Adding New Devices to Virtual Machine ............................................................................. 128 
Networking in Virtual Machine ............................................................................................ 131 
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Using USB Devices in Virtual Machine ............................................................................... 135 
Custom Screen Resolutions................................................................................................... 135 
Making Copy of a Virtual Machine ...................................................................................... 137 
Keyboard Shortcuts in Virtual Machine ............................................................................... 141 
About Parallels Workstation Screen ..................................................................................... 142 
More Information.................................................................................................................. 143 
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Setting Parallels Workstation 
Preferences 

Settings that affect more than one virtual machine are contained the single menu entry. To edit 
these general preferences click Preferences in the Parallels Workstation Edit menu. 

Common, User Interface, and Hot key preferences are assigned for each user. Memory and 
Network preferences concern all users that work on a particular computer and all virtual 
machines they launch. 
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Common Preferences 

 

Settings on this tab can be different for each user of your computer. 

Workspace: 

 Default directory for virtual machines. A directory proposed by Parallels Workstation to a 
user for saving new configuration files and hard disk images is specified on this tab in the 
Default directory for virtual machines field. It is possible to choose another location when 
creating configuration file or hard disk image. 

 Two options, Load recently used VM at startup and Show startup dialog, determine what 
happens at Parallels Workstation startup. By default, both options are selected and the 
application starts with the last used virtual machine configuration. If this configuration is 
already opened in another instance of Parallels Workstation or the configuration file cannot 
be found on the given path (for instance, it has been moved to another folder or deleted), 
then Startup Options dialog is opened upon Parallels Workstation startup. 
If the Load recently used VM at startup option is selected while the Show startup dialog 
option is turned off, Parallels Workstation will open a blank virtual machine upon startup if 
it is unable to open the last used virtual machine. 

If the Load recently used VM at startup option is not selected while the Show startup dialog is 
turned on, Parallels  Workstation always starts with the Startup Options dialog. 

If both options are turned off, Parallels Workstation starts with a blank virtual machine. 
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More information about what happens upon Parallels Workstation startup can be found in 
Selecting and Opening Virtual Machine (on page 103) and Startup Options Dialog (page 
104) topics.  

 Automatically check for updates setting controls an auto-update feature checking period. 
Specify Every day, Every week, or Every month to perform automatic check for 
update with that period. By choosing Never you disable the auto-update. See Auto-
Updating Parallels Workstation in Windows (page 36) or Auto-Updating Parallels 
Workstation in Linux (page 42) for auto-update feature description.   

VM shutdown behaviour: 

Radio buttons in this group control the effect upon selecting the File -> Exit menu item while the 

virtual machine is running or clicking the Windows close button  for the Parallels 
Workstation window.  

 If you want all virtual machines to be suspended upon these actions, select the Suspend VM 
radio button.  

 If you want all virtual machines to be stopped upon these actions, select the Power Off radio 
button. 

 When you are unsure if you want virtual machines to stop or to suspend, select the Ask me 
what to do radio button. Every time you click the Windows close button  or select the 
File -> Exit menu command, you will be asked to choose whether you want to stop or 
suspend the virtual machine. 
See the Suspending/Resuming Virtual Machine (page 154) topic to learn about 
suspending/resuming virtual machines. 
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Memory Preferences 

 

On this tab maximum amount of physical memory (RAM) that system should reserve to all 
simultaneously running virtual machines on your computer can be adjusted. This setting applies 
to all users of your computer. 

The maximum memory allowed depends on physical RAM size of your computer. Some 
memory must be reserved for your primary operating system. From the remainder you can 
select the maximum RAM allowed for Parallels Workstation. If you have one instance of virtual 
machine running, it may use all the memory allocated here. In case of several simultaneously 
running virtual machines this memory will be shared between them. Memory for a specific 
virtual machine is set on the Memory tab (page 112) in Configuration Editor. 

Memory amount should be multiple of 4. If it doesn't then you will receive error notification 
when trying to save memory options. To set an appropriate memory amount you may use the 
slider, the spin buttons in the Reserved memory limit field, or type a value directly into the field.  
 

 



 Managing Virtual Machines 93 
 

Network Preferences 

 

Parallels Workstation provides host-only network accessible only to a primary system and 
virtual machines running on it. Methods of configuring different types of host-only network are 
discussed in the Creating Host-Only Network (page 132) topic.  

The Network tab is intended for specifying a range of IP addresses to be assigned to virtual 
machines by Parallels DHCP server when configuring host-only network with dynamic IPs.  

The Scope start address and Scope end address values determine the first and the last IP 
addresses. First address of this scope DHCP server usually assigns to itself. The second address 
is usually given to the primary system. Others are assigned to virtual machines. Scope start 
address and Scope end address should belong to the same subnet. 

Subnet mask should be set in the Scope mask field. 

Note. Before changing DHCP scope settings make sure that there is no virtual machine running 
in Host-only networking mode. 

To check the networking mode of a running virtual machine: 

1 Point the mouse cursor to the network adapter icon  in the status bar,  

2 Check the Mode line in the inscription. 
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Changing Network Preferences in Linux Primary OS 

To edit settings on this tab in Linux primary OS you need root privileges. Users with other 
than root privileges can only view them.   

To edit settings on the Network tab: 

1 In the Terminal, run the command 
su -c parallels  

to get root privileges. Enter the password to the root account when you are asked for it. 

2 Start Parallels Workstation by issuing the command 
parallels  

3 In the Parallels Workstation menu, select Edit/Preferences/Network and enter new settings on 
the Network tab. 

4 Close Parallels Workstation. 

5 In the Terminal, run the 
exit 

command to leave the root account. 

6 Start Parallels Workstation as a normal user to continue work with it.  
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User Interface Preferences 
The appearance of the User Interface tab in Windows primary OS: 
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The appearance of the User Interface tab in Linux primary OS: 
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User interface preferences can be different for each user of your computer. 

Look and feel: 

 Dialog font option is only available in Linux primary OSes. It allows user to select 
preferable font, its size and other parameters to be used in system dialogs. Click Browse 
button near the field and choose new font if you wish to. To restore the default font and its 
size use the Default font button. 

 Show tooltips option is only available in Linux primary OSes. It controls the appearance of 
tooltips for the toolbar buttons and the command buttons on the property page (see Property 
Page (page 51)). By default this option is selected. 

 Allow to change guest resolution in fullscreen mode. If this option is selected, a virtual 
machine switched to fullscreen mode tries to change its screen resolution to the host screen 
resolution. This can be done when the video driver from Parallels Tools (page 76) is 
installed in your guest OS. 

 Allow to change host resolution in fullscreen mode. If this option is selected, resolution of 
your host monitor is changed to the resolution of the guest OS when a virtual machine is 
switched to fullscreen mode. Note that this option has lower priority than the previous one, 
so if both are selected this option is active only when the Allow to change guest resolution in 
fullscreen mode option can not be applied.  

Help browser: 

Note. This option group is only available in Linux primary OSes. 

 Help Browser Executable field shows the path to an executable file of web browser used for 
displaying help for Parallels Workstation. By default help is displayed in Mozilla web 
browser. If it is not installed on your computer or you prefer another browser, locate its 
executable file using browse button. 

Restore hidden messages:  

 If the Parallels Workstation wants to attract user's attention to an operation that is going to 
be performed or to some situation, it displays a message that contains a description and a Do 
not show this message again check box. If you select this check box, in the same situation 
the message would not be displayed. Restore hidden messages button on this tab allows to 
reactivate all suppressed messages. 
The system does not allow to suppress messages reporting potentially dangerous situations. 

 

 



 Managing Virtual Machines 98 
 

Hot Key Combinations 
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Hot key combinations can be different for each user of your computer. 

Parallels Workstation allows to define two hot key combinations: 

 For releasing a keyboard and mouse that are captured in the virtual machine screen. The 
default hot key is Ctrl+Alt. 

 For switching a virtual machine screen from the Parallels Workstation default window size 
to the fullscreen mode and back. The default hot key is Alt+Enter. 

You can set your own hot key combinations different for each case. Key combination should 
include one or more special keys (Ctrl, Alt and Shift), plus an ordinary key can be added. 

To define new key combination, you should perform the following operations: 

 Select check boxes of one or more special keys; 
 To add an ordinary key select the Custom check box, place input focus to the field for an 

ordinary key (the extreme right field), then press the key you want to use on your keyboard.  

Some keys and key combinations are prohibited to assign as Parallels Workstation hot keys. 

In Windows primary OS: The Tab and the Pause keys are prohibited to use as custom 
keys. 

In Linux primary OS: The Pause key is prohibited to use as a custom key and also the 
following key combinations are prohibited since they are Linux OS hot keys: 

 Ctrl+Alt+Backspace 
 Ctrl+Alt+ any key in the range of F1-F12, i.e. Ctrl+Alt+F1 - Ctrl+Alt+F12 

Notes. 1. You can free the mouse and the keyboard from the virtual machine screen without 
pressing hot key combination, if you install the Parallels Tools. See the Installing Parallels 
Tools (page 76) section to learn if this package is available for your guest operating system, and 
Capturing and Releasing the Keyboard and the Mouse (page 151) topic. 

 2. See also Switching a Virtual Machine to Fullscreen Mode (on page 152) for information on 
running virtual machine in fullscreen mode. 
 

Using Virtual and Real Disks 
In this section all types of disks handled by Parallels Workstation virtual machines are 
discussed. 
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Hard Disk Images 
The current version of Parallels Workstation creates and uses only virtual hard disks stored in 
.hdd files. The size of a virtual disk can be set within the range of 20 MB to 128 GB. 

Physical hard disks cannot be used by the current version of Parallels Workstation. To transfer 
data from the real hard drive to virtual machine use Shared folders (page 110) or create an 
image of a real disk with Parallels Image Tool (page 174) and attach it to the virtual machine as 
a data disk. 
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Format of The Virtual Disk 

A virtual hard disk can be one of two formats: plain or expanding.  

plain A disk of this format occupies all of the allocated space from the moment it is 
created. It takes more space on the real hard disk and more time to create as 
compared with an expanding virtual hard disk, but allows the guest OS to 
operate faster. 

expanding A disk of this format is small initially and grows as you add applications and 
data to the Virtual Machine. The disk size you enter when creating the disk is 
the maximum size to which the disk can grow. When you just begin to operate 
with the disk, it's size is much less than this value. 

Expanding disks take less time to create and save disk space. 

Disk format is set when you create a hard disk image. If you need to change the disk format 
after the hard disk file is created, a copy of the disk in another format can be made using the 
Parallels Image Tool (page 183).  

Hard disk images of both formats are stored in .hdd files, however the structure of a disk file is 
different. Format of the virtual hard disk is displayed in the Disk format field on the Advanced 
(page 116) tab of Hard Disk Options.  

If you discover that a hard disk's size is insufficient, you may increase disk capacity using the 
Parallels Image Tool (on page 174). 

Creating New Virtual Hard Disk 

A new virtual hard disk can be created at the same time when a virtual machine is created and 
attached to this virtual machine. For a typical virtual machine, a new hard disk is created 
automatically, as for custom virtual machines, you have to select Create a new virtual hard disk 
option in step 6 of the New Virtual Machine Wizard (page 59). 

To add a new virtual hard disk to an existing virtual machine use the Add Device Wizard (page 
128). 

You may also replace the current virtual hard disk in an opened virtual machine configuration 
with a new one using the Recreate button on the Hard Disk Options (page 114) tab in 
Configuration Editor.  

Besides creating new empty disk, an image of a real hard drive with all the data inside can be 
created using Parallels Image Tool (page 174). This feature is intended mainly for migrating 
data from real hard drive to virtual machine. 

Maintaining Virtual Hard Disks 
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Virtual hard disks require periodic maintenance procedures to keep disk operations quick and 
efficient, similarly to real hard disks.  An expanding disk is very size efficient at the beginning 
of a virtual machine's life cycle and becomes less and less efficient as time goes on, because 
each time writing to the disk is requested, the system allocates new space, and therefore disk 
size increases. Deleting files does not reduce the size of a virtual disk image file in the primary 
operating system. Eventually, an expanding virtual disk could grow enormously causing a 
number of inconveniencies.  

Parallels Workstation includes the Disk Compacting Tool which is recommended for all other 
guest operating systems. For more information on the Disk Compacting Tool refer to the 
Compacting Virtual Disk (page 169) topic. 
 

Floppy Disks and Disk Images 
Parallels Workstation can access real floppy disks, or create and use floppy image files that 
appears to virtual machine floppy drive as real diskettes. Floppy disk images used by Parallels 
Workstation have the .fdd format. Blank .fdd image can be created by two methods: 

 using the Recreate button on the Floppy Options (on page 113) tab of the Configuration 
Editor,  

 when adding a floppy drive to a virtual machine use the Add Hardware Wizard (page 128). 

An .fdd image of a real diskette can be created using Parallels Image Tool (page 174), a 
special tool for creating images of different real media that is installed along with Parallels 
Workstation. 

You may also use .img and .ima floppy images created by WinImage or VMware 
applications.  
 

CD/DVD Real Discs and Images 
Parallels Workstation can access real CD/DVD discs, or create and use CD/DVD images that 
appear to the CD/DVD-ROM drive of a virtual machine as real discs. Parallels Workstation uses 
CD/DVD discs in .iso format. Images in this format can be created by many applications, 
particularly by Parallels Image Tool (page 174), a special tool for creating images of different 
real media that is installed along with Parallels Workstation. 

There is a set of limitations on using CD/DVD-ROMs in Parallels Workstation in that it allows 
the use only of single-session CD and DVD-ROMs. Multisession disks cannot be handled. 
Sound from audio CDs cannot be reproduced. Neither CD nor DVD discs can be written. 
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Selecting and Opening Virtual 
Machine 

When you launch Parallels Workstation, the last used virtual machine is opened by default. This 
option is controlled by the Load  recently used VM at startup setting on the Common tab (page 
90) of the Preferences window. You may turn this option off, to start Parallels Workstation with 
Startup Options dialog, which is discussed in the separate topic Startup Options Dialog (page 
104), or with blank virtual machine. In these cases last used virtual machine can be opened via 
recently used list. 

There are other ways to open virtual machines as well: 

 List of recently used configurations; 
 Browsing the hard disk for a configuration; 
 Open a virtual machine in a new window. 

Opening Recently Used Configuration 

The list of recently used configurations in the File menu displays six most recently used 
configuration files. Use this method to open a virtual machine you recently worked with.  

If the required virtual machine is not shown in the recently used list, you may find it browsing 
hard disk for its configuration file manually. 
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Browsing Hard Disk for a Configuration 

To select a virtual machine that is not represented in the recently used list, you should perform 
the following operations: 

1 Click the  icon on the Command Button panel at the bottom of the 
Parallel Workstation window or select Open in the File menu.  

2 Browse for a desired configuration file and click OK. After the configuration file is opened, 
its file name appears in the Parallels Workstation title bar, virtual machine name and full 
configuration file name with path are displayed on the property page (page 51). 

Opening Virtual Machine in a New Window 

You may open an additional instance of the Parallels Workstation using the menu. To do this: 

 Select the New Window command in the File menu. 

Since last used virtual machine is blocked by the Parallels Workstation instance where you issue 
this command, a new window is opened either with the Startup Options (page 104) dialog (if the 
Show startup dialog option is selected on in the Common tab of the Preferences window), or 
with a blank virtual machine. 
 

Startup Options Dialog 
Startup Options dialog is sometimes displayed upon Parallels Workstation startup in order to 
assist in easily opening a virtual machine or proceeding to creation of a new one. The first time 
you launch Parallels Workstation this dialog is opened automatically.  
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Opening Recently Used Virtual Machines 

To open one of the recently used virtual machines: 

1 Select the name of the machine in the Recently Used Virtual Machines list. The VM Path will 
show the respective configuration file. 

2 Click Open.  

The list of the recently used virtual machines is empty if you launch Parallels Workstation for 
the first time. 

Browsing Hard Disk for a Configuration 

To open an existing virtual machine that is not in the recently used list: 

 Click Browse button and locate the desired configuration file.  

Creating a New Virtual Machine 

To create new virtual machine: 

 Click the New VM button and follow the New Virtual Machine Wizard (page 59). 

Also, you may close this dialog by clicking the Cancel button; a blank virtual machine will be 
opened and you may start creating a new virtual machine manually. 

What to Open on Parallels Workstation Startup 

The Load recently used VM at startup and Show startup dialog options control what happens 
when Parallels Workstation is started. The same options are in the Common tab (page 90) of 
Preferences window and are described in the respective topic. Whenever you check/uncheck 
these options in one of these screens, they are automatically changed in the second one. 
 

Editing Virtual Machine 
Configuration 

Configuration of an existing virtual machine can be changed in the Configuration Editor. In this 
section we consider editing settings of devices already included in the configuration and general 
virtual machine settings. Adding and removing devices are discussed in the separate section, 
Adding New Devices to Virtual Machine (page 128).  

Changing Device Settings 

To change device settings: 

1 Open the Virtual Machine (on page 103) you wish to make changes to. 

2 Display the Configuration Editor by clicking  button on the Command 
Button panel, or select Edit Configuration in the File menu, or just click a device name in the 
Resource Name list. 
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3 Choose the hardware whose parameters you want to alter in the left part of the 
Configuration Editor window. (Options resource contains general virtual machines settings.) 
Tabs corresponding to the selected resource are displayed. 

Note: In Linux primary OS to be able to connect any virtual device to a real one, you should 
have system privileges to access real device. Otherwise the real device will not appear in the list 
of available devices despite it being installed on your computer.  
 

Saving Virtual Machine Configuration 

After you have changed devices settings and are satisfied with them, save the virtual machine 
configuration: 

1 Click OK on the Configuration Editor screen, then click the button on the 
Command Button panel or select Save in the File menu. The file will be saved in its current 
location and with the current name. 

2 To save the configuration in another location or with another name select Save As in the File 
menu. After you have saved the file, its new file name appears in the title bar, full new name 
with path appears on the property page (page 51). 

 

General Options 
Under Options general virtual machine settings are collected. 
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VM Identification: 

 Virtual machine name field shows the name of the machine that has been specified when 
creating and can be changed. Its name should be descriptive, and its length should be no 
more than 50 symbols. The name of the virtual machine is displayed on its property page 
(page 51). 

Guest OS Type: 

 Here you can specify an operating system to be installed on the virtual machine (if you 
didn't choose the right one while creating the machine or want to install another OS). Be 
careful to choose the right operating system. If settings on this tab do not correspond with 
the operating system actually installed this may cause problems varying from slow 
performance to machine failure. 

 

Booting Options 
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On the Booting Options tab you can select the order of devices from which the virtual machine 
will try to boot one-by-one. You can choose one of the three predefined sequences - [Floppy, 
Hard drive, CD-ROM], [Hard drive, Floppy, CD-ROM], [CD-ROM, Hard drive, Floppy]. During its 
startup, the virtual machine checks media in the first device of the boot sequence and tries to 
boot from it. If the media is not found or is not bootable, the virtual machine will proceed with 
the next device in the boot sequence, and so on.  

Note: Please make sure that a boot disk (Floppy disk, Hard Disk, CD-ROM) is available and 
configured correctly. If you select a boot disk that does not exist, after starting up the guest 
operating system and loading BIOS, you will see the error message “Currently opened 
virtual machine does not include any boot devices. In order to 
be successfully booted the virtual machine should have at least 
one of the following devices attached: floppy disk drive, hard 
disk drive, CD/DVD-ROM drive. Do you want to power on this 
virtual machine anyway?”. Click No, correct the configuration of your floppy or the 
corresponding IDE drive and try to start again. 
 

VM Flags 
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VM Flags tab contains various options that influence the performance of the virtual machine and 
startup configuration options. 

Emulation flags:

 Acceleration level. Acceleration enables a number of the guest OS specific performance 
optimization techniques. We recommend selecting the High level. If you notice incorrect 
guest operating system behaviour while running with high acceleration, for example when 
installing software, shut down the OS and lower acceleration level. Note that without 
acceleration at all (Disabled level) the virtual machine runs very slowly. We recommend 
turning acceleration on after finishing the process that caused problems. 

 Enable hardware virtualization support option is available for editing if you have on your 
host computer either an Intel processor with Virtualization Technology or an AMD 
processor with Security and Virtual Machine architecture. By default hardware acceleration 
is enabled. See Intel Virtualization Technology (VT-x) and AMD SVM Support (page 10) 
to learn about hardware virtualization support in Parallels Workstation.  
If you run a guest OS with VT-x support, it is indicated in the About Parallels Workstation 
screen (see the More Information (page 143) section). 

Process priorities: 

Note: Process priorities options are available in Windows primary OS only. 

 When running in foreground. This option specifies priority of the virtual machine process 
when running in the foreground mode, i.e. when the virtual machine window is active. 

 When running in background. This option specifies priority of the virtual machine process 
when running in the background mode, i.e. when the virtual machine window is inactive. 

Misc flags: 

 PC speaker support enabled. If this option is enabled the virtual machine can indicate its 
actions by PC speaker sounds. 

 Autostart VM when configuration is loaded. After you open the virtual machine configuration 
file, the VM will be automatically started. 

 Switch to fullscreen mode automatically. As soon as the virtual machine is started, it will run 
in the fullscreen mode. 

 Exit application on VM shutdown. If this option is enabled the Parallels Workstation window 
is closed automatically after the virtual machine is stopped using either guest OS shutdown 

command or Power Off  button, or it is suspended. By default this option is disabled. 
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Shared Folders 
Note. This tab is active in Windows 2000/XP/2003 guest OSes only. In other guest OSes you 
will see the message: "Feature is not available for this type of guest 
operating system". 

 

 Enable shared folder option allows/prohibits using shared folders in the virtual machine. 
 The list below displays all the shared folders created for this virtual machine. The Name 

column shows name of the folder in the guest OS, the Path column shows the same folder in 
the file system of your host computer. 

 Add button  opens the Shared Folder Properties dialog for creating a new shared folder. 
See the Using Shared Folders (page 133) section for detailed description of this process. 

 Delete button  removes the selected shared folder. 

 Edit button  opens the Shared Folder Properties dialog where you can make changes in 
the shared folder properties. See the description of this dialog in the Using Shared Folders 
(page 133) section. 
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Video (Screen Resolutions) 

 

 Enable custom screen resolutions option allows/prohibits using different screen resolutions 
for the virtual machine. 

 Screen Resolutions table displays all the custom resolutions defined for this virtual machine. 
The check mark near a resolution means that this resolution will be available for selection in 
the virtual machine. Those resolutions that are not checked will not be available for 
selection. To enable/disable a resolution, open its properties using the Edit button. 

 Add button  opens the Resolution Properties dialog for creating a new resolution. See the 
Using Custom Screen Resolutions (page 136) topic for detailed description of this process. 

 Delete button  removes the selected screen resolution. 

 Edit button  opens the Resolution Properties dialog where you can make changes in the 
screen resolution properties. See description of this dialog in the Using Custom Screen 
Resolutions (page 136) section. 
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Memory Options 

 

The Memory Size parameter describes the size of virtual memory (RAM) to be allocated for the 
virtual machine. You can choose any value from 4 to 1500 MB. We advise you not to exceed 
the recommended maximum because this is the limit of the physical RAM that your system 
should reserve for virtual machines. If this amount is not enough the redundant memory is 
swapped to disk, thus slowing down both guest OS and primary OS performance.  

The recommended memory maximum size is specified on this tab below the slider. This value 
can be adjusted on the Memory tab (on page 92) in the Preferences window. 

To set memory size for the current virtual machine use slider, spin buttons in the RAM field, or 
type a value directly into the field. Memory size should be set at a multiple of 4. If it not, when 
trying to save memory options you will receive an error message.  
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Floppy Options 
A virtual machine floppy drive can be connected to a real floppy drive as well as to floppy disk 
image. To get information on floppy disk images used by Parallels Workstation read Floppy 
Disk Images (page 102) topic.  

 

Device status: 

 To temporary disable floppy drive operations without deleting it from configuration, 
deselect Enabled check box. 

Note: If you start the virtual machine with the floppy drive disabled, you cannot change this 
option when virtual machine is running.  

If the floppy drive is enabled, it can be connected/disconnected while VM is running. Media 
that the floppy drive accesses can also be changed. 

 To start guest OS with the floppy disk inserted, select the Connect at startup check box. 

Emulation: 

 If you have the physical floppy drive(s) on your computer, then you can select Use real 
floppy radio button and the floppy device name will be shown in the Floppy Drives list. You 
can select one of them (for example, A:).  

Note: In Linux primary OS to be able to connect virtual machine floppy drive to a real 
floppy drive, you should have system privileges to access real device. Otherwise real floppy 
will not appear in the list of available devices despite it is installed on your computer.  
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 To use a floppy disk image (the .fdd file), select Use image file radio button. A new field, 
Image File, appears. Specify the path to a disk image file or click Browse button and locate 
the file.  

 Parallels Workstation allows to create blank floppy image. Type the file name in the Image 
File field and click Recreate button. The size of a floppy disk image equals 1.44 MB. The 
default extension for a floppy disk is .fdd and the corresponding file is created in the 
directory specified in the Image File field. 

 

Hard Disk Options 
The current version of Parallels Workstation allows virtual machines to only use hard disk 
images in .hdd format. Read Hard Disk Images (page 100) topic to get acquainted with disk 
format and other its options. 

Up to four IDE devices (hard disks and CD/DVD-ROM drives) can be connected to a virtual 
machine currently. This means, that there can be no more than four hard drives plus CD/DVD-
ROM drives, i.e., it doesn't matter how many of IDE devices will be hard drives and how many 
will be CD/DVD-ROMs. 
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Device status: 

 To temporarily disable operations with this hard drive without deleting it from 
configuration, deselect Enabled check box. 

Emulation: 

 If you want to change the hard drive connected to your virtual machine, you may choose 
another .hdd file in the Image File field.  

 Recreate button deletes an old hard disk and creates a new one. Use this opportunity if you 
want to create a disk from scratch. If you want to replace the current hard disk with a new 
one do the following: 

1 Click the Recreate button. 

2 Create HDD window appears. You can specify Disk size and whether the disk should be 
expanding (page 100) or plain (page 100). Select Expanding disk check box if you want the 
hard disk to be expanding.  

 
3 Click Create. 

4 You are asked to confirm that you are going to create a new disk instead of the old one. 
Click Yes. A new empty disk is now connected to your virtual machine. 

Note: If while using a hard disk you discover that its size is insufficient, you may increase disk 
capacity using the Parallels Image Tool (page 174). 
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Advanced 

 

Device Geometry: 

 Fields Cylinders, Heads, and Sectors in this group show geometry of a virtual HDD. Note 
that the geometry concerns virtual disk, not a real one where virtual disk is stored. 

 Disk format label indicates virtual hard disk format. See the Format of The Virtual Disk 
(page 101) in Hard Disk Images topic.  

Attachment Options: 

 Choose IDE channel to connect to the HDD image in the Connect to field. If you want the 
HDD to be startup one select IDE 0:0.  

Note that if you set two startup drives at once - hard disk (IDE 0:0) and CD/DVD-ROM 
(IDE 0:1) - the guest OS will try to boot according to the sequence set on the Booting 
Options (page 107) tab under the General Options. 

Optimization: 

 If the selected disk is an expanding-type disk, the Compact button starts the process of 
compacting of the disk. See the Compacting Virtual Disk (page 169) topic for information 
on this feature. The Compact button is disabled for plain virtual disks. 
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CD-ROM options 
A virtual machine CD/DVD-ROM drive can be connected to a real CD/DVD-ROM drive of 
your computer as well as to CD/DVD .iso image. To get information on using CD/DVD 
images in Parallels Workstation look in CD/DVD Real Discs and Images (page 102) topic.  

Up to four IDE devices (hard disks and CD/DVD-ROM drives) can be connected to a Virtual 
Machine currently. This means, that there can be no more than four hard drives plus CD/DVD-
ROM drives, i.e., it doesn't matter how many of IDE devices are hard drives and how many are 
CD/DVD-ROMs. 

 

Device Status: 

 If you wish to temporary disable a CD/DVD-ROM drive without deleting it from 
configuration, deselect the Enabled check box.  

Note: If you start the operating system with the CD/DVD-ROM drive disabled, you cannot 
change this option when virtual machine is running.  

If the CD-DVD-ROM drive is enabled, it can be connected/disconnected while VM is 
running. Media that CD/DVD-ROM drive can access may also be changed. 
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 If the CD/DVD-ROM drive is enabled, you can select the Connect at startup check box to 
start the guest OS with the CD/DVD disc inserted. 

Emulation: 

 If you have a physical CD/DVD-ROM on your computer, you can use it in the virtual 
machine. In this case, select the Use real CD/DVD-ROM check box, the name of the physical 
CD/DVD-ROM (for example, D:) will be shown in the CD/DVD-ROM drives drop-down 
menu and available for selection. 

Note: In Linux primary OS to be able to connect the virtual machine CD/DVD-ROM drive 
to a real CD/DVD-ROM drive, you should have system privileges to access the real device. 
Otherwise the real CD/DVD-ROM drive will not appear in the list of available devices even 
though it is installed on your computer.  

 If you want to use a CD/DVD image (e.g., the .iso file), select the Use image file flag. As 
you select it, another field where you can enter the CD/DVD image file name appears 
below. Specify the path to your CD/DVD image file or click the Browse button and locate 
the CD/DVD image file.  

Attachment Options: 

 Choose the IDE channel to connect to CD/DVD-ROM image in the Connect to list. If you 
want the CD/DVD-ROM to be the startup drive select IDE 0:1 in the list. 

Note that if you set two startup drives at once - hard disk (IDE 0:0) and CD/DVD-ROM 
(IDE 0:1) - the guest OS will try to boot according to the sequence set on the Booting 
Options (page 107) tab of the General Options. 
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Network Adapter Options 
In the current version of Parallels Workstation a RTL8029 (NE2000 compatible PCI card) 
network adapter is supported. 

In a Linux guest OS, to be able to access an external network in the virtual machine, a ne2k-pci 
driver should be loaded into the Linux kernel. It is included by default, however if you are going 
to recompile the kernel remember to select the ne2k-pci component. In a FreeBSD guest OS you 
need to have the if_ed.ko module loaded. 
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Device Status:  

 If you wish to temporarily disable network support in the Virtual Machine without deleting 
the network adapter from configuration, deselect the Enabled check box. When the Enabled 
check box is selected, the options and fields for configuring the network become active. 

 If network adapter is enabled, you can select Connect at startup check box to start the guest 
OS with network adapter connected. 

Emulation: 

In the Emulation group, you can select the type of network adapter to be used in your guest OS. 
You can choose between the Bridged Ethernet and Host-only networking.  

 Bridged Ethernet networking is intended to access local network and Internet using physical 
Ethernet adapter of your computer. A virtual machine is treated as a separate computer and 
should be configured the same way as a real one.  
If you select the Bridged Ethernet radio button, the Network Adapters drop-down list will 
show a list of all physical network adapters available on your computer. Choose one of them 
to connect to your virtual adapter.  

The list of available adapters contains the Default adapter which always maps to Ethernet 
adapter that handles the default route in your system. When routing table in your system 
changes, default adapter mapping will change automatically. This is useful when you use a 
wired connection and changed it to wireless one. With Default adapter selected you don't 
need to stop the virtual machine and select the currently active adapter. 

 



 Managing Virtual Machines 121 
 

 Select Host-only networking if you want to emulate a network inside your computer, you 
don't want to access a network outside your local computer, or you don't have physical 
network interface card. When you set this option, the primary OS and other Parallels 
Workstation virtual machines inside it are visible, thus making possible to imitate a network 
that includes the primary OS and a number of virtual machines. The Creating Host-Only 
Network (page 132) topic discusses how to configure a host-only network. 

Advanced 

 

 This tab allows you to specify a network driver to be used in your guest OS. In the current 
version of the Parallels Workstation a RTL8029 driver for the Ethernet adapter is supported. 
It is already selected in the Type field.  
You can find native Realtek RTL8029 drivers for many different guest OSes in the Parallels 
Tools (page 76) pack shipped together with the Parallels Workstation. 

In Windows 2000/XP/2003 guest operating systems you can improve network performance 
by installing a specially developed PRLETH driver that can be found in the Parallels Tools 
(page 76) pack. 

 A MAC address is generated automatically but can be changed manually. If you decide to 
change it, please make sure that the number is unique inside your network. 
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Serial Port Options 
Parallels Workstation allows up to four serial ports to be connected to a virtual machine. 

Serial Port Options in Windows primary OS: 

 

Device status: 

 If you wish to temporarily disable operations with a serial port without deleting it from 
configuration, deselect the Enabled check box.  

Note: If you start the operating system with the serial port disabled, it can not be 
connected/disconnected while the VM is running. 
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 If you have enabled the port, you can select the Connect at startup check box to start the 
guest OS with this port connected.  

Emulation: 

Parallels Workstation suggests three methods of serial port emulation:  

 connect it to a physical device (Use port option), 
 use an output file (Use output file option), 
 the third option is different in the Windows and Linux versions of Parallels Workstation. In 

the Windows primary OS it will be a named pipe (Use pipe option). In the Linux version 
socket technology instead of pipe is used (Use socket option).  

These methods are described below: 

1 If you have selected Use port, the drop-down list COM - Port displays the list of available 
real COM ports. Select one of them to connect to the virtual port. 

Note: In Linux primary OS to be able to connect virtual machine serial port to a real serial 
port, you should have system privileges to access the real device. Otherwise the real serial 
port will not appear in the list of available devices despite it is installed on your computer.  

2 If you have selected Use output file, you can attach the existing file using the Browse button 
or create a new one. The new file is created in the virtual machine folder. 

3 Windows primary OS. If you have selected Use pipe, the Pipe name field appears 
containing a default pipe name. Use it or type a new name that should subject to the 
following rules.The name should begin with \\.\pipe\, i.e. it should be in the form 
\\.\pipe\<name>. If a name doesn't conform to this rule, you will get the error 
message: "Serial <number>: unable to connect. Cannot open '<pipe 
name>'" when the virtual machine is started. 

In the second field select a role at this end of the pipe. 

Linux primary OS. If you have selected Use socket, the Socket Name field appears 
containing a default socket name. Use it or type a new name that should subject to the 
following rules. The name should begin with /tmp/, i.e. it should be in the form 
/tmp/<socket>. If a name doesn't subject to the rule, then after virtual machine is 
started you will get the error message: "Com Port <number>: Unable to open 
<port name> device". 

In the second field select a role at this end of the socket. 
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Parallel Port Options 
Parallels Workstation allows up to three parallel ports to be connected to a virtual machine. 

 

Device status: 

 If you wish to temporarily disable operations with a parallel port without deleting it from 
configuration, deselect the Enabled check box. If the parallel port is enabled, it can be 
connected/disconnected while the VM is running. 

Note: If you start the operating system with the parallel port disabled, you cannot change 
this option when the virtual machine is running.  

 If you have enabled a port, you can select the Connect at startup check box to start the guest 
OS with this port connected.  

Emulation: 

Parallels Workstation suggests three methods of emulating parallel port in Windows primary OS 
and two methods in Linux one:  

 attaching to a physical LPT port - Use port. 
If you select this option, the drop-down LPT - Port list displays real LPT ports available on 
your computer. Select one of them to connect to the virtual port.  
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Notes. 1. In Linux primary OS to be able to connect virtual machine parallel port to a real 
parallel port, you should have system privileges to access the real device. Otherwise the real 
parallel port will not appear in the list of available devices despite it is installed on your 
computer.  

2. Running a virtual machine with its parallel port connected to a real LPT port blocks the 
access to this real LPT port. If a physical printer cable is attached to this LPT port, other 
virtual machines and the primary OS will not be able to print via this printer. For more 
information on this issue see Problem with Printing (page 211). 

 attaching to a printer - Use printer. This method is available in Windows primary OS only. 
If you select Use printer and have a physical printer connected to your computer, Printers list 
displays all the printers available within your Windows primary OS. Select one of them to 
connect to the parallel port.  

When using this way of printing, Parallels Workstation composes a printer job and transfers 
it to the primary OS which guides further process. 

 attaching to an output file - Use output file.  
If you select this option, you can attach to parallel port an existing file or create a new one. 
Click the Browse button and locate the file.  

 

Sound Options 
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Parallels Workstation virtualizes the Realtek AC'97 compatible sound card. 

Device status: 

 Enable option allows/prohibits using the sound device in the virtual machine. If the sound 
device is enabled, it can be connected/disconnected while the VM is running. However if 
you wish to temporarily disable operations with a sound device without deleting it from 
configuration, deselect the Enabled check box.  

Note: If you start the operating system with the sound device disabled, you cannot change 
this option when the virtual machine is running.  

 To start the guest OS with the sound device activated, select the Activate sound at startup 
check box. 

Emulation: 

Note.  If you are not satisfied with the quality of sound issued, a special AC'97 sound driver 
(page 77) is available for Windows 95/98/ME/NT/2000 guest OSes and for OS/2 and 
eComStation guest OSes. You can install it instead of standard one. 

Windows primary OS: 

 Specify playback sound device field contains a list of available devices for sound 
reproducing. You may select a specific device or use a Default sound playback 
device. If you don't want to produce sound but the sound card is required by the guest 
OS'es applications, you can select the Loopback sound device. 

 Specify recording sound device contains a list of available devices for sound recording. You 
may select a specific device or use a Default sound recording device. If you 
don't want to record the sound but need to emulate this process, you can select the 
Loopback sound device. 

Linux primary OS: 

 Output Device field contains a list of sound adapters and virtual sound devices available on 
your real computer. If you don't want to produce sound but the sound card is required by 
guest OS'es applications, you can select loopback.  

Note: In Linux primary OS to be able to connect virtual machine sound drive to a real sound 
drive, you should have system privileges to access the real device. Otherwise the real sound 
device will not appear in the list of available devices despite it is installed on your computer.  

 Mixer Device field contains list of available mixer adapters. If you don't want to use a mixer 
device but it is required by guest OS'es applications, you can select loopback.  
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USB Options 

 

Device status: 

 Enable option allows/prohibits using USB devices in the virtual machine. If the USB is 
enabled, USB devices can be connected/disconnected to the virtual machine while it is 
running. However if you wish to temporarily disable USB operations without deleting it 
from configuration, deselect the Enabled check box.  

Note: If you start the operating system with the USB disabled, you cannot change this 
option when the virtual machine is running.  

Connection Options: 

 Autoconnect USB devices. Select this option if you want the running virtual machine to 
capture new USB devices connected to your host computer. New device are captured if 
there is no more than one USB device currently active. 
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Adding New Devices to Virtual 
Machine 

Virtual machine technology allows adding new devices to a virtual machine to be like 
connecting new devices to a real computer. Virtual machine configuration can include the 
following devices: 

 up to four IDE devices - virtual hard disks and CD/DVD-ROM drives; 
 a floppy drive; 
 a network adapter; 
 up to four serial ports; 
 up to three parallel ports; 
 a sound device; 
 a USB controller. 

New devices are added using Add Hardware Wizard. Device of any type (except hard disks) can 
be connected to a real drive as well as to virtual media. In addition, if you add a floppy drive, a 
new blank .fdd image can be created at the same time and connected to the drive. When 
adding virtual hard disk you may choose between connecting an existing hard disk image and 
creating a new one. 

Note: In Linux primary OS to be able to connect any virtual device to a real one, you should 
have system privileges to access the real device. Otherwise, the real device will not appear in 
the list of available devices despite it is installed on your computer.  

To add a new device to the virtual machine do the following: 

1 Open the virtual machine to which you want to add new device, then select Edit 

Configuration in the File menu or click on the command button panel to 
open Configuration Editor. 

2 In the lower left part of the Configuration Editor window click the Add button. 
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3 The Add Hardware Wizard greets you with the Welcome to Add Hardware Wizard screen. 
Click Next. 

 
4 On the Select hardware screen you should choose the device you want to add to your 

machine. 

The Available Hardware list contains devices available for adding. If the VM configuration 
already includes the maximum allowed number of a particular device type, this device type 
will not appear in the Available Hardware list. For instance, only one floppy drive is allowed. 
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The wizard allows you to add only one device at a time.  

 
On this screen you may prefer to add devices immediately without specifying its options, in 
order to save time (You may set options later in the Configuration Editor). To do so, click 
the Add device instantly button after selecting the desired device. The new device is added 
immediately with standard options, and some of them are not set at all (for example, the 
instant hard disk has a size of zero).  

To set the options of the device being added click the Next button. 

Follow the wizard screens to configure the new device. You should select the device type, the 
media it is connected to, and the options specific to the device and media type. All of them are 
described under the Editing Virtual Machine Configuration (on page 105) section. The last 
options screen contains the Finish button.  

Note that not all operating systems are able to recognize a newly added device, use the guest 
operating system means to make a new device visible to the guest OS.  
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Removing Devices 
Most virtual machine devices can be removed from the configuration. Memory and those 
elements of the virtual machine configuration that are not devices but rather collections of 
settings can not be removed. These elements are: Options, Shared Folders, and Video.  

Note. Any device, except memory, can be disabled in the Configuration Editor (on page 105) 
without removing it from configuration. Uncheck the Enabled check box of the desired device.  

To remove a device: 

1 Open the virtual machine from which you want to remove a device, then open the 
Configuration Editor by selecting File->Edit Configuration in the menu or click 

 on the command button panel.  

2 Select the device you want to delete in the left part of the Configuration Editor window. Note 
that options, shared folders, video, and memory list entries can not be deleted.  

3 Click the Remove button. 
 

Networking in Virtual Machine 
Parallels Workstation allows two types of networking in virtual machine, Bridged Ethernet and 
Host-only networking. This section describes these types of networking and ways of 
configuring them. 
 

Bridged Ethernet Networking 
Bridged Ethernet networking allows virtual machines to access a physical network, such as 
Local Area Network and/or Internet. You should have an Ethernet adapter installed on your host 
computer. This Ethernet adapter should support promiscuous mode, as described in Hardware 
Requirements (page 14).

To access LAN and Internet, configure the virtual machine: 

 in virtual machine Network adapter options (on page 119) select Bridged Ethernet type of 
networking in the Emulation group and choose the proper network adapter in the list, 

 configure network options in the guest operating system.  
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Creating Host-Only Network 
Parallels Workstation provides virtual network accessible only to the primary operating system 
and virtual machines running on it. The primary operating system is attached to this network 
through the Parallels Host-Guest Virtual NIC adapter installed along with Parallels Workstation. 
For a virtual machine to join such a host-only network, the guest network adapter should be set 
to host-only networking. IP addresses for the primary operating system and virtual machines 
may be: 

 dynamic (assigned by Parallels DHCP server running on host-only network); 
 static (assigned manually). 

Configuring Network with Dynamic IPs 

IP addresses for machines in a host-only network are provided by Parallels DHCP server that is 
started automatically whenever you launch Parallels Workstation. DHCP server is installed 
along with Parallels Workstation. 

Configure network with dynamic IPs in the following way: 

1 Open Configuration Editor for the virtual machine and on the Network Adapter Options (on 
page 119) tab select the Host-only networking parameter. 

2 Select Edit->Preferences in the Parallels Workstation menu. Specify a range of IP addresses 
to be assigned to the virtual machines on the Network (page 93) tab.  

Configuring Network with Static IPs 

To configure host-only network with static IP addresses you have to manually assign them to 
the primary operating system and to each virtual machine in which you want to include on the 
network.  

The virtual machine should be configured as follows: 

1 Open the Configuration Editor for the virtual machine and on the Network Adapter Options 
(on page 119) tab select the Host-only networking parameter.  

2 Start the virtual machine and specify the IP address by standard means for the guest 
operating system installed on it.  

Configuring a static IP address for the primary operating system: 

In Windows primary OS: 

1 Open Windows Control Panel, select Network Connections. 

2 In the Network Connections window right click on the Parallels Workstation network 
adapter, Parallels Host-Guest Virtual NIC, to display its context menu and select Properties in 
it. 

3 The Parallels Host-Guest Virtual NIC Properties windows is displayed, in This connection 
uses the following item list select Internet Protocol (TCP/IP) and click Properties button. 

4 In the Internet Protocol TCP/IP Properties window select Use the following IP address option, 
after that other options in this group become accessible. Specify IP address and Subnet mask 
for the primary system. 
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In Linux primary OS: 

1 Open /usr/lib/Parallels/.dhcpd_configuration file. 

2 Settings under "[vnic0]" determine Parallels network adapter parameters. Find the string 
"DHCP=1". This setting means that address for the primary operating system is assigned 
automatically. To allow static IP change DHCP setting to 0 instead of 1. Set "DHCP=0" and 
save the file. 

3 Launch the Terminal program and run two following commands: 
/etc/init.d/parallels stop 

and after this 
/etc/init.d/parallels start 

4 Specify an IP address for the primary system by means of the Linux version installed on 
your computer. 

 

Using Shared Folders 
Shared folders are folders in your host computer that are visible to the guest OS also. These 
folders are used for exchanging files between the primary OS and a virtual machine or between 
several virtual machines.  

In the primary OS shared folders appear as usual folders, while in guest OS they are objects of 
the network neighborhood. 

Using shared folders is possible for the following guest OSes:  

 Window 2000/XP/2003. 
 

Setting Up a Shared Folder 
Setting Up a shared folder requires two steps: 

1 Adding a shared folder(s) in your virtual machine configuration.  

2 Installing Parallels Tools in your guest OS. 

See below for detailed instructions. 

Adding a Shared Folder 

1 Open the virtual machine configuration, click the  button to open the 
Configuration Editor. 

2 In the Configuration Editor, select the Shared Folders tab (see the Shared Folders (page 110) 
topic). Select the Enable shared folders option. 

3 In the Shared Folders tab, click the  button to open the Shared Folder Properties screen. 

4 In the Shared Folder Properties screen: 

specify a name for the folder which will appear in your guest OS in the Name field; 
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specify a folder in your host computer that will be shared in the Path field; 

if you want to restrict writing to this folder from inside the guest OS, select the Read Only 
check box. You will be able to save files to this folder in the primary OS only; 

make sure the Enabled check box is selected; 

and click OK. 

 
5 Click OK in the Configuration Editor. 

6 Click  to save the virtual machine configuration. 

If you have not installed the Parallels Tools in a virtual machine, proceed to the Installing 
Parallels Tools in the Guest OS subtopic. If you have them installed: 

 power on your virtual machine and view shared folders in your guest OS. 

Installing Parallels Tools in Guest OS 

Parallels Tools includes the Shared Folders tool which is necessary for a guest OS to view the 
shared folders. See a full description of this tool in the Parallels Tools Overview (page 77). 

Installation of Parallels Tools is performed just after you have created a new virtual machine 
and installed a guest OS in it. See Installing Parallels Tools (page 76) for detailed descriptions 
on how to do so in a particular guest OS. We recommend that you perform the typical 
installation, but if you perform a custom installation make sure the Shared Folders tool is 
selected. 

 

 
 

 



 Managing Virtual Machines 135 
 

Viewing Shared Folder in Guest OS 
There are two ways to view the contents of the shared folders in the guest OS.  

Easy Way 

Shared Folders Options (page 168) tab in Parallels Tools Center contains the Place shortcut on 
the desktop option. If it is selected viewing contents of shared folders is simple: 

 Click the Parallels Shared Folders icon on the desktop of a running virtual machine. 

General Way 
1 In the virtual machine, open Windows Explorer. 
2 In Explorer, select My Networks Places, then select Entire Network, and find the Parallels 

Shared Folders. 

3 Click the Parallels Shared Folders to view the list of shared folders available in your virtual 
machine. 

Note. When working with a shared folder inside a virtual machine, keep in mind that the ability 
to save files into this folder depends on its Read Only setting. 
 

Using USB Devices in Virtual 
Machine 

The current version of Parallels Workstation emulates the 2-port USB 1.1 controller. This 
means that up to two USB peripherals can be connected to a virtual machine simultaneously.  

Parallels Workstation lets you connect USB devices to virtual machine automatically. See the 
USB Options (page 127) section to learn how to turn this option on. And see the Connecting 
USB Devices (page 160) section to learn how to connect a USB device to a virtual machine 
both automatically and manually.  
 

Custom Screen Resolutions 
Same as real computer, virtual machine allows to change resolution of its monitor. But with 
virtual machine you have one more degree of freedom - non-standard screen resolutions. Use 
them if you want the virtual machine to occupy some specific part of your monitor. 

Defining custom resolutions is different in different guest OSes. 
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In Windows Guest OSes 
Parallels Workstation allows you to define up to 10 different resolutions for a Windows virtual 
machine and change them when running the guest OS. Note that these resolutions should be no 
less than 800x600.  

Adding a Screen Resolution 
1 Open the virtual machine configuration you want to add a resolution to, click the 

 button to open the Configuration Editor. 
2 In the Configuration Editor, select Video in the Resource list.   

3 In the Screen Resolutions tab (see Video (Screen Resolutions) (page 111) ), make sure the 
Enable custom screen resolutions option is selected. 

4 Click the Add button  to open the Resolution Properties dialog. 

5 In the Resolution Properties dialog:  

set the desired resolution options in the Width, pixels and Height, pixels fields. Note that 
width value should be divisible by 8; 

select the Enabled check box if you want this resolution to be available for selection in the 
guest OS; 

click OK. 

 
6 Click OK in the Configuration Editor. 

7 Click  to save the virtual machine configuration. 

Changing Screen Resolution for a Virtual Machine 

To change screen resolution: 

 Power on your virtual machine. 
 Right-click on the Windows desktop and select Properties->Settings in the context menu. 

On the Settings tab, will propose for selection all the resolutions available in the Video 
(Screen Resolutions (page 111)) tab for which the Enabled option is selected. Select the one 
you want.  
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In Linux Guest OSes 
To run a Linux virtual machine with a non-standard resolution do the following: 

1 Make sure gtf is installed in your guest system.  

2 In the Terminal, generate xorg.conf modeline by executing  
gtf <width> <height> <refresh> 

Note. Refresh need not to be more than 60. 

3 Paste output of gtf to "Monitor" section of xorg.conf. 

4 Insert mode name in the beginning of the modes list which is located in the subsection 
"Display" of section "Screen" and begins with the "Modes" keyword. 

Note. Make sure, that "Depth" property of the subsection "Display" equals to 
"DefaultDepth" value defined in section "Screen". 

5 Restart X Server.  
 

Making Copy of a Virtual Machine 
A complete copy of a virtual machine can be created using the Clone Virtual Machine Wizard. A 
new configuration file and new hard disk drive(s) are made. The clone includes as many hard 
drives as there are connected to an original machine. By default the Wizard puts new files into a 
new directory, but you may prefer to store them in an existing one. Copies of virtual hard disks 
are always placed in the same folder with the copy of the configuration file. 

Auxiliary devices of the new virtual machine are connected to the same drives or disk images as 
the source devices. If source CD/DVD-ROM drive is connected to an .iso CD/DVD disc 
image file, this connection is restored in the new machine. The same goes for the floppy drive. 
However output files of serial/parallel ports, if used, are not transferred from the original VM. 
In the clone, they are started from scratch.  

If a network adapter is included in the original configuration, a new MAC address is generated 
for the new adapter.  

A virtual machine to be copied should be opened and meet the following conditions: 

 The guest OS is not running. If it is running, the menu item that starts the wizard is disabled. 
 The virtual machine is not opened by another instance of Parallels Workstation. 
 It is not a blank virtual machine. Blank virtual machines can not be copied. 

To make a clone of a virtual machine: 

1 Open the virtual machine you want to make copy of. 
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2 Select Clone VM in the VM menu. The Clone VM Wizard starts. Click Next. 

 
3 In the next step, Specify new virtual machine name and location, you have to specify a name 

for the clone and a path for storing its configuration file. The name and path suggested by 
the wizard are made by adding "Clone of" at the beginning of the original virtual machine 
name and path. You can modify both of them. Remember that a virtual machine name  
should be no longer than 50 characters. 
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If you select the Open virtual machine in new window automatically option, after the new 
configuration is created it will be opened in a new Parallels Workstation window. Click 
Finish to start copying the machine. 

 
If the directory for storing the virtual machine configuration file does not exist, the 
confirmation for its creation may be asked: "Directory <directory name> does 
not exist. Do you want to be created automatically?" Click Yes. A 
new directory will be created. 
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4 While the virtual machine is being copied, the Copying in progress screen indicates the 
current state of the process. If everything is OK, the Wizard informs you that copying has 
been performed and a new machine is ready. Click Exit to close the Wizard. 

 
A new instance of Parallels Workstation is opened with the new virtual machine loaded, if 
you have selected the corresponding option on the Specify new virtual machine name and 
location screen. 
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Keyboard Shortcuts in Virtual 
Machine 

Both Windows and Linux primary OSes have special hotkeys which they intercept even when 
the hotkeys are pressed inside guest OSes. Techniques of bypassing this problem are stated 
below. 

Windows Primary OS 

If your computer is running Windows primary OS, it will intercept Ctrl+Alt+Del key 
combination pressed in guest OS. To send Ctrl+Alt+Del to guest OS: 

 either press Ctrl+Alt+Ins while the keyboard is captured inside a virtual machine 
window, 

 or select Send Ctrl+Alt+Del in the Parallels Workstation VM menu. 

Using Standard Hotkeys in Linux Guest OS When Primary OS is Also Linux 

When both primary and guest operating systems are Linux-based the problem arises how to 
send standard hotkey combinations to the guest Linux OS since primary Linux OS intercepts 
them. To bypass this trouble 

 whenever Alt key is used in standard combination press Shift instead. 

To send to the guest Linux OS, for example, Ctrl+Alt+Backspace press 
Ctrl+Shift+Backspace. Primary Linux OS will not intercept this combination while 
guest Linux OS will interpret it as Ctrl+Alt+Backspace.  

The table below shows what combinations you should press instead of standard ones.  

Desired Hotkey Combination to Press 

Ctrl+Alt+Backspace Ctrl+Shift+Backspace 

combination from range Ctrl+Alt+F1 -
Ctrl+Alt+F12 

Ctrl+Shift+F1 - Ctrl+Shift+F12 

Ctrl+Alt+plus sign or 
Ctrl+Alt+minus sign 

Ctrl+Shift+plus sign or 
Ctrl+Shift+minus sign 
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About Parallels Workstation Screen 
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The upper part of the About Parallels Workstation screen provides information on the number of 
the build you are using, the full name of the vendor and link to its site, and copyright and 
trademark information as well. 

Licensing Information 

 indicates your type of activation and to whom this copy is licensed. 

Support Information  

 contains the contact information of the Parallels technical support group. 

Buy Online and/or Evaluate buttons 

 are provided if you have a trial activation or did not activate your copy at all. If you have 
activated the program with a permanent activation key, none of these buttons will be 
displayed. See Activating Parallels Workstation in Windows (page 26) or Activating 
Parallels Workstation in Linux (page 31) for a detailed description of the processes of 
receiving a key and activating. 

More Info button  

 opens the screen with details of your license and set of indicators. 
 

More Information 
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License Status: 

 User Name and Company Name contain information about your name and the name of your 
company that you entered in the Activate Product window. 

 Product ID displays the identification number of your copy of Parallels Workstation as well 
as the following information: the version of the Parallels Workstation, license number, and 
the abilities covered by your license that are displayed in the Primary OSes and Terminal 
Services fields. 

 Validity period shows the date until your license is valid. 
 Primary OSes indicates which primary operating systems are allowed by your license. 
 Terminal Services displays which primary operating systems are able to access Parallels 

Workstation remotely. 

Note: The same license information is displayed in the Activate Product window. See 
Activating Parallels Workstation in Windows (page 26) or Activating Parallels Workstation 
in Linux (page 31). 

Virtual Machine Features: 

This group contains indicators that are active only when the guest OS is running. Otherwise 
they are off. 

 Virtualization mode shows your acceleration mode. 
If you are running virtual machine with hardware acceleration, this line indicates either 
Intel VT-x or AMD SVM. It shows Intel VT-x if you work on an Intel VT-enabled 
processor and hardware virtualization support is activated on the VM Flags (page 108) tab 
of the General Options. This line shows AMD SVM if you work on an AMD SVM-enabled 
processor and hardware virtualization support is activated on the VM Flags (page 108) tab 
of the General Options. See Intel Virtualization Technology (VT-x) and AMD SVM Support 
(page 10) for a description of both types of hardware virtualization. 

If you are running without hardware acceleration, the virtualization mode line indicates the 
acceleration level. All guest OSes, besides Windows NT/2000/XP/2003, run in Software 
mode 0. Windows NT/2000/XP/2003 starts with Software mode 0, then switch to 
Software mode 1 and Software mode 2 in case the Acceleration Level setting (on 
the VM Flags (page 108) tab of the General Options) is set to High.  

 Remote session indicates if Parallels Workstation is executed on a remote server. 
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Deleting a Virtual Machine 
Virtual machines can be deleted manually, however we recommend doing it using the Delete VM 
Wizard that detects all the files that make up the virtual machine and are connected to it. 

The Wizard helps remove the following virtual machine components and associated files: 

 configuration file, 
 virtual hard disk drives connected to the virtual machine, 
 CD/DVD disc .iso images connected to the virtual machine (if any), 
 floppy disk image (.fdd  or other) connected to the virtual machine (if any), 
 output files of serial and parallel ports (if any), 
 home directory where virtual machine files are stored. 

The Wizard can delete a currently opened virtual machine that meets the following conditions: 

 Its guest OS is not running. If it is running, the menu item that starts the wizard is disabled. 
 The virtual machine is not opened by another instance of Parallels Workstation. 
 The virtual machine is not blank. 

To delete a virtual machine: 

1 Open the desired virtual machine. 

2 Select Delete VM in VM menu. The Welcome to the Delete Virtual Machine Wizard screen is 
opened. Click Next. 
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3 The Wizard detects all files related to the virtual machine and presents them on the Review 
files to be deleted screen. Each device/file is displayed in a separate string, i.e. if two hard 
disks are connected to the virtual machine, there will be two hard disk strings on the screen. 
The full path is displayed for each component.  

The configuration file, virtual hard disk, output files of serial and parallel ports, and the 
home directory are pre-selected for deleting while connected CD-ROM .iso images and 
floppy .fdd (or other) images are not, because they can be useful for other virtual 
machines. If you do not consider them to be useful, mark them for deletion on this screen. 
Note that virtual hard disks can also be attached to other virtual machines. 

 
Review selected files, check those that should be deleted and click Finish when you are 
ready. 
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4 The virtual machine wizard removes the selected files from your hard disk. If everything is 
OK the final wizard screen will appear: 

 
The virtual machine is considered to be successfully deleted if all the selected components 
or all selected components except the home directory (if it was chosen for deleting) have 
been removed. If the home directory contains any files it will not be deleted.  

Click Exit to close the wizard. 

After the virtual machine is deleted, a blank VM is opened in the Parallels Workstation screen. 
The deleted machine disappears from the list of recently used configurations in the File menu. 
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C H A P T E R  8  

Running Virtual Machine 

This chapter provides information on handling a virtual machine while the guest operating 
system is executed. 

In This Chapter 
Overview............................................................................................................................... 148 
Starting Virtual Machine....................................................................................................... 149 
Capturing and Releasing the Keyboard and the Mouse ........................................................ 151 
Switching Virtual Machine to Fullscreen Mode ................................................................... 152 
Shutting Down and Resetting Virtual Machine .................................................................... 153 
Pausing Virtual Machine....................................................................................................... 154 
Suspending/Resuming Virtual Machine ............................................................................... 154 
Working with Devices When Running Virtual Machine ...................................................... 155 
Parallels Tools Center ........................................................................................................... 161 
Compacting Virtual Disk ...................................................................................................... 169 
Setting up a Printer in a Virtual Machine.............................................................................. 170 
 
 

Overview 
When you start a virtual machine, its console is opened and acts as the display of a real 
computer (refer to Console View (on page 53)). Your next step is to capture your keyboard and 
mouse in the Virtual Machine screen; after doing so you are able to work with the Virtual 
Machine in the same way you would with a standalone computer. 

Parallels Workstation controls such as the toolbar and the menu allows to manage virtual 
machine behavior when running the machine in windowed mode. You may also run the Virtual 
Machine in fullscreen mode, where Parallels Workstation controls and the primary operating 
system are not visible.  

While working in windowed mode, Parallels Workstation controls let you to do the following: 

 start, turn off and reset the virtual machine, 
 switch between virtual machine and your host computer, 
 pause and suspend virtual machine, 
 connect and disconnect devices, change data type accessed by them, 
 temporarily disable separate Parallels Tools (if you have them installed), 
 expand virtual machine console to fullscreen mode. 

The Configuration Editor is inaccessible while the virtual machine is running. 
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Starting Virtual Machine 
To start a virtual machine: 

1 Start Parallels Workstation. See Starting Parallels Workstation in Windows (on page 26) or 
Starting Parallels Workstation in Linux (page 31). 

2 Open a virtual machine configuration (on page 103). 

3 Do on of the following: 

 Click the Power On   button on the Parallels Workstation toolbar. 
 Select Power On in the VM menu.  

The virtual machine will be switched on, its console will be opened in the Parallels Workstation 
window, and you can see the boot process of the guest OS. 

Note that the virtual machine can be powered on only if you have a registered copy of the 
Parallels Workstation, regardless of whether it is of permanent or trial status. If your copy is not 
registered, the "This copy of Parallels Workstation is currently not 
active" warning appears. This warning displays your current activation status and prompts 
you to activate your copy of the product. 

In Windows primary OS:  

Depending on whether you had previously received a trial activation key or not, Evaluate 
and/or Buy buttons are available at the bottom of the window prompting you to get a trial or 
a permanent activation key. See Activating Parallels Workstation in Windows (page 26) for 
detailed description of the processes of receiving a key and activating. 

In Linux primary OS: 

Depending on whether you had previously received a trial activation key or not, warning 
text contains one or two links prompting you to get a trial or a permanent activation key. See 
Activating Parallels Workstation in Linux (page 31) for detailed description of the processes 
of receiving a key and activating. 
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Troubleshooting 

In Windows Primary OS 

If when starting a virtual machine in Windows primary OS you receive the warning 
"Parallels Workstation has detected that your primary operating 
system is running in PAE mode...", this means that your host computer 
configuration does not conform to Parallels Workstation requirements. Current version of the 
Parallels Workstation supports up to 4 GB PAE. To bypass this problem: 

 Follow Parallels Workstation prompts to create new configuration with 4 GB PAE. 
 Boot into this configuration. When launching Windows primary OS select the configuration 

that has in parentheses "for Parallels Workstation" on the Please select the 
operating system to start screen. 

In the future boot into the Windows configuration without PAE to work with Parallels 
Workstation. 

In Linux Primary OS 

If when starting a virtual machine in Linux primary OS you receive the warning "Parallels 
Workstation can not be started due to VM memory mapping fail..." 
or when running a guest OS you receive the warning "Parallels Workstation 
experience problem when trying to allocate physical memory in 
PAE mode...", it could mean that the currently running kernel supports PAE greater than 4 
GB physical memory while the current version of Parallels Workstation supports up to 4 GB 
PAE only. To fix the problem you have to change the auto detected PAE value to 4096MB. Do 
the following: 

 Add to your boot loader the kernel option "mem=4096M" (refer to your boot loader 
documentation for details). 
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Capturing and Releasing the 
Keyboard and the Mouse 

This section teaches how to capture and release input devices (like your mouse and keyboard) 
inside a virtual machine. 

When you power on a virtual machine, either during installation or normal operation, you will 
need to capture the computer's input devices in the virtual machine to interact with it exactly as 
if you were using a standalone computer. Since each virtual machine is independent, it will not 
"see" the primary OS, and consequently, you will not be able to access Parallels Workstation's 
menu and toolbar from inside the virtual machine without manually releasing your input devices 
to the primary OS.  

To lock keyboard and mouse in a virtual machine screen, do one of the following: 

 Point the mouse cursor to the Parallels Workstation client window and click somewhere 
inside the virtual machine screen. When the mouse is captured, it does not move out of the 
Parallels Workstation window.  

 Select Capture Input in the VM menu. 
 Press Ctrl+I on your keyboard. 

To release the keyboard and mouse to your primary OS: 

 Press the hot key combination designated for releasing your keyboard/mouse (the default 
combination is Ctrl+Alt).  

The keyboard and mouse will be released immediately. Now you will be able to manage your 
virtual machines using the Parallels Workstation controls, manage your primary operating 
system, or capture the keyboard and the mouse in another virtual machine. 

The default hot key combination for releasing keyboard/mouse can be changed in the Hot Key 
Combinations (page 98) tab of the Preferences window.  

Note. You can free the mouse and the keyboard from the virtual machine screen without 
pressing the hot key combination if you install the Parallels Tools. See Parallels Tools Overview 
(page 77) to learn if this package is available for your guest operating system.  
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Switching Virtual Machine to 
Fullscreen Mode 

To make working inside a virtual machine more comfortable, you can run a guest operating 
system in fullscreen mode. When running a virtual machine in fullscreen mode, the guest OS 
screen occupies the whole monitor of your computer; the primary OS and its applications as 
well as the Parallels Workstation menu, toolbar, and status bar are hidden.  

Note: You can start a virtual machine in the fullscreen mode if the Switch to fullscreen mode 
automatically option is set in the VM Flags (page 108) tab of the General Options. 

If you want to switch to fullscreen while running a guest OS, do one of the following: 

 click Fullscreen Mode  toolbar button,  
 select View->Fullscreen in the menu, 
 press the appropriate hot key combination (Alt+Enter by default, unless you have 

defined other hot key). 

To return to windowed mode: 

 press any of the hot key combinations defined (Ctrl+Alt or Alt+Enter by default).  

Hot key combinations are defined in the Hot Key Combinations (page 98) tab of the Preferences 
window. 

You may adjust resolution of the monitor for fullscreen mode. See User Interface Preferences 
(page 95) for more info. 
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Shutting Down and Resetting 
Virtual Machine 

A virtual machine can be shut down and reset in the same way as a typical computer. If a guest 
operating system is normally closed using some internal command (such as Shut Down in 
Windows), it is STRONGLY RECOMMENDED to shut down the machine this way to ensure 
safety of your data. However, if you are unable to stop the guest OS this way, you may use the 
Parallels Workstation controls. 

Mandatory Stopping a Virtual Machine 

To mandatory stop a virtual machine, do one of the following: 

 Click the Power Off   button during guest OS execution. 
 Select VM -> Power Off in menu. 

The virtual machine will be stopped immediately. 

Resetting a Virtual Machine 

To reset a virtual machine, do one of the following : 

 Click the Reset button on the Parallels Workstation toolbar. 
 Select Reset in the VM menu.  
 Press Ctrl+Alt+Del while the keyboard is captured inside a virtual machine window. 
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Pausing Virtual Machine 
When a virtual machine is paused, the guest OS is stopped and the virtual machine process is 
removed from the CPU processes list. Guest operating system execution can be continued at any 
time. 

Pausing the guest OS is recommended if you want to leave the virtual machine for a short 
period of time. If you want to leave it for an extended period, and especially if you need to 
restart your primary OS, it is best to suspend of the VM. See Suspending/Resuming Virtual 
Machine (page 154). 

To pause a virtual machine: 

 Select Pause in the VM menu.  

When a virtual machine is in pause mode its console is darkened.  

To continue running the virtual machine do one of the following: 

 Click the Power On  button on the toolbar. 
 Select Continue in the VM menu. 

 

Suspending/Resuming Virtual 
Machine 

The state of the running Virtual Machine, and all of its applications, can be saved in order to 
continue working with the guest OS at a later time. This is called suspending the Virtual 
Machine. When suspending, the Virtual Machine state is saved to the hard disk in a .sav file. 
After saving, you may return to the saved Virtual Machine at any time and continue running the 
guest OS from the point where you stopped. 

Suspending a Virtual Machine 

To suspend a virtual machine: 

1 During guest OS execution do one of the following: 

 Click the Suspend button, 

 Select VM -> Suspend in menu. 

2 Progress of saving is displayed in the Please wait while virtual machine is suspending screen. 
When finished, the virtual machine property page is displayed. 
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Note. After the virtual machine is suspended, its configuration can not be changed. If you begin 
editing, despite the warning, the .sav file will be deleted and you will not be able to resume 
the virtual machine. 

Resuming a Suspended Virtual Machine 

To resume a suspended virtual machine: 

1 Open the virtual machine configuration in the typical way. 

2 Do one of the following: 

 Click the Power On button, 

 Select VM -> Power On in menu. 

3 Wait until the guest OS state is resumed. Progress is displayed in the Please wait while virtual 
machine is resuming screen. 

After the virtual machine has been resumed, its .sav file is deleted. 
 

Working with Devices When 
Running Virtual Machine 

Despite the fact that Configuration Editor (on page 105) cannot be accessed while a virtual 
machine is running, you can connect and disconnect additional devices, switch the media they 
access. So, when running virtual machine you can work with the following its devices: 

 CD/DVD-ROMs; 
 Floppy disk; 
 Network adapter; 
 Parallel ports; 
 Serial ports; 
 Sound device; 
 USB devices. 

To connect/disconnect any device, it should be enabled in the virtual machine configuration. If 
you have disabled some device, it will not be included into running virtual machine. 

USB Devices  

If you start the virtual machine with the USB controller enabled, you may connect various real 
USB peripherals to the virtual machine. The USB controller itself can not be connected or 
disconnected. 
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Working with a CD/DVD-ROM Drive 
When running a virtual machine with a CD/DVD-ROM drive you can: 

 enable/disable the CD/DVD-ROM drive temporarily, 
 change the media CD/DVD-ROM drive accesses. 

Note: If the guest OS was started with the CD/DVD-ROM drive disabled, you should shut down 
the guest OS first, then enable CD/DVD-ROM in the Configuration Editor (select the Enabled 
check box in the CD/DVD-ROM Options (on page 117) tab) and restart the guest OS. 

All commands to control CD/DVD-ROM during guest OS execution can be found in the 
Parallels Workstation Devices menu.  

 Windows primary OS. If you have several CD/DVD-ROM drives connected to your 
virtual machine they can be identified according their IDE numbers (CD/DVD-ROM 00 means 
connected to IDE 0:0, CD/DVD-ROM 01 means IDE 0:1 and so on). 

 Linux primary OS. If you have several CD/DVD-ROM drives connected to your virtual 
machine, in the Devices menu they are numbered according the order of their appearance. 
The first appeared CD/DVD-ROM will be CD/DVD-ROM 1, the second one will be CD/DVD-
ROM 2 and so on. 

How to Connect/Disconnect CD/DVD-ROM Drive 

To connect or disconnect a CD/DVD-ROM drive, do the following: 

1 Select the Devices->CD/DVD-ROM <number> in Parallels Workstation menu. 

2 Select the Connect/Disconnect command to connect or disconnect the CD/DVD-ROM drive 
respectively. 

Note. You may also enable/disable a CD/DVD-ROM drive using context menu of the 
CD/DVD-ROM drive  on the status bar. 

How to Change Media CD/DVD-ROM Drive Accesses 

Data type accessed by the CD/DVD-ROM drive can be switched from a real CD/DVD-ROM to 
an image file and vice versa. To change the media accessed by the CD/DVD-ROM drive: 

1 Select the Devices->CD/DVD-ROM <number> in Parallels Workstation menu. 

2 Select Connect to <drive letter> to access real CD/DVD-ROM drive or Connect image to 
access an .iso image file.  

Note: You may also switch change the media using commands in the context menu of the 
CD/DVD-ROM drive  on the status bar.  
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Working with a Floppy Drive 
If you start a guest operating system with the floppy drive enabled, you may connect/disconnect 
it and change its options while running the guest OS. Parallels Workstation allows to: 

 connect/disconnect floppy drive, 
 change media that floppy drive access. 

Note: If the guest OS is started with the floppy drive disabled, you should shut down the guest 
OS first, then enable the floppy in the Configuration Editor (select the Enabled check box in the 
Floppy Options (on page 113) tab) and restart the guest OS. 

Guest operating system with a virtual floppy connected to a real floppy drive prevents the 
floppy from being accessed by the primary OS while guest OS is running.  

How to Connect/Disconnect Floppy Drive 

To connect or disconnect the floppy drive, do the following: 

1 Select the Devices->Floppy <drive letter> in Parallels Workstation menu. 

2 Select the Connect/Disconnect command to connect or disconnect the CD/DVD-ROM drive 
respectively. 

Note. You may also connect/disconnect a floppy drive using the context menu of the floppy 
drive   on the status bar. 

How to Change Media Floppy Drive Accesses 

Data type accessed by the floppy drive can be switched from a real floppy to an image file and 
vice versa. To change the media accessed by the floppy drive: 

1 Select the Devices->Floppy <drive letter> in Parallels Workstation menu. 

2 Select Connect to <drive letter> to access real CD/DVD-ROM drive or Connect image to 
access a flopy image file.  

Note: You may also switch change the media using commands in the context menu of the 
floppy drive  on the status bar.  
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Working with a Network Adapter 
When running a virtual machine with a network adapter you can: 

 connect/disconnect the network adapter, 
 switch between different adapters of your host computer and host-only networking mode. 

Note: If the guest OS is started with the network adapter disabled, you should shut down the 
guest OS first, then enable the network adapter in the Configuration Editor (select the Enabled 
check box in the Network Adapter Options (on page 119) tab) and restart the guest OS. 

How to Connect/Disconnect a Network Adapter 

To connect or disconnect network adapter, do the following: 

1 Select Devices->Network in Parallels Workstation menu. 

2 Select the Connect/Disconnect command to connect or disconnect network adapter 
respectively. 

Note. You may also connect/disconnect a network adapter using context menu of the network 
adapter device   on the status bar. 

How to Switch Between Adapters 

To switch a network adapter of the virtual machine between bridged adapters: 

1 Check to what network adapter the virtual machine is now connected. 

To learn this point by mouse to the network adapter icon   on the status bar. The Mode 
line shows the type of networking: bridged ethernet or host-only; the Name line shows the 
name of the network adapter to which the virtual machine is connected. 

2 Set a different network adapter.  

For this right-click network adapter icon  on the status bar to display the context menu. 
Click the name of the desired adapter in the context menu. 

Note: You may also switch between adapters using commands in the Devices->Network menu.  
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Connecting Serial/Parallel Ports 
If a parallel/serial port is enabled in your virtual machine configuration, you can 
connect/disconnect port when running the guest OS. 

Note: If the guest OS is started with the parallel/serial port disabled, you should shut down the 
guest OS first, then enable the serial or parallel port in the Configuration Editor (select the 
Enabled check box in the Serial Port Options (on page 122) tab or Parallel Port Options (on page 
124) tab) and restart the guest OS. 

To connect or disconnect serial or parallel port, do the following: 

 select the Parallels Workstation Devices menu,  
 select COM (from 1 to 4 depending on how many serial ports are enabled) or LPT (from 1 to 

3 depending on how many parallel ports are enabled), 
 then select Connect/Disconnect command. 

Note: There is another way to connect/disconnect the port. Right-click the serial ( ) or parallel 
( ) port icon on the status bar (on page 54) to display the context menu, and select the 
appropriate command. 
 

Connecting a Sound Device 
If a sound device is enabled in your virtual machine configuration, you can connect/disconnect 
it while running the guest OS. 

Note: If the guest OS is started with the sound device disabled, you should shut down the guest 
OS first, then enable the sound device in the Configuration Editor (select the Enabled check box 
in the Sound Options (on page 125) tab) and restart the guest OS. 

To connect or disconnect the sound device, you should do the following: 

 select Devices in the Parallels Workstation menu,  
 select Sound menu item,  
 select Activate to connect the sound device (or select Mute to disconnect). 

Note: There is another way to connect/disconnect the sound device. Right-click the sound 
device icon  on the status bar (on page 54) to display the context menu and select the 
appropriate command. 
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Connecting USB Devices 
If the USB controller is enabled in the virtual machine configuration, you can 
connect/disconnect USB peripherals to the running virtual machine. Up to two USB devices can 
be used by virtual machine simultaneously.  

Parallels Workstation automatically detects all the USB devices connected to your host 
computer and displays them under the Devices->USB menu item and in the context menu for the 
USB controller ( ) in the status bar. Those devices that are currently connected to the virtual 
machine are checked. The primary OS can not access a USB device while it is being used by the 
virtual machine. 

Note: If the guest OS is started with the USB controller disabled, you should shut down the 
guest OS first, then enable the USB controller in the Configuration Editor (select the Enabled 
check box in the USB Options (page 127) tab) and restart the guest OS. 

Autoconnect 

If the Autoconnect USB devices option in the USB Options (page 127) tab is turned on and no 
more than one USB device is currently active, you can connect an additional USB device to 
your virtual machine. Do the following: 

 simply connect a USB device to your host computer.  

If you connect an additional USB peripheral to your host computer while there are two active 
USB devices already running, nothing will happen. However you are able to activate the newly 
connected device manually after deactivating any of the currently active USB devices. See the 
next subtopic to learn more on this. 

Manual Connect 

To connect a USB device to the virtual machine: 

 Connect a USB device to your host computer. 
 Select Devices->USB in the Parallels Workstation menu or context menu for the USB 

controller  ( ) in the status bar to display the list of all the USB devices connected to your 
host computer. 

In the USB device list, make sure that no more than one USB device is currently active. If there 
are two devices checked, disconnect one of them by clicking it. 

 Click the desired USB device in the list to connect it. 

Note. If you follow the instructions stated above but receive the "Unable to connect 
USB device" message while trying to connect an USB device on a computer running Linux 
primary OS, see the Problem with Connecting USB Devices in Linux Primary OS (page 209). 
 

 



 Running Virtual Machine 161 
 

Parallels Tools Center 
Note. Parallels Tools Center is available in Windows guest OSes only. 

Parallels Workstation allows you to control the status of Parallels Tools in all of the Windows 
guest OSes for which tools are provided (see Parallels Tools Overview (page 77) for tools 
descriptions and availability table). The Parallels Tools Center allows you to: 

 check the status of various tools; 
 temporarily disable and enable each tool separately (for those tools that can be stopped 

without violating guest OS executing); 
 configure specific tool parameters (for those tools that have them). 

The Parallels Tools Center is organized as a collection of tabs, each of which contains settings 
for an individual tool. In each guest OS, the Parallels Tools Center contains tabs only for those 
tools that you have installed in your guest OS. 

Parallels Tools Center is started automatically upon guest OS startup; its icon is placed into the 
guest OS system tray. 

Installing Parallels Tools Center 

Parallels Tools Center is installed along with Parallels Tools. Refer to the Installing Parallels 
Tools (page 76) section for detailed instructions. 

Upgrading 

If you have a virtual machine created by a previous version of Parallels Workstation with 
Parallels Tools installed, you need to upgrade this package. See Upgrading Parallels Tools (page 
87). 

Parallels Tools Center in Parallels Workstation 2.2 contains new Shared Folders Options tab 
needed for Shared Folders function in Windows 2000/XP/2003 guest OSes. 

Opening Parallels Tools Center 

To open Parallels Tools Center: 

 click its icon  in guest OS system tray. 

Restarting Parallels Tools Center 

To restart Parallels Tools Center after disabling: 

 Locate the ParallelsToolsCenter.exe file in the folder where you have installed 
the Parallels Tools and launch it. 
If you installed the Parallels Tools into the default folder, this file resides in the following 
path: 
C:/Program Files/Parallels/Parallels 
Tools/ParallelsToolsCenter.exe. 
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Clipboard Synchronization Tool Options 

 

Status: 

 Enabled shows the current status of the Clipboard Synchronization Tool. To temporarily 
disable this tool, deselect this check box. You can enable the Clipboard Synchronization 
Tool by selecting this check box later. 

Current clipboard content: 

 This field displays the current clipboard contents that can be scrolled.  
 The Clear button empties the clipboard contents.  

Description: 

 Displays the short description of the tool. For a complete description see the Parallels Tools 
Overview (page 77).  

Activating changes: 

After you have made the desired changes on the tab, do one of the following: 

 Click the Apply button to activate changes. 

Click the OK button to activate changes and hide the Parallels Tools Center. 
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Time Synchronization Tool Options 

 

Status: 

 Enabled check box shows the current status of the Time Synchronization Tool. To 
temporarily disable this tool, deselect this check box. You can enable the Time 
Synchronization Tool by selecting this check box later. 

Note: Before starting the Time Synchronization Tool, please stop all other time synchronization 
services in order to avoid potential conflicts. 

Advanced options: 

 Synchronization interval, sec. contains the period of time between two synchronization 
operations. Use scroll buttons in the field to set the desired value or simply enter it into the 
field. The interval value should be from 10 to 3600 seconds. 
To synchronize the guest OS system time with the primary OS: 

1. select this check box, 

2. set the desired value of the synchronization interval in the Synchronization Interval field. 
 Keep time difference between primary and guest OS check box allows you to maintain a 

constant difference between the guest OS system time and primary OS system time. 
To use this feature: 

1. select the Enabled check box, 

2. select the Keep Time Difference option, 

3. in the guest OS, set the desired current time.  
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The Time Synchronization Tool will calculate the lag/advance value at the moment when 
the guest OS time is set and will maintain it.  

Description: 

 Displays the short description of the tool. For a complete description see the Parallels Tools 
Overview (page 77).  

Activating changes: 

After you have made the desired changes on the tab, do the following: 

 Click the Apply button to activate changes. 

Click the OK button to activate changes and hide the Parallels Tools Center. 

 
 

Video Driver Options 

 

Status: 

 Enabled check box shows the tool's current status but is inaccessible for editing. 

Description: 

 Displays the short description of the tool. For a complete description see the Parallels Tools 
Overview (page 77).  
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Mouse Synchronization Tool Options 

 

Status: 

 Enabled check box shows the tool's current status but is inaccessible for editing. 

Description: 

 Displays the short description of the tool. For complete description see the Parallels Tools 
Overview (page 77).  
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Network Driver Options 

 

Status: 

 Enabled check box shows the current status of the Parallels Network Adapter Driver. If this 
check box is selected, it means that the Parallels Network Adapter Driver is active. We 
recommend that you use this driver whenever possible,  however, you are able to 
temporarily return to the native Realtek RTL8029 driver at any time. 
To enable the Parallels Network Adapter Driver select the Enabled check box.To return to 
the native Realtek RTL8029 driver deselect the Enabled check box. Drivers can be changed 
without restarting the guest operating system, however network connection may be 
temporarily lost. 

Description: 

 Displays the short description of the tool. For complete description see the Parallels Tools 
Overview (page 77).  

Activating changes: 

After you have made the desired changes on the tab, do one of the following: 

 Click the Apply button to activate changes. 
 Click the OK button to activate changes and hide the Parallels Tools Center. 
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Disk Compacting Tool Options 

 

Status: 

 The table displays the list of volumes located on the expanding virtual hard disks connected 
to your virtual machine and formatted to Windows file systems. Volumes formatted to other 
file systems are not displayed even though they may be physically located on expanding 
virtual hard disks. In the table you can select the volumes to be processed by the Disk 
Compacting Tool. 

 Execute all stages at once. Select this check box if you want to perform both stages of the 
compacting process at once. See the description of the two stages of compacting process  in 
the Compacting Procedure of the Compacting Virtual Disk (page 169) topic.  

 Start button starts the process of preparing virtual hard disks for compacting. 

Description: 

 Displays the short description of the tool. See the complete description and guidelines in the 
Compacting Virtual Disk (page 169) topic. 
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Shared Folders Options 

 

Status: 

 Enabled check box shows the tool's current status but is inaccessible for editing. 

Advanced Options: 

 Place shortcut on the desktop option controls the presence of the Parallels Tools Center 
shortcut on the guest OS desktop. 

Description: 

Displays the short description of the tool. For a complete description see the Parallels Tools 
Overview.  
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Compacting Virtual Disk 

What Is the Disk Compacting Tool? 

Expanding virtual disks grow in size as you work with them. Besides applications and their 
data, every disk accumulates temporary files. The Disk Compacting Tool, included in Parallels 
Workstation, cleans up the unused disk space occupied by temporary files, thus reducing the 
size of expanding virtual hard disks. We recommend that you use Disk Compacting Tool from 
time to time to save space on the host hard disk.  

The Disk Compacting Tool processes the following partitions: 

 volumes located on the expanding virtual hard disks and formatted to Windows file systems 
(FAT 16, FAT 32, and NTFS).  

Note. The Disk Compacting Tool does NOT process: 1) volumes located on expanding virtual 
hard disks but formatted to file systems other than Windows, 2) plain virtual disks. 

Compacting Procedure 

In general the compacting procedure consists of two stages that can be performed separately: 

1 A preparation step, performed in the guest OS, when an unused disk space is marked.    

This step can be performed only in those guest OSes where the Parallels Tools Center can 
be installed, i.e. in Windows 95/98/NT/ME/2000/XP/2003 guest OSes. See Installing 
Parallels Tools (page 76) for guidelines on installing Parallels Tools package. 

2 A compacting step, performed in the primary OS, when the unused space is removed.  

This step can be performed in two ways:  

 Immediately after the preparation step is completed. 

All of the selected expanding virtual disks are compacted in one operation.  

This option is available in those guest OSes where the preparation step can be 
performed, i.e. in Windows 95/98/NT/ME/2000/XP/2003 guest OSes. 

 When the virtual machine is powered off.   

Compacting is launched for each expanding virtual disk one-by-one. 

This way is available in all guest OSes.  

How to Compact Expanding Virtual Disks 

To compact disks in Windows 95/98/NT/ME/2000/XP/2003 guest OSes: 

1 In the running virtual machine, open the Parallels Tools Center. See the Parallels Tools 
Center (page 161) topic to learn how to do so.  

2 In the Parallels Tools Center, open the Disk Compacting Tool tab.  

3 In the Disk Compacting Tool Options (page 167) tab, a table in the Status group displays 
the list of volumes that can be compacted. Select the volumes you want.  
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If you want to proceed to compacting immediately after the preparation step is completed, 
select the Execute all stages at once check box.  

Click the Start button to begin preparing disks.  

4 During the preparation step the "Preparing for compacting. Please 
wait..." message is displayed.  

5 If you have selected the Execute all stages at once check box: 

When the disks are ready for compacting, the Disk Compacting Tool pauses virtual machine 
execution and starts compacting. The Compacting virtual hard disk box is displayed.  

When the process is finished, you are informed that the "Process of compacting 
of virtual hard disk(s) has been successfully completed". Click 
OK to continue working with the virtual machine.  

6 If you have NOT selected the Execute all stages at once check box: 

When the disks are ready for compacting, you are informed that "You are able 
either start compacting right now or do it when the virtual 
machine is powered off".   

If you select to start compacting, the Disk Compacting Tool performs compacting as 
described in step 5.  

If you select to put compacting off, you may continue working with the virtual machine. See 
the subtopic below to learn how to start compacting later. 

To compact expanding virtual disks in any guest OS: 

 When the virtual machine is powered off, click the Compact button on the Advanced (page 
116) tab of Hard Disk Options for each expanding-type virtual disk. While compacting is 
performed, the Compacting virtual hard disk box is displayed. When the process is finished, 
you are informed that the "Process of compacting of virtual hard 
disk(s) has been successfully completed".  

 

Setting up a Printer in a Virtual 
Machine 

There are three principal methods of configuring printing in a virtual machine: 

 Setup a network printer. 
We recommend that you use this method since it provides the most stable work. 

 Connect a virtual machine's parallel port to a parallel port of your real computer to which a 
printer is connected. 
This is performed in Parallel Port Options (on page 124) tab. Two options are available for 
virtual machines under Windows primary OS:  Use printer and Use port. We recommend 
you to select the Use printer option. When using this method, Parallels Workstation 
composes a printer job and transfers it to the primary OS that guides further process as if 
printer job was initiated by itself.  

On a computer running Linux primary OS only Use port option is available in virtual 
machines. When using this method, Parallels Workstation itself controls the printer job. 
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 Setup a USB printer. 

Configuring a virtual machine for either method of printing is described below. 
 

Setting Up a Network Printer 
Before installing a network printer in a guest OS make sure that your primary OS and the virtual 
machine meet the following requirements: 

 Networking in your primary operating system is configured. 
 Virtual machine configuration includes the network adapter which is connected to a real 

network adapter of your computer. See the Network Adapter Options (on page 119) of your 
virtual machine; make sure that the Enabled and the Connect at startup options are selected 
in the Device Status group. In the Emulation group the Bridged Ethernet option should be 
selected and the real network interface should be chosen in the Network Adapters list. 

 Networking in the guest OS is configured. 
 User account from which you will setup printer has permissions to access the network 

printer. 

In Linux or FreeBSD Guest Operating System 

Make sure that the following components are installed in your guest Linux or FreeBSD system: 

 Common UNIX Printing System (CUPS). Installation instructions can be found at CUPS 
site http://cups.org/documentation.php; 

 Samba service. Installation instructions can be found at Samba site 
http://us4.samba.org/samba/docs/man/Samba-HOWTO-Collection/install.html; 

 A Web browser, since we consider controlling CUPS via web interface; 
 Also you have to know the root password. 

To add a network printer in a Linux or FreeBSD guest OS: 

1 Start your Linux or FreeBSD guest operating system. 

2 Start Common UNIX Printing System.  

In the Terminal, issue the command: 
/etc/init.d/cups start 

3 Start a Web browser and open either IP address of your virtual machine or 
http://127.0.0.1:631. 

4 Select Printers in menu. Click the Add printer button below the list of available printers (if 
any).  

5 You are asked for root password. Enter it to be able to proceed. 

6 In the Add New Printer screen enter the information for easy identification of the printer: an 
informative printer name, location, and description. 

7 In the Device for <Printer Name> screen select the Windows Printer via Samba. 

8 In the Device URI  for <Printer Name> screen specify the path to network printer in the 
following format: 
smb://<computer name>/<printer name> 

9 In the Model/Driver for <Printer Name> screen select the model of your printer. 
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10 CUPS performs installation. If installation is successful, the "Printer <name> has 
been added successfully" message is displayed.  

In Windows Guest Operating System 

To add a network printer in a Windows guest OS: 

 Start the Windows guest operating system and log in the proper account. 
 Open Windows Start menu, select Settings and then the Printers and Faxes (or simply 

Printers) item. 
 Open the Add Printer Wizard: 

In Windows 95/98/NT/ME/2000/2003 double-click the Add printer icon. 

In Windows XP click the Add a printer link. 
 In the Add Printer Wizard: 

In Windows 2000/XP/2003: 

- click Next in the first wizard's screen, 

- in the Local or Network Printer screen, click A network printer, or a printer attached to 
another computer. 
In Windows 98/ME: 

- click Next in the first wizard's screen, 

- the wizard's next screen asks: How is this printer attached to your computer? Click the 
Network printer option.  

In Windows 95/NT: 

- click Network printer/server. 
 Continue an ordinary network printer installation. 

 

Setting Up Printing via LPT Port of Real Computer 
Before setting up printing using this method make sure that: 

 a printer is connected to an LPT port of your real computer.  

To setup printing through a parallel port of your physical computer: 

1 Open the virtual machine configuration in configuration editor (on page 105), make sure 
that the configuration includes a parallel port, if necessary add it.  

2 Open the Parallels Port Options (on page 124), make sure that the Enabled and the Connect 
at startup options are selected.  

3 Specify the way of emulating the parallel port in the Emulation group. 

If your computer runs Windows primary OS, we recommend to select the Use printer 
method (it is not available in Linux primary OSes). The Printers list displays list of printers 
available in the primary OS. Specify which of them you want to use.  

In virtual machine under Linux primary OS select the Use port option and then specify the 
real port of your physical computer to which the printer is connected in the LPT-port list. 

4 Save the virtual machine configuration (see Saving Virtual Machine Configuration (page 
106)) and start the guest operating system. 
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5 Install the driver for your printer in the guest OS. We recommend that you use the native 
driver. 

 
 

Setting Up a USB Printer 
To setup an USB printer: 

1 Open the virtual machine configuration in the Configuration Editor (on page 105), and 
make sure that the configuration includes a USB controller; if necessary add it.  

2 Open the USB Options (page 127), and make sure that the Enabled option is selected. Select 
the Autoconnect at startup if you want the printer to be automatically captured by the virtual 
machine. 

3 Save the virtual machine configuration (see Saving Virtual Machine Configuration (page 
106)) and start the guest operating system. 

4 Connect the USB printer as a normal USB device. See the Connecting USB Devices (page 
160) topic. 

5 Install the native driver for the printer in the guest OS. 
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C H A P T E R  9  

Using the Parallels Image Tool 

This chapter provides all the information necessary to use Parallels Image Tool. Since a virtual 
machine operates virtual hard disks which are image files, uses virtual CD/DVDs which are 
images of real discs and virtual floppies which are images of floppy disks, the Parallels 
Workstation package includes a special tool for creating and supporting images - the Parallels 
Image Tool, which is automatically installed along with Parallels Workstation. 

 

In This Chapter 
What Is Parallels Image Tool................................................................................................ 174 
Starting the Parallels Image Tool.......................................................................................... 175 
Managing Hard Disk Images ................................................................................................ 175 
Creating CD/DVD-ROM Image ........................................................................................... 190 
Creating Floppy Disk Image ................................................................................................. 197 
 
 

What Is Parallels Image Tool 
Parallels Image Tool allows you to: 

 create an image of a real hard disk and modify existing images of virtual hard disks 
including conversion of images to other formats (see the Format of The Virtual Disk (page 
101) in the Hard Disk Images topic). In particular these operations are listed below, 

 create ISO images of real CDs or DVDs, 
 create images of real floppies. 

The Image Tool can perform the following operations on hard disk images: 

 Increase the disk size of a hard disk image. 
Both expanding and plain disks can be enlarged. Note that disk size can not be reduced. 

 Convert a plain hard disk image to an image in expanding format. 
The result of the conversion can be saved in the same file as well as in another one. 

 Convert an expanding hard disk image to an image in a plain format. 
The result of the conversion can be saved in the same file as well as in another one. 
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 Defragment an expanding hard disk image. 

Parallels Image Tool is designed as a wizard.  The wizard guides you through all the steps 
necessary to perform the required operation on the image.  Furthermore, the wizard keeps all 
your previously selected options between uses in case you often perform the same operation. 

Notes: 1. Blank hard disk and floppy disk images can be created in Configuration Editor on the 
corresponding options tabs - Hard Disk Options (page 114) and Floppy Options (on page 113) - 
using the Recreate button located on these tabs. 

2. In Linux primary OS some Image Tool options may be disabled depending on your system 
privileges. 

 

 
 

Starting the Parallels Image Tool 
The Parallels Image Tool is made in the form of wizard.  

In Windows primary OS: 
To run the Parallels Image Tool wizard, select Programs --> <Parallels Folder Name> --> 
Parallels Workstation --> Parallels Image Tool in the Windows Start menu where <Parallels 
Folder Name> denotes the folder you have specified while installing Parallels Workstation. 

In Linux primary OS: 
To run Parallels Image Tool log in, launch the Terminal program and run  

imagetool 

in the command line. 
 

Managing Hard Disk Images 
This section contains information on creating and modifying virtual hard disks using Parallels 
Image Tool. 
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Creating an Image of a Real Hard Disk 

For What These Images Can Be Used 

The Parallels Image Tool can create images of real hard disks. Such disks are intended mainly 
for migrating data from your real computer to a virtual machine. Since configuration of the 
virtual machine is probably different from the hardware configuration of your real computer, an 
operating system installed on the real disk (if it is installed) is not likely to function properly on 
the virtual machine. Thus such virtual disk is not recommended to serve as startup disk, rather it 
should be attached to an existing configuration as an additional one.  

Requirements to Computer Hardware 

An image of a real hard disk is created in plain format only.  See the Format of The Virtual Disk 
(page 101) in the Hard Disk Images topic for description of the plain format. Virtual hard disk in 
plain format occupies all its size right from the moment it is created. This means that the disk 
image is the same size as the real disk itself, regardless of how much space on the real disk is 
actually used. So, to create an image of a real hard disk you should have one real hard disk more 
for storing the image file. And to accommodate the image, the size of the additional hard disk 
should be not less than the size of the one you are going to image.  

So, in order to create an image of a real hard disk: 

 Your computer should have an additional hard disk to store an image of the disk. Additional 
disk should be at least 5% larger than the first one. 

Using the Wizard to Modify an Existing Hard Disk Image 

To create an image of a real hard disk follow these steps: 

1 Start the Parallels Image Tool (page 175). Upon startup, the wizard displays the Welcome 
screen. If you want to skip this screen next time you run the Image Tool, select the Skip 
Introduction next time check box. Click Next. 
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2 On the Select device type screen select the Hard Disk Drive option and click Next.  
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3 On the Select operation type wizard screen, select the Create new Hard Disk image option and 
click Next. 

 
4 On the Specify source and destination folder screen: 

in the Source field, select a physical hard disk to be duplicated, 

in the Destination field, specify a destination directory and file name for the disk image file. 
The folder should be located on another physical hard disk. 
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Click Next.  
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5 The wizard will display the chosen operation and the selected options on the Review 
processing options screen. Carefully review the settings (operation, source drive, and 
destination file). If everything is correct, click the Start button to begin the operation. 
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6 While the operation is being performed, the Execution in progress screen is displayed.  

 
7 After the disk image is created, the Processing is completed screen appears. The disk image 

is created and placed in the destination folder specified in step 5. See Adding New Devices 
to Virtual Machine (page 128) to learn how to connect a hard disk image to a virtual 
machine or Hard Disk Options (page 114) to learn how to replace one of the currently 
connected hard disks with the new one. 
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Also see the Hard Disk Images (page 100) section for ideas on using hard disk images in 
Parallels Workstation. 

 
 

Modifying an Existing Hard Disk Image 

Requirements for Source Disk 

The modifying operations require that the source hard disk image should not be in use by a 
running virtual machine. 

Checking Disk Format 

When selecting a disk image to modify, make sure that you select the source hard disk image of 
a proper format.  

To check the disk format do the following: 

1 Open the configuration of any virtual machine that includes this virtual hard disk. 

2 In the Configuration Editor open the Advanced (page 116) tab of the Hard Disk Options 

3 You will see the disk format in the Disk format field.  
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Using the Wizard to Modify an Existing Hard Disk Image 
1 Start the Parallels Image Tool (page 175). Upon startup, the wizard displays the Welcome 

screen. If you want to skip this screen next time you run the Image Tool, select the Skip 
Introduction next time check box. Click Next. 
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2 On the Select device type screen select the Hard Disk Drive option and click Next.  

 
3 On the Select operation type screen select the Maintain an existing Hard Disk image option. 

When you select it, the hard disk image management options appear in the lower part of the 
screen.  

In the Hard Disk actions group, choose the operation you want to perform on the virtual hard 
disk.  

There are four available operations for virtual disks images: 

 Increase size of Hard Disk image to make a hard disk image larger. 

 Convert plain Hard Disk image to expanding Hard Disk image to create an expanding copy 
of a plain hard disk image. 

 Convert expanding Hard Disk image to plain Hard Disk image to create a plain copy of an 
expanding hard disk image. 

 Defragment expanding Hard Disk image to optimize files arrangement on a virtual disk 
and to increase disk operation speed. 
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Choose the operation, then click Next.  

 
4 Next, you have to specify the options for the selected operation on the Specify source and 

destination screen.  

For size increasing select the source hard disk image and the new size for the disk. Use the 
Browse button to locate a file. Use the spinner buttons next to the Image Size field to set the 
required value.  
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Note. Parallels Image Tool doesn't allow you to decrease image size.  
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For both hard disk conversion operations select a source disk specify a path and specify a 
name of the resulting converted image in the Destination field.  
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When defragmenting an expanding hard disk specify the name of a source hard disk image. 
Use the Browse button to locate the required file.  

 
After specifying the input data click Next.  

5 The wizard will display the chosen operation and selected options on the Review Processing 
Options screen. 

Carefully review the settings (operation, source image file, and destination file if present, 
etc.). If everything is correct, click the Start button to start the desired operation.  
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6 While the operation is being performed, the Execution in progress screen is displayed. After 
the disk image is created, the Processing is completed screen appears. Close the Wizard by 
clicking the Exit button.  

 
The new disk image is ready, and you can connect it to a virtual machine in the 
Configuration Editor.  See Adding New Devices to Virtual Machine (page 128) to learn how 
to connect a new hard disk image to a virtual machine, or Hard Disk Options (page 114) to 
learn how to replace one of the currently connected hard disks with the new one. 

Note that not all operating systems are able to recognize a newly added hard disk, use the 
guest operating system means to make a new device visible to the guest OS.  

 

Creating CD/DVD-ROM Image 
To create an image of a CD/DVD disc follow these steps: 

1 Insert the required disc into the CD/DVD-ROM drive of your computer. 
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2 Start the Parallels Image Tool (page 175). Upon startup, the wizard displays the Welcome 
screen. If you want to skip this screen next time you run the Image Tool, select the Skip 
Introduction next time check box. Click Next. 
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3 On the Select Device Type screen select the CD/DVD-ROM Drive option and click Next.  
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4 The Select Operation Type screen appears with the single operation Create new ISO image of 
CD/DVD already selected. Click Next. 
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5 On the Specify source and destination screen select the source (CD/DVD-ROM on your 
computer), and specify a destination folder and a name of the CD/DVD image file. Click 
Next.  
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6 The wizard will display the chosen operation and the selected options on the Review 
processing options screen. Carefully review the settings (operation, source device, and 
destination file. If everything is correct, click the Start button to begin the operation. 
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7 While the operation is being performed, the Execution in progress screen is displayed. Wait 
until the operation is completed.  

 
8 After the disc image is created, the Processing is completed screen appears. The disc image 

is created and placed in the destination folder specified in step 5 and can be connected to a 
virtual machine CD/DVD-ROM drive. See the CD/DVD-ROM Options (on page 117) 
section to learn how to connect an .iso image to CD/DVD-ROM drive of a virtual 
machine. 
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Also see the CD/DVD-ROM Real Disks and Images (page 102) section for ideas of using 
CD and DVD disc images in Parallels Workstation. 

 
 

Creating Floppy Disk Image 
To create a floppy disk image follow these steps: 

1 Insert the required floppy disk you want to create an image of into appropriate drive of your 
computer. 

 



 Using the Parallels Image Tool 198 
 

2 Start the Parallels Image Tool (page 175). Upon startup, the wizard displays the Welcome 
screen. If you want to skip this screen next time you run the Image Tool, select the Skip 
Introduction next time check box. Cick Next. 
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3 On the Select device type screen select the Floppy Disk Drive option and click Next. 
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4 The Select Operation Type screen appears with the single operation Create new Floppy Disk 
image already selected. Click Next. 
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5 On the Specify source and destination screen select the source (real floppy drive on your 
computer), and specify a destination folder and a name of the floppy image file. Click Next.  
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6 The wizard will display the chosen operation and the selected options on the Review 
processing options screen. Carefully review the settings (operation, source device, and 
destination file. If everything is correct, click the Start button to begin the operation. 
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7 While the operation is being performed, the Execution in progress screen is displayed. Wait 
until the operation is completed.  

 
8 After the disc image is created, the Processing is completed screen appears. The disc image 

is created and placed in the destination folder specified in step 5 and can be connected to a 
virtual machine floppy drive. See the Floppy Options (on page 113) section to learn how to 
connected an .fdd image to the floppy drive of a virtual machine. 
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Also see the Floppy Disk Images (page 102) section for ideas on using floppy disk images 
in Parallels Workstation. 
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Reporting a Problem to Parallels 
Team 

In order to enhance the quality of Parallels Workstation product, you are able to send feedback 
to Parallels Software International Inc. in the form of problem reports. In case of a fatal error 
inside a virtual machine, Parallels Workstation automatically opens Report a Problem window 
proposing user to send the report. You can decide to send a report on your own, whenever you 
encounter incorrect system behavior. 

Automatically Generated Reports 

Fatal errors in virtual machine leads to the automatic generation of a virtual machine status 
report, taking a console screenshot and opening Report a Problem window for a user to decide 
whether he/she wants to send the report to Parallels Software corporation. The Report a Problem 
window contains the following elements. 
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The Technical data field shows the name of the .txt status report file that have been generated 
in the error moment. The status report holds information on product version, your activation 
data, primary and guest OSes information, processor status and so on. You can correct the data 
if it is required. Click View to open the report in the text editor.  

The Session screenshot field holds the name of the .jpg console screenshot that have been 
made in the error moment. To see the screenshot click View button. 

You may add a verbal description of the situation in the Problem description box. The text you 
enter here is saved in the status report in a separate block when you close the Report a Problem 
window by clicking OK button. 

Sending report options are different in Windows and Linux primary OSes. 

Windows primary OS: 

To send a report to Parallels, select Send report to reports@parallels.com check box and 
click OK button. On this command Report a problem window will be closed and the default 
e-mail client application will be activated.  

If you decide not to send a report, deselect Send report to reports@parallels.com check box 
and click OK button. The status report and the screenshot are saved in the Bugreports 
directory in the Parallels Workstation folder.  By default it is 

C:\Program Files\Parallels\Parallels Workstation\Bugreports 

directory.  

Linux primary OS: 

To send report to Parallels corporation, click OK button. 

Then launch your e-mail client application, create a new letter and attach the status report 
and the console screenshot to it. They are located in the following directory: 

/usr/lib/parallels/bugreports/ 

Specify the following e-mail address for the letter:  
reports@parallels.com 

In both Windows and Linux Primary OSes: 

format of status reports names and screenshots is the following: 

parallels-yyyy.mm.dd-hh.mm.ss.<txt/jpg> 

Creating Report Manually 

To create a problem report, select Report a Problem in the Help menu. A report with technical 
data available at the moment of Report a problem command activation is generated. If a guest 
OS is running, a console screenshot is made.  

To send a report, perform the same actions as for automatically generated report. 

In Windows primary OS click Cancel if you decide not to send the report.  

Other elements of the Report a problem window are the same as for automatically generated 
reports in both Windows and Linux primary OSes. 
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Problems with Networking Inside a 
Virtual Machine 

If you encounter any sort of problems with networking inside a virtual machine, varying from 
inability to access Internet to host-only network configuring failure, that can not be handled by 
adjusting virtual machine and Parallels Workstation settings, we recommend that you check 
your primary OS firewall settings. The primary OS firewall may affect Parallels Host-Guest 
Virtual NIC (page 132) network adapter thus preventing host-only network functioning. It also 
may interfere Bridged Ethernet networking. 
 

Installing Ubuntu Linux 6.0.6 Server 
To run an Ubuntu Linux 6.0.6 Server in a virtual machine, follow these steps: 

1 The virtual machine should have the network adapter included into its' configuration. 
Network adapter should be set to the Bridged Ethernet mode. 

If you use a typical virtual machine, it meets both conditions. 

2 Install the Ubuntu Linux 6.0.6 Server package. Do not disconnect the installation CD/DVD 
or its' image! 

3 Make sure that Boot Sequence on the Configuration Editor / Options / Booting Options tab is 
set to [CD-ROM, Hard Disk, Floppy]. 

4 Power on the Ubuntu virtual machine. Enter  
rescue 

in the prompt. 

5 In the Enter rescue mode screen select /dev/discs/disco/part1, then on the same screen, select 
execute a shell in /dev/discs/disco/part1. Note that these options may have slightly different 
names. 

6 In the next screen click Continue. 

7 In the prompt string enter the following command: 
sudo apt-get install linux-686 

8 When you are asked if you want to continue, type "y". 

9 686 kernel is downloaded and installed. When it is finished, enter the 
exit 

command. 

10 In the Enter rescue mode screen select the last option reboot the system.  

11 Disconnect the installation CD/DVD from your virtual machine to boot from hard disk. 
After booting is finished the virtual machine is ready for work. 
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Problem with Connecting USB 
Devices in Linux Primary OS 

If you receive the "Unable to connect USB device" message while trying to connect 
an USB device to your virtual machine on a computer running Linux primary OS, the most 
probable cause is that you do not have permissions to access USB devices. To fix the problem: 

1 Check if an usb-operating group exists in your Linux primary OS. 

2 If the group exists: 

 In the Terminal, issue the command 
su 

to gain root privileges. Enter the password to the root account when you are asked 
for it. 

 Include into this group users who have to have an access to USB devices. 

 Run the  
exit 

command to leave the root account. 

 Proceed to step 4. 

3 If the group does not exist: 

 In the Terminal, issue the command 
su 

to gain root privileges.  

 Create a group and include into it users who have to have an access to USB devices. 

 In the /etc/fstab file edit the string that mounts the usbfs. Devgid parameter should 
contain the identifier of the group created in the previous step.  
usbfs        /proc/bus/usb usbfs   devgid=<USB 
gid>,devmode=0664 0 0  

This option will of course only work if you have the relevant support compiled in your 
kernel. 

 Run the  
exit 

command to leave the root account. 

4 Restart your Linux primary OS. 
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Configuring Display for Fullscreen 
Mode 

If you receive a poor picture or incorrect system behavior when switching a guest operating 
system to fullscreen mode, this can be fixed by configuring your primary OS settings. 

Windows primary OS: 

When guest OS is running in fullscreen mode, physical display is switched to guest OS 
resolution with the highest possible frequency. If your physical videocard or physical monitor 
do not support the resolution or frequency requested by the guest OS, substitute video mode that 
matches best is set instead. In some cases substitute mode may not work, or you are warned of 
an inability to switch to fullscreen mode. To fix the situation, correct primary OS display 
settings: 

1 Open Display Properties window by selecting in Windows Start menu the Settings/Control 
Panel/Display. Make sure that the Hide modes that this monitor cannot display option is 
selected in the Setting tab. If not, select it and apply the settings. 

2 If the option in the previous item is selected but problem remains, make sure that the proper 
monitor and videocard drivers are installed in the primary system. Reinstall them in case of 
necessity.  

Linux primary OS: 

When a guest OS is running in fullscreen mode, the physical display is switched to guest OS 
resolution with the highest possible frequency. If X Window System is not configured for the 
mode requested by guest OS, substitute mode that matches best is set instead. The situation is 
worse if the physical monitor does not support the requested mode while it is configured in X 
Window System. Parallels Workstation can not know that the monitor does not support the 
requested mode and will try to switch to it. This may lead to poor picture quality in fullscreen 
mode. 

If display picture in fullscreen mode is unusable: 

1 Stop the guest OS, 

2 Reconfigure X Window System to exclude resolution/frequency inconsistent with your 
monitor, and restart X Window. 
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Interaction between Virtual 
Machines of Other Vendors and 
Parallels Network Adapter 

If in addition to Parallels Workstation you have installed on your computer virtual machine 
software developed by vendors other than Parallels Software International Inc., a problem with 
a network adapter for an external virtual machine is possible. Alternative virtual software may 
assume Parallels virtual network adapter, Parallels Host-Guest Virtual NIC, to be a real network 
interface and connect an external virtual machine network adapter to it. This problem is 
especially probable if the external virtual machine chooses network adapter automatically. 

If the problem described above occurs, you will receive an error when trying to access Internet 
in an external virtual machine. To solve the problem: 

 Open this virtual machine configuration and select a physical network adapter.  

The Parallels Workstation adds Parallels Host-Guest Virtual NIC network adapter to the list of 
network adapters in primary operating system during the installation process. This adapter is 
required for host-only network (page 132).  
 

Problem with Printing 
If you have a physical printer connected to an LPT port of your computer but you can not print 
from primary operating system and/or several virtual machines despite the printer being 
properly connected and configured, this may be caused by the following reason: the running 
virtual machine's parallel port is connected to a real LPT port which is blocking this LPT port. If 
printer cable is attached to that port of a physical computer, no other virtual machine as well as 
primary operating system can access printer. 

To solve the problem: 

 find a virtual machine from where you can print, 
 disconnect its parallel port which is connected to the real LPT port. See Connecting 

Serial/Parallel Port (page 159).  

Documents that have been sent for printing in primary OS or other virtual machines while you 
were unable to print are accumulated in the spooler and will be printed according to the 
sequence they arrived. If you run several virtual machines with their parallel ports connected to 
printer through the same physical LPT port, you may be required to consequently disconnect 
their parallel ports to print all the documents. 
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SoftICE Keyboard Problem 
If you run Parallels Workstation simultaneously with Compuware SoftICE debugger from 
Compuware Driver Studio, keyboard problems may arise. Problems usually occur when starting 
SoftICE from the Windows command line while Parallels Workstation is already running. 

Note. Since SoftICE is a Windows application this issue may appear in Windows primary OS 
only. 

To fix the problem: 

1 Open SoftICE Settings, select Troubleshooting part. Check Do not patch keyboard driver 
option. 

2 Restart your computer. 
 

Initializing Swap File Problem 
If you receive the "Unable to initialize swap file" message when starting a 
virtual machine, follow the steps: 

1 Do either: 

 In the property page, click Memory and decrease memory size used by virtual machine. 

 In the menu, select Edit/Preferences/Common and specify a different default directory 
for virtual machines. This folder should be located on your local hard drive that has 
enough free space. 

2 Try to start the virtual machine again. 

Appearing of this problem indicates lack of disk space on the volume where virtual machine 
configuration is stored. 
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Citrix Support 
Parallels Workstation for Windows supports Citrix remote access tools. If the support is set, 
Citrix ICA Client will intercept most of the standard hot key presses and send them to Parallels 
Workstation instead of primary Windows OS. It allows using Ctrl+Alt to switch between 
applications inside Windows guest OS, press Win key to open Start menu, etc. 

Note: Linux version of Parallels Workstation does not support Citrix.  

Parallels Workstation includes special .dll libraries to be installed on both server and client 
sides. 

To install Citrix support in the Parallels Workstation for Windows, please do the following steps 
on client side: 

1 Locate the IOHooksCitrixClient.dll file on the server hard disk in the directory 
where you have installed Parallels Workstation. Copy this file to you local machine into the 
directory, where you have installed the Citrix ICA Client. 

2 Modify the module.ini file in the Citrix ICA Client directory in the following way:  

a search for the string beginning from VirtualDriver and add to the end of the list a 
new element, IOHooksCitrixClient, for example: 

VirtualDriver = Thinwire3.0, … ,ICACTL, IOHooksCitrixClient  

b Add the following strings to the end of the module.ini file: 
[IOHooksCitrixClient] 
DriverName = IoHooksCitrixClient.dll 
DriverNameWin32 = IoHooksCitrixClient.dll 
Resolution = 10 

3 Restart the Citrix ICA client. 
 

 



 Troubleshooting and Limitations 214 
 

Copyright © 2005-2006 by Parallels Software International Inc. All rights reserved. 
 
Parallels is a registered trademark of Parallels Software International, Inc. 
 
This product is based on a technology that is the subject matter of a number of pending patent 
applications. 
 
Distribution of this work or derivative of this work in any form is prohibited unless prior written 
permission is obtained from the copyright holder. 
 
Microsoft, Windows, Windows Server, Windows NT, and MS-DOS are registered trademarks of Microsoft 
Corporation. 
Linux is a registered trademark of Linus Torvalds. 
Solaris is a registered trademark of Sun Microsystems, Inc. 
All other marks and names mentioned herein may be trademarks of their respective owners. 
 

 



 215 
 

Index 

A 
Address 

IP • 93, 132 
MAC • 119 
MAC in a cloned Virtual Machine • 137 

Autostart VM when configuration is opened, 
setting • 108 

B 
Boot sequence, setting • 107 
Bridged Ethernet • 131 
Browser for displaying help in Linux primary 

OS • 95 

C 
CD/DVD images 

CD/DVD images used by Virtual Machine • 
102 

creating image of a real CD/DVD disk • 
190 

Clipboard synchronization between primary 
OS and guest OS • 77, 162 

Cloning Virtual Machine • 137 
Configuration Editor • 105 
Configuration of a Virtual Machine 

creating • 57 
definition • 58 
editing • 105 

CPU 
emulated in Virtual Machine • 11 
required on host computer • 14 

D 
Defragment an expanding hard disk image • 

183 
Delete Virtual Machine • 145 
Devices 

adding to Virtual Machine • 128 
boot sequence • 107 
configuring in Virtual Machine • 105 
connecting to running Virtual Machine • 

155 
emulated in Virtual Machine • 11 

DHCP server • 93, 132 
Directory 

default directory for Virtual Machines • 90 
for cloned Virtual Machine • 137 
for custom Virtual Machine • 65 

Disk Compacting Tool • 167, 169 

F 
FDD • 58, 102 
Files 

screenshot • 56 
status report • 206 
that make up a Virtual Machine • 58 

Firewall • 208 
Floppy disk image 

creating image of a real diskette • 197 
creating new empty image • 113 
floppy disk images used by Virtual 

Machine • 102 
Font for dialogs in Linux primary OS • 95 
Fullscreen 

autorun in fullscreen mode • 108 
configuring display for fullscreen mode • 

210 
fullscreen mode • 152 

G 
Guest operating system 

installing guest OS • 73 

H 
Hard disk image 

compacting • 167, 169 
converting expanding HD image into plain 

• 183 
converting plain HD image into expanding 

• 183 
creating an image of a real hard disk • 176 
creating new empty HD image • 114, 128 
defragmenting an expanding HD image • 

183 
expanding HD image • 100 
file type and format of an HD image • 100 
hard disk in Virtual Machine • 114 
increasing size of an HD image • 183 
plain HD image • 100 

HDD • 58, 100 
Host computer 

 



 Index 216 
 

hardware requirements • 14 
software requirements • 15 

Host-only networking • 132 
Hot Key • 98, 141 

I 
IDE devices in Virtual Machine 

CD/DVD-ROM • 117 
Hard Disk • 114 

Image Tool • 174 
Internet accessing • 131 
IP address • 93, 132 
ISO • 58, 102 

K 
Keyboard 

capturing in Virtual Machine • 151 

L 
Local Area Network accessing • 131 

M 
MAC address 

in cloned Virtual Machine • 137 
in Virtual Machine • 119 

Memory 
in Virtual Machine • 112 
limit for all Virtual Machines • 92 

Mouse 
capturing in Virtual Machine • 151 
synchronization between primary OS and 

guest OS • 77, 165 

N 
Named pipe • 122 
Network adapter 

Host-Guest Virtual NIC • 132, 211 
in Virtual Machine • 119 

Network driver, Parallels Tools • 77 
Networking 

Bridged Ethernet • 131 
host-only • 132 

O 
Operating system 

installing in Virtual Machine • 73 
supported Linux primary OSes • 15 
supported Windows primary OSes • 15 

P 
PAE • 15, 149 
Parallels Image Tool • 174 
Parallels Tools 

overview • 77 
Parallels Tools Center • 161 
updating • 86 

Pause Virtual Machine • 154 
Pipe • 122 
Preferences for Parallels Workstation • 89 
Primary operating system 

supported Linux primary OSes • 15 
supported Windows primary OSes • 15 

Printer, connecting to Virtual Machine • 170 
Process priorities in Windows primary OS • 

108 
Processor 

emulated in Virtual Machine • 11 
required on host computer • 14 

PVS • 58 

R 
RAM 

in Virtual Machine • 112 
limit for all Virtual Machines • 92 

Reset Virtual Machine • 153 
Restore hidden messages • 95 

S 
SAV • 58, 154 
Screenshot 

for bug reports • 206 
of guest operating system screen • 56 

Shut down Virtual Machine • 153 
Socket • 122 
Sound driver, Parallels Tool • 77 
Starting Virtual Machine • 149 
Startup options • 90, 104 
Status bar 

connecting devices in a running Virtual 
Machine • 155 

general description • 54 
hiding • 48 

Suspend/Resume • 154 

T 
Time synchronization between guest OS and 

primary OS • 77, 163 
Toolbar 

buttons • 53, 149, 152, 153 
general description • 48 

Tooltips for buttons in Linux primary OS • 95 
Turn off Virtual Machine • 153 

U 
Uninstall Parallels Workstation 

 



 Index 217 
 

in Linux primary operating system • 34 
in Windows primary operating system • 29 

Update Parallels Workstation 
in Linux primary operating system • 41 
in Windows primary operating system • 35 

USB 
USB controller in Virtual Machine • 135 
USB devices connecting to Virtual Machine 

• 160 

V 
Video driver, Parallels Tool • 77, 164 
Virtual hard disk 

compacting • 169 
converting expanding virtual HD into plain 

• 183 
converting plain virtual HD into expanding 

• 183 
creating an image of a real HD • 176 
creating new empty virtual HD • 114 
defragmenting an expanding virtual HD • 

183 
expanding virtual HD • 100 
file type and format of a virtual HD • 100 
hard disk in Virtual Machine • 114 
increasing size of a virtual HD • 183 
plain virtual HD • 100 

Virtual Machine • 58 
adding new devices • 128 
configuration • 58 
creating custom configuration • 59, 65 
creating typical configuration • 59, 60 
directory for storing • 65, 90 
editing options of current devices • 105 
opening • 103 
pausing • 153 
resetting • 153 
running • 148 
shutting down • 153 
starting • 149 

W 
Windowed mode of the guest OS screen • 152 
Wizard 

Add new hardware • 128 
Clone Virtual Machine • 137 
Delete Virtual Machine • 145 
New Virtual Machine • 59 

X 
X Window System • 15, 210 
 

 


	Introduction
	Virtual Machine Technology Overview
	About Parallels Workstation
	What's New in Parallels Workstation 2.2
	Intel Virtualization Technology (VT-x) and AMD SVM Support
	Virtual Machine Equipment
	Supported Guest Operating Systems

	Installing Parallels Workstation
	System Requirements
	Hardware Requirements
	Software Requirements

	Installing Parallels Workstation in Windows
	Parallels Workstation for Windows: Step-by-Step Installation
	Starting Parallels Workstation
	Activating Parallels Workstation in Windows
	Uninstalling Parallels Workstation in Windows

	Installing Parallels Workstation in Linux
	Parallels Workstation for Linux: Step-by-Step Installation
	Starting Parallels Workstation
	Activating Parallels Workstation in Linux
	Uninstalling Parallels Workstation in Linux


	Updating Parallels Workstation
	Updating Parallels Workstation in Windows
	Auto-Updating Parallels Workstation in Windows
	Update Wizard in Windows

	Updating Parallels Workstation in Linux
	Auto-Updating Parallels Workstation in Linux
	Update Wizard in Linux
	Installing an Update


	Interface Basics
	Main Window
	Property Page
	Console View
	Status Bar
	Text Size
	Making Screenshots

	Creating Virtual Machine
	Creating Virtual Machine Configuration
	Understanding Virtual Machine Configuration
	New Virtual Machine Wizard
	Creating Typical Virtual Machine
	Creating a Custom Virtual Machine

	Installing Guest OS
	Installing a Guest Operating System on a Virtual Machine
	Configuring X Window System in FreeBSD Guest OS

	Installing Parallels Tools
	Parallels Tools Overview
	Windows Tools Installation
	Windows 98 Sound Driver Installation
	Windows NT Tools Installation
	Solaris Network Driver Installation
	OS/2 and eComStation Tools Installation
	Upgrading Parallels Tools
	Uninstalling Parallels Tools in Windows Guest OSes


	Managing Virtual Machines
	Setting Parallels Workstation Preferences
	Common Preferences
	Memory Preferences
	Network Preferences
	User Interface Preferences
	Hot Key Combinations

	Using Virtual and Real Disks
	Hard Disk Images
	Floppy Disks and Disk Images
	CD/DVD Real Discs and Images

	Selecting and Opening Virtual Machine
	Startup Options Dialog

	Editing Virtual Machine Configuration
	General Options
	Shared Folders
	Video (Screen Resolutions)
	Memory Options
	Floppy Options
	Hard Disk Options
	CD-ROM options
	Network Adapter Options
	Serial Port Options
	Parallel Port Options
	Sound Options
	USB Options

	Adding New Devices to Virtual Machine
	Removing Devices

	Networking in Virtual Machine
	Bridged Ethernet Networking
	Creating Host-Only Network

	Using Shared Folders
	Setting Up a Shared Folder
	Viewing Shared Folder in Guest OS

	Using USB Devices in Virtual Machine
	Custom Screen Resolutions
	In Windows Guest OSes
	In Linux Guest OSes

	Making Copy of a Virtual Machine
	Keyboard Shortcuts in Virtual Machine
	About Parallels Workstation Screen
	Deleting a Virtual Machine

	Running Virtual Machine
	Overview
	Starting Virtual Machine
	Capturing and Releasing the Keyboard and the Mouse
	Switching Virtual Machine to Fullscreen Mode
	Shutting Down and Resetting Virtual Machine
	Pausing Virtual Machine
	Suspending/Resuming Virtual Machine
	Working with Devices When Running Virtual Machine
	Working with a CD/DVD-ROM Drive
	Working with a Floppy Drive
	Working with a Network Adapter
	Connecting Serial/Parallel Ports
	Connecting a Sound Device
	Connecting USB Devices

	Parallels Tools Center
	Clipboard Synchronization Tool Options
	Time Synchronization Tool Options
	Video Driver Options
	Mouse Synchronization Tool Options
	Network Driver Options
	Disk Compacting Tool Options
	Shared Folders Options

	Compacting Virtual Disk
	Setting up a Printer in a Virtual Machine
	Setting Up a Network Printer
	Setting Up Printing via LPT Port of Real Computer
	Setting Up a USB Printer


	Using the Parallels Image Tool
	What Is Parallels Image Tool
	Starting the Parallels Image Tool
	Managing Hard Disk Images
	Creating an Image of a Real Hard Disk
	Modifying an Existing Hard Disk Image

	Creating CD/DVD-ROM Image
	Creating Floppy Disk Image

	Troubleshooting and Limitations
	Reporting a Problem to Parallels Team
	Problems with Networking Inside a Virtual Machine
	Installing Ubuntu Linux 6.0.6 Server
	Problem with Connecting USB Devices in Linux Primary OS
	Configuring Display for Fullscreen Mode
	Interaction between Virtual Machines of Other Vendors and Pa
	Problem with Printing
	SoftICE Keyboard Problem
	Initializing Swap File Problem
	Citrix Support

	Index

